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1

WABS SPI Concepts

The Smart Plug-in for WebSphere Application Server (WBS SPI) allows you to manage
WebSphere Application Servers from an HP OpenView Operations (OVO) console. WBS SPI
adds monitoring capabilities otherwise unavailable to OVO. For more information on OVO
refer to HP OpenView Operations for UNIX Concepts Guide.

This chapter offers a basic introduction to WBS SPI concepts. The following topics are
covered:

¢ Introducing WBS SPI
¢ Functions of WBS SPI
e  WBS SPI Components

Intfroducing WBS SPI

In conjunction with OVO, WBS SPI offers centralized tools that help you monitor and manage
systems using WebSphere Server. From the OVO console, you can apply the HP OpenView
performance and problem managing processes to monitor systems using WebSphere Server.
WBS SPI metrics are automatically sent to the OVO agent. These metrics can generate
alarms or be consolidated into reports and graphs to help you analyze trends in server usage,
availability, and performance. You can also integrate WBS SPI with HP OpenView Reporter
and HP OpenView Performance Manager (both products must be purchased separately) to
obtain additional reporting and graphing flexibility and capabilities. For details on
integrating WBS SPI with other HP OpenView products see Integrating HP OpenView
Reporting and Graphing Products with WBS SPI on page 75.

Smart Plug-in Data

WBS SPI has several server-related metrics that gather data about the following areas:
e server availability

e gserver performance

* memory usage

® transaction rates

e servlet executing times, time-outs, request rates

e JDBC connection status

e Web application processing
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Smart Plug-in Data Interpretation

WebSphere server administrators can choose those metrics most crucial to the successful
operation of WebSphere servers by modifying WBS SPI templates. These templates contain
settings that allow incoming data to be measured against predefined rules that generate
useful information in the form of messages. These messages with severity-level color-coding
can be reviewed for problem analysis and resolution. Corrective actions are often available in
Instruction Text as are automatically generated metric reports, available in the Annotations
area of a message.

Functions of WBS SPI

WBS SPI messaging, reporting, and action-executing capabilities are based on the OVO
concept of templates. The settings within these templates define various conditions within the
WebSphere server. Once in use, WBS SPI templates allow information to be sent back to the
OpenView Operations management server to help you proactively address potential or
existing problems and avoid serious disruptions to Web transaction processing.

Collecting and Interpreting Server Performance/Availability Information

The WBS SPI, once configured and deployed to managed nodes, gathers data that is
interpreted and acted upon, according to settings within the deployed templates. Those
templates, described in a later section, define conditions that can occur within the WebSphere
server, such as queue throughput rates, cache use percentages, timeout rates, average
transaction times, etc. Default thresholds, set within the templates, monitor these conditions
and trigger messages to the console when a threshold has been exceeded.
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Displaying Information

Messages in the Message Browser: Comparing the values gathered for WebSphere server
performance/availability against the schedule template settings relating to those specific
areas, OVO agent software forwards the appropriate messages to the OVO console. These
messages are displayed with color-coded severity levels in the OVO Message Browser.

|:_ Message Browser lopc_adm an vwbug.rose.hp.com] |

Browser Actions View Window

ption s

0 0 crollom
‘ _ Dwn | Highlight |  Details.. | 'erform Actiol Annotations.] Acknowledgd

Instruction Text: Messages generated by WBS SPI programs contain instruction text to
help diagnose and remedy problems. With each Message Details window, you can press the
Instructions button to view the text.

You can usually find instruction text in the message details; this same text is also available in
the HP OpenView Smart Plug-in for WebSphere Application Server Reference Guide metric
definition.

P
The average axecution for &4 =epvlet Hi ded the threshold

Fammatlc

ASCII-Text Reports: In addition to the instruction text mentioned above, metrics with
alarms also have automatic action reports that are generated when a defined threshold is
exceeded. These reports show conditions of a specific WebSphere server instance. When a
report is available, like the instruction text, you can find it within the Message Details,
specifically in the Annotations area.

WBS SPI Concepts 15
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Generating Reports Using HP OpenView Reporter

The WBS SPI also integrates with HP OpenView Reporter to provide you with over 20
management-ready, Web-based reports. WBS SPI includes the templates for generating these
reports within its Report package, which you can install on the Reporter Windows system.
After you have installed the product and completed some configuration steps, you can expect
to see new reports of summarized, consolidated data generated nightly that can help you
assess how the WebSphere server is performing over time.

The WBS SPI reports can use WBS SPI data to vividly illustrate servlet request rates,
transaction throughput rates, and average transaction execution time, to name just a few

generated reports.

Servlet Reauest Rate
1000

800

600

400

Requests / second

200

hp OpenView operations  |'smar plug-infer Bea Weblogic

Average Execution Time in milliseconds

opemlions smart plug-in for Bea Weblogic

Transaction Throughput - TOP 20

Senet 3
Sendet 4 @ MyServer-3
O myserver
W MyServer-2
Senvlet 1 B MyServer-1
Servlet 2
Sendet &
4
Servlet 6
= 1
0 400 200 1200 1600 2000 2400 08/26/01 08/27/01 08/28/01 08/29/01Avy. trans. / sec.
Avy. a |
Execution Requests/ 000 10000 400.00 30000 45000 000 31250
D Servlet Time (ms)  second 000 20000 €00.00 25000 55000  0.00 400,00

|
|
| 000 20000 5000 15000 10000 000 12500
1
1

000 4000 15000 3000 7500 000 7375
3 MyServer1:A 2,125.00 43750 |

4 MyServer1:B 190000 42500
6 MyServer3:B 000 36250
1 myserver.A 105000 32500

2 myserverB 950.00 237 50
5 MyServer2A 0.00 £5.00

000 540,00 1,200.00 730.00 147500  0.00 91125

Changes You Can Make

You can use WBS SPI templates with no customization, or you can change them as you find
necessary. Possible minor modifications and major customizations are listed here:

e Modification of Default Templates - Within a template you can change the default settings
for (1) collection interval, (2) threshold, (3) message text, (4) duration (5) severity level of
the condition, (6) actions assigned to the condition (operator-initiated or automatic).

e Creation of Custom Template Groups - Create custom template groups, using default
templates as a starting point. To do this, see Chapter 4, Using and Customizing WBS SPI.

e (Custom Metrics - The ability to define your own metrics or user-definable metrics (UDMs)
is a powerful feature that you can use to expand the monitoring capabilities of WBS SPI.
Instructions are available in the HP OpenView Smart Plug-in User Defined Metrics User
Guide.
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WABS SPI Components

The WBS SPI components include applications and templates that allow you to configure and
receive data in the form of messages and short reports. These messages (available in the
Message Browser) and short reports (through applications or message details) provide you
with information about conditions present in the servers running on specific managed nodes.

WBS SPI configuration applications let you configure the management server’s connection to
named server instances on specific managed nodes. After you have configured the connection,
you can assign templates to the nodes. With OVO agent software running on the manage
nodes, you can use WBS SPI reporting applications to generate reports.

Chapter 2, Installing, Upgrading, and Removing the WBS SPI details how to install the
components and use them to configure server instances on the managed nodes and then
deploy the template groups. The sections that follow here give you brief descriptions of all
components.

Applications

The WBS SPI applications include configuration, troubleshooting, and report-generating
utilities. In the OVO Application Bank window the WBS SPI applications are accessed by
double-clicking WBSSPI and are divided into three categories (all three categories are
available in both UNIX and Windows for a total of six application groups): WBSSPI Admin,
WebSphere, and WBSSPI Reports. Additional applications are available in the JMX Metric
Builder application group if you install the WASSPI-UDM-BUILDER software bundle.

WBSSPI Admin Applications Group

This group contains configuration and troubleshooting applications requiring “root”
permission, so it is recommended the Admin group be assigned to the OVO administrator. The
applications in this group allow you to configure the connection to the server you are
monitoring and to turn collections and tracing on and off. The group contains subgroups and
applications that are nearly duplicate for UNIX and Windows nodes.

WBSSPI Admin applications allow you configure, control, and troubleshoot the WBS SPI.

Application Group: WBSSPI Admin
View Window

Yiew Error File

WBS SPI Concepts 17



18

The WBSSPI Admin group contains the following applications (additional information is
located in Appendix C, Applications):

Config WBSSPI - Launches the configuration editor and maintains the WBS SPI
configuration.

Discover WebSphere- Sets basic configuration properties needed for discovery.

Init Non-Root - Simplifies the configuration of a non-root HTTPS agent on a UNIX
managed node (OVO 8.x only). Refer to Configuring a Non-Root HTTPS Agent on a UNIX
Managed Node (OVO 8.x Only) on page 50 for all the steps necessary to configure a
non-root HTTPS agent on a UNIX managed node.

Self-Healing Info - Collects data to be sent to your HP support representative.

Start/Stop Monitoring - Starts/Stops the collection of metrics for the entire WBS SPI or for
a selected server on the managed node.

Start/Stop Tracing - Starts/Stops tracing of the collections of metrics into a file. Run this
application only when instructed by your HP support representative.

Verify - Verifies that the WBS SPI is properly installed on the server or managed node.
View Error File - View the contents of the WBS SPI error log file.

View Graphs - View WBS SPI metric data in OpenView Performance Manager i a web
browser (additional setup is required: see Task 1: Configure the Management Server to
Launch your Web Browser on page 35 for more information).

WebSphere Application Group

These applications offer a quick way of checking the status or logfiles of a WebSphere server
and starting or stopping a server.
WebSphere applications provide you with convenient access to WebSphere server functions.

You can open the WebSphere applications by double-clicking WBSSPI - WebSphere in the
Application Bank window.

—-| Application Group: WehSphere | : iJ

Map Actions Edit View Window Help

opc_adm [Read—Write]

Check WebSphere Start WebSphere Stop Web Sphere

Auto—Layout] [Connection Labels Off]

The WebSphere group contains the following applications:

Check WebSphere - Does an interactive status check of selected WebSphere application
servers.

Start WebSphere - Allows an OpenView Operations user to start one or all WebSphere
application servers on a managed node (requires setup).

Stop WebSphere - Allows an OpenView Operations user to stop one or WebSphere
application servers on a managed node (requires setup).

View WebSphere Log - Allows a user to view the entire specified WebSphere log file.

Chapter 1



WABSSPI Reports

WBS SPI Concepts

Generated manually by dragging the managed node onto the window/report you have
accessed by selecting
Application Bank > WBSSPI > WBSSPI Reports = <selected_report>.

Definitions for the individual metrics contained in each report are available in the HP
OpenView Smart Plug-in for WebSphere Application Server Reference Guide.

These reports reflect the current condition of all configured server instances on the managed
node at the time you generate it. WBS SPI reports require that the targeted managed node
have a PMI level setting at or above the rating for the metric you are selecting.

WBSSPI Reports show collected data on all server instances on the targeted node.
Application Group: WBS5P| Reports

Map Actions Edit Yiew Window

HJOECConn 1262_JOECConnPo 12635 JOECCon 1264 _JOECConr 1265 _JOECConn Pool Timeoul
r r r r

opc_adm [Read—¥rite] [Autu—Layuut]

WBSSPI Reports Generated from Alarms

WBS SPI reports are also used to capture the data on a current condition in a server. Such a
report is triggered by an alarm condition and shows an individual server instance on a
managed node. These reports are available by clicking the Annotations button in the OVO
Message Browser. If you have configured your Message Browser to display the SUIAONE
columns, an S the A column (adjacent to the message) indicates that a report has been
successfully generated and is waiting in the Annotations of the message.
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JMX Metric Builder Applications

If you install the WASSPI-UDM-BLDR software bundle, the following applications are
installed in the JMX Metric Builder application group (refer to the HP OpenView Smart
Plug-in User Defined Metrics User Guide for more information about these applications and
how to install the WASSPI-UDM-BLDR software bundle):

e Deploy UDM - Deploys the UDM file.

e Gather MBean Data - Collects MBean information to be used with the JMX Metric
Builder.

e JMX Metric Builder - Launches the JMX Metric Builder application that is used to create
UDMs and browse MBeans.

e  UDM Graph Enable/Disable - Starts/Stops data collection for UDM graphs. Also starts/
stops the OVO subagent.

WBS SPI Templates

WBS SPI template groups provide a means of organizing various OVO templates. The SPI for
WebSphere template group organizes templates into WebSphere High, Medium, and Low
Impact groups, based on the impact that their data collections incur on system performance.
The Low Impact group has only low impact metrics. The Medium Impact group has both
medium and low impact metrics. The High Impact group has all metrics: high, medium, and
low impact metrics. Refer to the HP OpenView Smart Plug-in for WebSphere Application
Server Reference Guide for complete listings of the specific metrics included in each group.

All data collection affects performance in some way, with impact varying according to metric
(counter). The overhead cost associated with each WBS SPI metric is represented with a
rating of high, medium, or low. Metrics with medium or high ratings have higher performance
impacts. The calculations required for the collected data generally require multiplication,
division, or both. A metric with a low rating involves only a minor performance cost since its
calculation requires just a single addition or subtraction.
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WBS SPI Concepts

¥ Message Source Templates 1 [opc_adm]

The SPI for WebSphere template group contains the following template groups and individual
templates:

WBSSPI-Logfiles - Contains templates that generate messages according to log file and
error text detected in both the WebSphere server log files and in the WBS SPI log files.
The information captured from these log files includes errors that occur in the operation of
the WebSphere server or the WBS SPI and changes to WebSphere server configuration.

WBSSPI-Metrics - Contains metric templates that monitor the performance levels and
availability of a WebSphere server.

Each metric template determines the threshold conditions for the monitored metric, the
message text that is sent to the OVO message browser when the threshold is exceeded,
the actions to execute, and instructions that appear.

WBSSPI-Schedule - Contains collector templates that specify the collection interval of
metric templates. Within the name of each collector template is its collection interval. For
example, the collection interval of template WBSSPI-40-High-1h is one hour (where 1h
represents one hour). Each collector template is assigned a collection interval of 5
minutes, 15 minutes, or one hour.

When you open any collector template, you see the metrics collected within the interval
(listed by number, following the -m option of the collector/analyzer command
wasspi wbs ca).

Each collector template controls when and what metrics are collected. Specifically, the
collector template does the following:

— Runs the collector/analyzer at each collection interval

— Specifies which metrics are collected
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>»

e  WBSSPI-Messages - A single template that is used to intercept WBS SPI messages for the
OVO message browser.

e  WBSSPI Discovery - A single template that updates the configuration on the OVO
management server and managed nodes.

WebSphere Template Groups and System PMI Levels

When you deploy a template group on a managed node, the PMI level of the node is
automatically adjusted to that of the template group. For example, deploying the WebSphere
High Impact template group on a node would result in a PMI setting of “high” for the node.

PMI levels, once set, do not automatically revert to lower impact levels, even after removing
templates from a node and/or deploying a lower impact level template group. To lower a PMI
level for a node requires that you manually reset the PMI level within WebSphere.
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2 Installing, Upgrading, and Removing the WBS
SPI

This chapter covers installing, upgrading, and removing Smart Plug-in for WebSphere
Application Server (WBS SPI) components.

The sections that follow provide instructions for:
e Installing WBS SPI

e Removing WBS SPI

e Upgrading WBS SPI

Installing WBS SPI

The OpenView Operations (OVO) management server and discovery package must be
installed before you can install the WBS SPI. It is not necessary to stop OVO sessions before
beginning the WBS SPI installation.

The discovery package and WBS SPI are available on the HP OpenView Smart Plug-ins for
OVO/UNIX DVD.

For a complete list of software requirements, refer to the HP Smart Plug-in for WebSphere
Application Server Release Notes.

) The instructions that follow cover a command line swinstall installation. For HP-UX systems,
you can also use the graphical user interface (GUI). However, the GUI method is not covered
here.

) If you are going to create UDMs, also install the WASSPI-UDM-BLDR software bundle. Refer to
the HP OpenView Smart Plug-in User Defined Metrics User Guide for more information about
this software bundle.

For an HP-UX 11.0 management server, enter:
swinstall -s /cdrom/OV_DEPOT/11l.0HPUX.sdtape WBSSPI
For a Solaris management server, enter:

swinstall -s /cdrom/OV_DEPOT/SOLARIS.sdtape WBSSPI
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WABS SPI Bundles/Filesets

The swinstall commands in the previous section install filesets for all managed node
platforms. If you have only one kind of managed node, you may want to install the filesets
only necessary for the platform you have. Instead of specifying WBSSPI on the swinstall
command, you can specify one or more of the bundle names listed below.

Bundle Name Filesets Description

SPIWebSphereHPUX |WBSSPI-CORE Filesets required for a managed node running
WBSSPI-HPUX on HP-UX.

SPIWebSphereSOL WBSSPI-CORE Filesets required for a managed node running
WBSSPI-SOL on Solaris

SPIWebSphereAIX WBSSPI-CORE Filesets required for a managed node running
WBSSPI-AIX on AIX.

SPIWebSpherelX86 |WBSSPI-CORE Filesets required for a managed node running
WBSSPI-LXx86 on Linux.

SPIWebSphereAll WBSSPI-CORE Filesets required for managed nodes running
WBSSPI-HPUX on HP-UX, Solaris, Windows, AIX, and Linux.
WBSSPI-SOL
WBSSPI-AIX
WBSSPI-LXx86

Removing WBS SPI

The complete removal of the WBS SPI installation deletes all WBS SPI components.
Complete the tasks in the order listed:

e Task 1: Remove the WBS SPI Software from the Management Server

e Task 2: Remove WBS SPI Software from the Node Group and Managed Nodes

e Task 3: Delete WBS SPI Templates and Template Groups

e Task 4: Delete WBS SPI Applications

e Task 5: Delete the WBS SPI Message and Node Groups

e Task 6: Remove the WBS SPI Directory

e Task 7: Remove the Report Package (Optional)

e Task 8: Remove the Graph Package (Optional)
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Task 1: Remove the WBS SPI Software from the Management Server

1
2

Open a terminal window and log on as root.

In the terminal window, enter one of the following: /usr/sbin/swremove WBSSPI or
/usr/sbin/swremove SPIWebSphereAll

The swremove command removes the files from the file system only. The WBS SPI templates
are still in the OVO data repository and must be deleted manually. Before the templates can
be deleted, they (and the WBS SPI software) must be de-assigned from the managed nodes.

Task 2: Remove WBS SPI Software from the Node Group and Managed Nodes

1
2

Open the Node Bank and, from the Actions menu, select Agents = Assign Templates.

Select the WebSphere node group and all managed nodes to which WebSphere templates
have been assigned.

Press the Remove nodes/groups button.

Open the Node Group Bank and select the WebSphere node groups.

From the Action menu click Install/lUpdate SW & Config and select the following check boxes:
e Templates

e Actions

¢ Monitors

e Commands

Select the Nodes in List option button.

Select the Force Update option button.

Click OK to remove the Templates, Actions, Commands and Monitors from the managed
nodes. The following message is displayed in the Message Browser:

The following configuration information was successfully distributed:
Templates Actions Commands Monitors

Task 3: Delete WBS SPI Templates and Template Groups

Starting from the SPI for WebSphere template group, delete all templates and template
groups. Once these templates and template groups have been deleted, delete the SPI for
WebSphere template group.

1

Open the Message Source Templates window and double-click the SPI for WebSphere
template group

Press SHIFT+Click to select all templates and template groups in the SPI for WebSphere
template group.

Click Delete from All....
Click Yes in response to the message:
Do you really want to delete the template(s)?

If additional WBS SPI templates and/or template groups are in the SPI for WebSphere
template group, repeat steps 2 -4 until you have deleted all WBS SPI templates and
template groups from the SPI for WebSphere template group.
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6 Go up one level and delete the SPI for WebSphere template group.

) If you have customized templates (copies of WBS SPI default templates) residing in other
OVO template groups, you should remove them as well.

Task 4: Delete WBS SPI Applications

Unlike templates, applications can all be removed in a single step.
1 Open the Application Bank.

2 Right-click the WBSSPI application group and click Delete.

3 Click Yes in response to the following message:

Do you really want to delete the application group?

Task 5: Delete the WBS SPI Message and Node Groups

1 From the Window menu select Message Group Bank.

In the Message Group Bank window right-click the WBSSPI group and click Delete.
Repeat for the WebSphere group.

From the Window menu select Node Group Bank.

In the Node Group Bank window right-click the WebSphere (High, Low, and Medium)
node group and click Delete.

g A W N

Task 6: Remove the WBS SPI Directory

1 From a command line, remove the WBS SPI directory by entering:

rm -rf /var/opt/OV/wasspi/wbs

Task 7: Remove the Report Package (Optional)

If you installed the WBS SPI report package (on your Windows system running Reporter),
remove it:

1 On the Windows system running Reporter, from the Control Panel, double-click the Add/
Remove Programs icon.

2 Highlight the WBS SPI report package and click Remove.

Task 8: Remove the Graph Package (Optional)

If you installed the WBS SPI graph packages (on the OVO management server and on your
system running OVPM), remove them.

On the OVO management server, run the following command:

/usr/sbin/swremove WBSSPI-GRAPHS
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On a Windows system running OVPM, do the following:
1 From the Control Panel, double-click the Add/Remove Programs icon.

2 Select the WBS SPI graph package (HP OpenView SPI for WebSphere Application Server
- Graphing Component Integration) and click Remove.

On an HP-UX system running OVPM that is not the OVO management server, do the
following (if OVPM is installed on the OVO management server, the files are removed in
Task 1: Remove the WBS SPI Software from the Management Server on page 25):

1 Verify that the graph package is installed. Type swlist | grep WBSSPI-GRAPHS
2 Type swremove WBSSPI-GRAPHS

On a Solaris system running OVPM that is not the OVO management server, do the following
(if OVPM is installed on the OVO management server, the files are removed in
Task 1: Remove the WBS SPI Software from the Management Server on page 25):

1 Verify that the graph package is installed. Type /usr/bin/pkginfo HPOvSpiWbsGc
2 Type /usr/sbin/pkgrm HPOvSpiWbsGc

Upgrading WBS SPI

When you upgrade from a previous installation, all your configuration entries are preserved.

To upgrade the WBS SPI, do the following:

e Task 1: Remove WBS SPI Software from the Management Server

e Task 2: Delete WBS SPI Templates

e Task 3: Delete WBS SPI Applications

e Task 4: Upgrade the Management Server

e Task 5: Assign Operator Responsibilities

e Task 6: Assign Templates

e Task 7: Distribute Templates

e Task 8: Customize Templates

e Task 9: Update WebSphere Log Template

e Task 10: Move Nodes to New Node Group

e Task 11: Delete Node Groups

e Task 12: Distribute Actions, Monitors, Commands, and Templates on page 31
e Task 13: Run the Discover WebSphere Application

e Task 14: Install the New Report Package (Optional)

e Task 15: Install the New Graph Package (Optional)

e Task 16: Configure a Non-Root Agent on a UNIX Managed Node (Optional)

Task 1: Remove WBS SPI Software from the Management Server

1 Open a terminal window and log on as root.
2 In the terminal window, enter the following:

/usr/sbin/swremove WBSSPI
/usr/sbin/swremove WBSSPI-GRAPHS
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Task 2: Delete WBS SPI Templates

>»

Delete all WBS SPI templates and template groups that appear under the SPI for WebSphere
template group and the SPI for WebSphere template group itself. If you have customized any
of the default templates, note these changes (these customizations are not saved).

1 Open the Message Source Templates window and double-click the SPI for WebSphere
template group

2 Press SHIFT+Click to select all templates and template groups in the SPI for WebSphere
template group.

Click the Delete from All... button.
4 Click YES in response to the message:
Do you really want to delete the template(s)?

5 Repeat steps 2 -4 until you have deleted all WBS SPI templates and template groups from
the SPI for WebSphere template group.

6 Go up one level and delete the SPI for WebSphere template group.

If you have customized templates (copies of WBS SPI default templates) residing in other
OVO template groups, you should remove them as well.

Task 3: Delete WBS SPI Applications

Unlike templates, all WBS SPI applications can be removed in a single step.
1 Open the Application Bank.

2 Right-click the WBSSPI application group and click Delete.

3 Click Yes in response to the following message:

Do you really want to delete the application group?

Task 4: Upgrade the Management Server

The WBS SPI software is available on the HP OpenView Smart Plug-ins for OVO/UNIX DVD.

The instructions that follow show the command line usage of swinstall. For HP-UX systems,
you can also use the graphical user interface (GUI), but the GUI method is not covered.

For an HP-UX 11.0 management server, enter:
swinstall -s /cdrom/OV_DEPOT/11l.0HPUX.sdtape WBSSPI
For a Solaris management server, enter:

swinstall -s /cdrom/OV_DEPOT/SOLARIS.sdtape WBSSPI

Task 5: Assign Operator Responsibilities

1 Log on to OVO as administrator (opc_adm).
2 Open the User Bank window, right-click the opc_adm user, and click Modify.

3 Click Responsibilities in the Modify User:opc_adm user window.
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4
5
6

For WBSSPI and WebSphere Message Groups, ensure all check boxes are selected.
Assign the WBSSPI Node or Message Groups to any other appropriate operators.
Click Close.

Task 6: Assign Templates

Assign the WBSSPI-Discovery and WBSSPI-Messages templates to the management server:

1
2

Open the Node Bank window and highlight the management server.

From the Actions menu, select Agents - Assign Templates. The Define Configuration
window opens.

Click Add. The Add Configuration window opens.
Click Open Template Window. The Message Source Templates window opens.

From the Message Source Templates window, in the Template Groups pane, select the SPI
for WebSphere template group.

From the Message Source Templates window, in the right pane, select the
WBSSPI-Discovery and WBSSPI-Messages templates.

From the Add Configuration window, click Get Template Selections. The WBSSPI-Messages
and WBSSPI-Discovery templates appear in the right pane.

From the Add Configuration window, click OK.

Task 7: Distribute Templates

Distribute the WBSSPI-Discovery and WBSSPI-Messages templates to the management
server:

1

o O A WN

Open the Node Bank window and highlight the management server.

From the Actions menu, select Agents - Install/Update SW & Config.

In the Target Nodes section, select Nodes in List Requiring Update.

In the Install/Update Software and Configuration window check the Templates check box.
Select Force Update.

Click OK.

The following message is displayed in the Message Browser:

The following configuration information was successfully distributed:
Templates

The WBSSPI-Discovery and WBSSPI-Messages templates are distributed to the management
server.

Task 8: Customize Templates

If you noted any customizations in Task 2: Delete WBS SPI Templates on page 28, make a
copy of the default templates, and then make these same customizations to the copies. In this
version of the WBS SPI, the templates are no longer grouped by WebSphere version numbers.
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Task 9: Update WebSphere Log Template

Update the audit, deprecated, and informational suppress conditions for the WebSphere Log
Template:

1

From the Message Source Templates window, open the SPI for WebSphere template
group.
Select a WBSSPI-Templates impact group (High, Low, and Medium) and do the following:

a

Open the impact group.

Open the WBSSPI-Logfiles group.

Select the WebSphere Log Template and click Conditions.

Move the Audit, Deprecated, and Informational conditions to the top of the list.

Message and Suppress Conditions

Sphere Log Template

e

Click Close.

Task 10: Move Nodes to New Node Group

Move all managed nodes that are in the SPI for WebSphere node groups to the new
WebSphere node group.

1
2

Open the Node Bank and select the SPI for WebSphere node group.

Double-click each subgroup in the WebSphere 4.0 node group and note the managed nodes
in it.

Go back to the top level of the node bank (where the WebSphere node group is displayed)

Drag and drop or copy and paste the nodes (noted in step 2) from the IP submap to the
appropriate WebSphere node group.
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Task 11: Delete Node Groups

Delete all versioned node groups that are in the SPI for WebSphere node group (WebSphere

4.0).

1 Open the Node Bank and select the SPI for WebSphere node group.
2 Select the WebSphere 4.0 and, from the Edit menu, click Delete.

3 Click Yes in response to the following message:

Task 12

Do you really want to delete the node group?

Distribute Actions, Monitors, Commands, and Templates

At the OVO console, in the Node Bank window, select the nodes or node group on which to
install the WBS SPI.

From the Node Bank’s Actions menu select Agents = Install/lUpdate SW & Config.

In the Install/Update OVO Software and Configuration window select the following
component check boxes:

e Templates

e Actions

¢ Monitors

e Commands

Using this dialog, deploy updated components to the managed nodes.
Check the Force Update check box.

Select the Nodes in list button. Upon completion, the following message and appears in
the Message Browser for each managed node:

The following configuration information was successfully distributed:
Actions Commands Monitors Templates.

) You may see some WBS SPI errors in the message browser which you can ignore (these errors
are the result of the transition to the updated programs). WBS-SPI templates/programs are
updated on the Management Server and selected managed nodes. These errors are resolved
when the upgrade is complete.

Task 13: Run the Discover WebSphere Application

You must run the Discover WebSphere application but there is no need to re-enter any of the
WBS SPI configuration data (all configuration data is preserved). To re-deploy the file, you
can drag and drop multiple nodes at once, node groups, or single nodes. When you re-deploy
the file, relevant information is updated, transmitted, and stored on the node.

1
2
3

At the OVO console, select the nodes in the Node Bank window.
From the Window menu, select Application Bank.

In the Application Bank window select WBSSPI - WBSSPI Admin — Discover WebSphere. (If
the items do not appear, select Map = Reload.)
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4  The Introduction window opens.

Click Next.

A second Introduction window opens. This window displays information about which
properties may be required in order for the discovery process to work.

Read this information and click Next.

Modify the configuration using configuration editor.

’ If you have set the GRAPH_SERVER property, note that this property is no longer
supported in the WBS SPI. Instead, set the GRAPH_URL property.

) If you have set the UDM_DEFINITIONS_FILE property, note that this property
will not be supported in future versions of the WBS SPI. Note the locations of the
UDM files on your managed nodes and delete any occurrence of the
UDM_DEFINITIONS_FILE property from your configuration.

If you individually configured UDMs on your managed nodes, you must instead configure
these UDMs on the management server in the /opt/0V/wasspi/wbs/conf/
wasspl wbs udmDefnintions.xml file (or, set the UDM_DEFINITIONS_SOURCE

property to use another file).

Once you have consolidated your UDMs on the management server, delete your old UDM
files from the managed nodes and distribute the new UDM file to the managed nodes
using the Deploy UDM application.

7 Click Next to save any changes and exit the editor.

8 The Confirm Operation window opens. Click OK.

) If you click Cancel and made changes to the configuration, those changes remain in the
configuration on the management server. To make the changes to the selected managed
nodes’ configuration, you must select those nodes in the Node Bank window, start the
Discover WebSphere application, click Next from the configuration editor, and then click OK.

) Do not close the Discover WebSphere application window until the discovery process has
completed. The discovery process may take several minutes to complete.

Task 14: Install the New Report Package (Optional)

If you installed an older version of the WBS SPI report package (on your Windows system
running Reporter), you must uninstall it and install the new WBS SPI report package.

1

On the Windows system running Reporter, from the Control Panel, double-click the Add/
Remove Programs icon.

Highlight the WBS SPI report package and click Remove.

Follow the steps to install the WBS SPI report package in Integrating with HP OpenView
Reporter on page 77.

Your upgrade is now complete.
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Task 15: Install the New Graph Package (Optional)

If you installed an older version of the WBS SPI graph package (on your system running
OVPM), you must uninstall it and install the new WBS SPI graph package.

On a Windows system running OVPM, do the following:
1 From the Control Panel, double-click the Add/Remove Programs icon.

2 Highlight the WBS SPI graph package (HP OpenView SPI for WebSphere Application
Server - Graphing Component Integration) and click Remove.

3 Follow the steps to install the WBS SPI report package in Integrating with HP OpenView
Performance Manager on page 82.

On an HP-UX system running OVPM that is not the OVO management server, do the
following (if OVPM is installed on the OVO management server, the files are automatically
updated when you install the SPI software):

1 Verify that the graph package is installed. Type swlist | grep WBSSPI-GRAPHS
2 Type swremove WBSSPI-GRAPHS

3 Follow the steps to install the WBS SPI graph package in Integrating with HP OpenView
Performance Manager on page 82.

On a Solaris system running OVPM that is not the OVO management server, do the following
(if OVPM is installed on the OVO management server, the files are automatically updated
when you install the SPI software):

1 Verify that the graph package is installed. Type /usr/bin/pkginfo HPOvSpiWbsGc
2 Type /usr/sbin/pkgrm HPOvSpiWbsGc

3 Follow the steps to install the WBS SPI graph package in Integrating with HP OpenView
Performance Manager on page 82.

Your upgrade is now complete.

Task 16: Configure a Non-Root Agent on a UNIX Managed Node (Optional)

If you are running or planning to run a non-root HTTPS agent on a UNIX managed node,
refer to Configuring a Non-Root HTTPS Agent on a UNIX Managed Node (OVO 8.x Only) on
page 50 for more information.
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3 Configuring the WBS SPI

This chapter covers configuring the Smart Plug-in for WebSphere Application Server (WBS
SPI) for use with OpenView Operations (OVO). To successfully configure WBS SPI, you must
complete all configuration prerequisites, complete WBS SPI configuration (for managed nodes
and the management server), and complete additional configuration based on your
environment.

Configuration Prerequisites

On the OVO management server, complete the following tasks before configuring WBS SPI:

e Task 1: Configure the Management Server to Launch your Web Browser

Task 2: Assign Operator Responsibilities for opc_adm

Task 3: Assign Templates

Task 4: Distribute Templates
Task 5: Update the remactconf.xml File (OVO 8.x Only)

Task 1: Configure the Management Server to Launch your Web Browser

WBS SPI uses the ovweb utility to start your web browser for displaying graphed metrics
(which requires HP OpenView Performance Manager). If you do not use OpenView
Performance Manager (OVPM), skip this task.

1 Enter the browser invocation command in the ovweb. conf file. If no browser invocation
command is included in the ovweb. conf file, ovweb tries to start Netscape Navigator
(which must be version 6.0 or higher).

) The ovweb.conf file must be located in the directory specified by the environment variable
$0V_CONF (used by OVO). To find the OVO directory structure on your management server,
open the /opt/0OV/bin/ov.envvars. sh file and look for the $OV_CONF definition.

The browser invocation command must contain a%s to allow WBS SPI to pass a URL to
the browser. Open the file and insert the command according to the entry syntax and
example as follows:

Syntax: Browser: <browser command> %s
Example: Browser: /opt/netscape/netscape %s

2 Check the Web browser setting. To display the WBS SPI graphs, ensure that your browser
is JavaScript enabled. Check the setting within the browser’s Preferences.

3 In Task 3: Launch Discover WebSphere on page 44, set the following conditional
properties:

e Ifyou are using OVPM, set the GRAPH_URL property.
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For more information about launching a browser in OpenView Operations, consult the man
pages for ovweb, ovweb.conf, and ov.envvars. To access instructions for enabling graph
displays, at a command prompt enter: man ovweb

Task 2: Assign Operator Responsibilities for opc_adm

1 Log on to OVO as administrator (opc_adm).

2 Open the User Bank window, right-click the opc_adm user, and select Modify.
3  Click Responsibilities in the Modify User:opc_adm user window.

4 For WBSSPI and WebSphere Message Groups, ensure all boxes are checked.

=1 Responsibilities for Operator [opc_adm] 10| ]

_| _| _|
_| _| _|
_| _| _|
_| _| _|
_| _| _|
_| _| _|

5 Assign the WBSSPI Node or Message Groups to any other appropriate operators.
6  Click Close.

Task 3: Assign Templates

Assign the WBSSPI-Discovery and WBSSPI-Messages templates to the management server:
1 Open the Node Bank window and highlight the management server.

Chapfer 3



2 From the Actions menu, select Agents = Assign Templates. The Define Configuration
window opens.

ixi Define Configuration =10l x]

3 Click Add. The Add Configuration window opens.

ixi Add Configuration
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4 Click Open Template Window. The Message Source Templates window opens.

il Message Source Templates 1 [opc_adm] =181l

5 From the Message Source Templates window, in the Template Groups pane, select the SPI
for WebSphere template group.

6 From the Message Source Templates window, in the right pane, select the
WBSSPI-Discovery and WBSSPI-Messages templates.

7 From the Add Configuration window, click Get Template Selections. The WBSSPI-Discovery
and WBSSPI-Messages templates appear in the right pane.

ixi Add Configuration =gz

8 In the Add Configuration window, click OK.

Task 4: Distribute Templates

Distribute the WBSSPI-Discovery and WBSSPI-Messages templates to the management
server:

p—

Open the Node Bank window and highlight the management server.

2 From the Actions menu, select Agents — Install/Update SW & Config.

3 In the Target Nodes section, select Nodes in List Requiring Update.

4  In the Install/Update Software and Configuration window check the Templates check box.
5 Select Force Update.
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6 Click OK.
The following message is displayed in the Message Browser:

The following configuration information was successfully distributed:
Templates

The WBSSPI-Discovery and WBSSPI-Messages templates are distributed to the management
server.

Task 5: Update the remactconf.xml File (OVO 8.x Only)

If you are running DCE-based agents on your managed nodes, the discovery process must be
allowed to run automatic actions on the management server. Do the following:

1 Merge (if you have updated this file) or replace the
/etc/opt/0V/share/conf/OpC/mgmt sv/remactconf.xml with the
/opt/OV/wasspi/wbs/0OV/remactconf.xml file.

2 Restart the OVO management server: opcsv -start (you must restart the management
server if you modify the remactconf.xml file)

If the remactconf.xml file is not updated, the discovery process fails.
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WSBS SPI Configuration (Managed Nodes)

To configure WBS SPI, complete the following tasks (for each managed node):
e Task 1: Verify the Application Server Status

e Task 2: Collect WebSphere Login Information

e Task 3: Enable PMI

Task 1: Verity the Application Server Status

Verify that your application servers are running.For WebSphere Server version 4, check the
server’s status from the WebSphere administrative console. Under the General tab, a colored
marker appears next to the Application Server name. A green marker means the server is
running. A red marker means the server is not running.

WebSphere Advanced Administrative Console

= R 5 i |

B WebSphere Administrative Dlomain
— 3 VYirtual Hosts i

— B3 Server Groups : £ Installed Web Modules
=} B2 Modes %

E|- dukat
3 Application Servers
a [Default Serwer

[ Generic Servers

+} B3 Enterprise Applications ! Fault Serw
2 Resources ;

/opt/lebSphere/AppServersbin

E 1716703 10:.., Console Ready,

For WebSphere Server version 5 and above, check the server’s status from the WebSphere
administrative console
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Home | Save | Preferences | Logoul | Help | BB
User 1D & —
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oursun 2
A application server s 8 sarver which provides services reguired to run enterprise applcations. |1
B Sarvers
Applicalion Sarvers
& Applications Totat: 1
B Resources [ Fiter
B Sacurty E Preterences
B Ervviranmenl New Delste I
B System Administration - = i
B Troubleshooting | L L | 2 ‘
| e=rver] |rndc2
WebSphere Status [i] = Prewious  Mests February 24, 2004 74506 PM PST & | |
WebSphere Configuration Froblems
Total Vorkspace Flies 0 () Total Contiguration Frobiams 0
E Preferances =
[&] pare [ [ ¥ iocd inranet P

If you cannot verify the server’s status using the administrative console, run the following
commands on the managed node:

e UNIX: <WebSphere_Install_Dir>/bin/serverStatus.sh -all
For example: /opt/WebSphere/AppServer/bin/serverStatus.sh -all
e  Windows: <WebSphere_Install_Dir>\bin\serverStatus.bat -all

For example: C: \Program Files\WebSphere\AppServer\bin\serverStatus.bat
-all

Task 2: Collect WebSphere Login Information

If security is enabled on the WebSphere server, collect the username and password for each
WebSphere Admin Server. The user must have the local WebSphere administrator privileges
assigned for the WebSphere Admin Server.

The username and password are needed by the WBS SPI discovery process to gather basic
configuration information and by the WBS SPI data collector to collect metrics.

Configuration of WBS SPI is simplified if the same username and password are used by each
WebSphere Admin Server.

If you are using WebSphere version 5.1.0 or earlier, you must use the default WebSphere
Admin Server username and password (the username and password configured when the
WebSphere application server was installed/configured).

If you are using WebSphere version 5.1.1 or later, you should be able to use the username and
password for users/groups assigned to the administrator or operator role.

If you are using LDAP directory, then to access the WebSphere Console from LDAP, you must
create a user account similar to the user account of LDAP in the local WebSphere instance.
You must grant Administrator privileges to this user.
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Task 3:

Enable PMI

If you are running WebSphere server version 5, enable PMI using the WebSphere
administrative console and restart the server. Refer to http:/publib.boulder.ibm.com/
infocenter/ws51help/index.jsp?topic=/com.ibm.websphere.base.doc/info/aes/ae/
tprf_prfstartadmin.html for more information.

PMI is necessary for collecting metrics.

WBS SPI Configuration (from the Management Server)

To configure WBS SPI, from the management server, complete the following tasks:

Task 1:

Task 1: Assign the WBSSPI-Messages Template

Task 2: Distribute Templates, Actions, Monitors, and Commands
Task 3: Launch Discover WebSphere

Task 4: Verify the Discovery Process

Task 5: Add Nodes to a WBS SPI Node Group

Task 6: Distribute WBS SPI Templates

Task 7: Complete Configuration

Task 8: Run the Verify Application

Assign the WBSSPI-Messages Template

Assign the WBSSPI-Messages template to the managed nodes:

1
2

Open the Node Bank window and highlight the managed nodes.

From the Actions menu, select Agents > Assign Templates. The Define Configuration
window opens.

i
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3 Click Add. The Add Configuration window opens.

4  Click Open Template Window. The Message Source Templates window opens.

iXi Message Source Templates 1 [opc_adm]

From the Message Source Templates window, in the Template Groups pane, select the SPI
for WebSphere template group.

6 From the Message Source Templates window, in the right pane, select the
WBSSPI-Messages template.
7  From the Add Configuration window, click Get Template Selections. The WBSSPI-Messages

template appears in the right pane.
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8 From the Add Configuration window, click OK.

Task 2: Distribute Templates, Actions, Monitors, and Commands

1 Highlight the managed nodes on which to install the SPI components.
2 From the Node Bank window’s Actions menu select Agents - Install/Update SW & Config.

3 In the Install/Update VPO Software and Configuration window select the following
component check boxes:

e Templates
e Actions
e  Monitors

e Commands

Using this dialog, you deploy program components to the managed nodes.
%l Install / Update D¥0D Software and Configuration

4  Select the Force Update check box.
5 Select the Nodes in list option button.
6 Click OK.

Upon completion, the following message appears in the Message Browser for each managed
node:

The following configuration information was successfully distributed:
Templates Actions Commands Monitors

The WBS-SPI is now installed on the management server and selected managed nodes. If you
want to install the WBS SPI on other managed nodes, repeat these steps.

Task 3: Launch Discover WebSphere

1 At the OVO console, highlight the nodes in the Node Bank window.

2 From the Window menu, select Application Bank.
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3 Inthe Application Bank window select WBSSPI - WBSSPI Admin and double-click Discover
WebSphere. (If the above does not appear as described, select Map - Reload.)

4  The Introduction window opens. This window contains brief information about the
Discovery application.

Click Next.

5 A second Introduction window opens. This window displays information about which
properties may be required in order for the discovery process to work.

Read this information and click Next.

6 Ifyou have already set the LOGIN and PASSWORD properties, the configuration editor
opens. Go to the next step.

If you have not set the LOGIN and PASSWORD properties, the Set Access Info for Default
Properties window opens.

|

Fleaze enter the Login and Password information,
Thiz information iz required by the SPI to access a secured

application server’s environment,

Login |

Pazzword |

Verify Pazsword |

Customize Next | Cancel |

If security is not enabled on the application server, leave these fields blank, click Next, and
go to step 9.

If security is enabled on the application server, the WebSphere Admin Server login
information is required. Enter the username and password collected in Task 2: Collect

WebSphere Login Information on page 41. The LOGIN and PASSWORD properties are
set to this information.

The LOGIN and PASSWORD properties set in this window are used as the default
WebSphere Admin Server login and password (they are set at the global properties level).
That is, if no NODE level or server-specific LOGIN and PASSWORD properties are set,
this WebSphere login and password are used by WBS SPI to log on to all WebSphere
Admin Servers. For more information about the configuration structure, refer to Structure
on page 141.

If the WebSphere Admin Server login and password are the same for all
WebSphere application servers on all OVO managed nodes, do the following:

a Set the LOGIN and PASSWORD properties in the Set Access Info for Default
Properties window.

b Click Next.
¢ Gotostep 9.
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If the WebSphere Admin Server login and password are different for different
instances of WebSphere, you must customize the WBS SPI configuration by setting the
LOGIN and PASSWORD properties at the NODE or server-specific level (for more
information about the configuration structure, refer to Structure on page 141):

a Set the LOGIN and PASSWORD properties to the most commonly used WebSphere
login and password in the Set Access Info for Default Properties window.

b Click Customize to open the configuration editor.

From the configuration editor, set the configuration properties. Refer to Appendix B, The
Configuration, for more information about using the configuration editor.

Click Next to save any changes and exit the editor.

The Confirm Operation window opens. Verify the nodes on which the operation is to be
performed. Click OK.

) If you click Cancel and made changes to the configuration, those changes remain in
the configuration on the management server. To make the changes to the selected
managed nodes’ configuration, you must select those nodes in the Node Bank
window, start the Discover WebSphere application, click Next from the
configuration editor, and then click OK.

’ Wait for the discovery process to complete before going to the next task. The
discovery process may take several minutes to complete.

Task 4: Verify the Discovery Process

1

Verify that the following messages appear in the Discover WebSphere application window
(the Discover WebSphere application has completed successfully):

Discovery started on node: <node>
Finished running the Discovery application

If the Discover WebSphere application does not complete successfully, the following
message appears in the application window:

Failed to run discovery on node <node>

Refer to Troubleshooting the Discovery Process on page 98 for information on how to
troubleshoot the discovery process.

Verify that the following message appears in the message browser for each managed node:

WASSPI-602- Updating the WBSSPI configuration data with discovered
information

Depending on the number of managed nodes in your environment, it may take several
minutes for these messages to display for all managed nodes.

If Service Navigator is already running, select File > Reload Configurations. In the Services
tree, open the Application node and look for the WebSphere service.

Run the Config WBSSPI application to verify the properties set by the discovery process.
Refer to Configure WBSSPI on page 166 for more information about the configuration
editor.

If you are having problems with the discovery process, refer to Troubleshooting the Discovery
Process on page 98 for information on how to troubleshoot the discovery process.
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Task 5: Add Nodes to a WBS SPI Node Group

WBS SPI automatically creates three node groups which have been assigned the matching
WebSphere High, Medium, or Low template group:

e WebSphere High
e  WebSphere Medium
e WebSphere Low

When you assign a managed node to a WBS SPI node group, you are also assigning the
templates you want to deploy on the node.

) When data collection for the template group begins, the PMI level of the node is adjusted as
necessary to comply with the template group’s impact level. For example, data collection for a
WebSphere High Impact group results in a PMI level adjustment to high for the node if the
WebSphere PMI level is currently not at high. See WebSphere Template Groups and System
PMI Levels on page 22 for additional details.

The High template group contains all WBS SPI metrics, while the Medium group contains
Medium and Low metrics and the Low contains only Low metrics.

To add nodes to a WBS SPI node group, do the following:

1 From the Window menu, open both the Node Group Bank and the Node Bank to display
(side-by-side) the WBS SPI node group and the managed nodes.

2 Drag and drop managed nodes running a WebSphere server into the appropriate WBS
SPI node group, according to the PMI level desired for the node.

Task 6: Distribute WBS SPI Templates

1 Open the Node Group Bank window and highlight a WBS SPI node group.

From the Actions menu, select Agents — Install/Update SW & Config.

In the Target Nodes section, select the Nodes in List Requiring Update radio button.

In the Install/Update Software and Configuration window check the Templates check box.
Select Force Update.

Click OK.

o O A WN

The following message is displayed in the Message Browser:

The following configuration information was successfully distributed:
Templates

The WBS-SPI templates are now distributed to the selected node group. WBS-SPI monitors
now begin running according to their specific collection interval.

) If you use HP OpenView Reporter, see the Chapter 5, Integrating HP OpenView Reporting
and Graphing Products with WBS SPI for information on integrating WBS-SPI with Reporter
for generating WebSphere server reports that show more consolidated information.

Task 7: Complete Configuration

Before configuration is complete, the configuration information on the management server
and managed nodes must be updated. You can either:
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e Wait 10 minutes for the automatic configuration template to run; or

¢ Run the Config WBSSPI application (which updates the configuration information on the
management server and managed nodes). Refer to Configure WBSSPI on page 166 for

more information.

Task 8: Run the Verity Application

Run the Verify application to verify that WBS SPI is properly installed and configured (refer
to Verify on page 174 for more information about this application):

1 At the OVO console, select a WebSphere node group in the Node Group Bank window.

2 From the Window menu, select Application Bank.

3 In the Application Bank window select WBSSPI - WBSSPI Admin and double-click Verify.

Additional WBS SPI Configuration

Based on your WebSphere server configuration and application needs, you must finish WBS
SPI configuration by setting additional configuration properties and/or installing and
configuring additional components. Setting additional properties and configuring additional
components depends on your environment.

Conditional Properties

Based on your WebSphere configuration and application needs, you may need to set one or
more conditional properties. If you meet a condition, set the properties listed to the left of the
condition (these properties are not automatically discovered by the discovery process). For
more information about the properties, refer to Configuration Properties on page 153.

Table 1 Conditional Properties

Conditional Property

When Required

ALIAS

Required if more than one application server on a system
share the same server name. The discovery process
automatically sets the ALIAS property, but you may want to
edit this value as this is the name used in messages, reports,
and graphs.

COLLECT_METADATA

Required if you want to utilize MBean information in the
JMX Metric Builder application to create UDMs.

JAVA_HOME

The value of JAVA_ HOME must include the path to
JAVA .EXE (path to the Bin directory of Java) and not the path
to the actual JAVA_ HOME directory.

Required if:

e using a Java version not supplied with the WebSphere
server.

e there are multiple Java installation directories.
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Table 1 Conditional Properties

Conditional Property When Required

ADDRESS Required if a WebSphere server is configured to a virtual IP
address or is on a remote node.

START_CMD, Required if you want to start and stop a WebSphere

STOP_CMD, and application server from the OVO console.

USER

LOGIN and Required if security is enabled on a WebSphere server.

PASSWORD

MAX_ERROR_LOG_SIZE | Required if you want an error logfile larger than 2 MB.

Setting Conditional Properties

1 At the OVO console, select the nodes in the Node Bank window.
2 From the Window menu, select Application Bank.

3 In the Application Bank window select WBSSPI - WBSSPI Admin - Config WBSSPI. (If the
items do not appear, select Map - Reload.)

The Introduction window opens.
4 Click Next.

5 From the configuration editor, set the properties. Refer to The Configuration Editor on
page 143 for more information about using the configuration editor.

6 Optionally, click Save to save any changes made to the configuration. Once you save your
changes, you cannot automatically undo them.

7  Click Finish or Next to save any changes and exit the editor.
If you click Next, the Confirm Operation window opens. Click OK.

) If you click Cancel and made changes to the configuration, those changes remain in the
configuration on the management server. To make the changes to the selected managed
nodes’ configuration, you must select those nodes in the Node Bank window, start the Config
WBSSPI application, click Next from the configuration editor, and then click OK.

8 Ifyou have added an application server or added/edited the HOME and/or PORT
properties, run the Discover WebSphere application on the managed nodes on which the
application server/properties were added or edited. Running the Discover WebSphere
application updates the Service Navigator map.
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Configuring a Non-Root HTTPS Agent on a UNIX Managed Node (OVO 8.x

Only)

>»

If you are running or planning to run a non-root HTTPS agent on a UNIX managed node
(OVO 8.x only), do the following:

You must install the OS-dependent Sudo software package on the UNIX managed node. Sudo
is free software available from http:/www.sudo.ws. The OS-dependent software packages
are located at the bottom of the download page (http:/www.sudo.ws/sudo/
download.html). Refer to the release notes for more installation information.

1

Switch the HTTPS agent to a non-root user. Refer to the HTTPS Agent Concepts and
Configuration Guide for more information. This document is available from
http://ovweb.external.hp.com/lpe/doc_serv/ under the product Operations for UNIX,
version 8.x.

On the managed node, set the OV_SUDO variable. As root or with OVO agent user
privileges, do the following:

a Stop all OVO agents. Run the following command:
opcagt -kill

b Set the OV_SUDO variable. Run the following command:
ovconfchg -ns ctrl.sudo -set OV_SUDO <sudo_program>

where <sudo_program> is the location (including the absolute pathname) where sudo
is installed (for example, /usr/local/bin/sudo).

c¢ Start the OVO agents. Run the following command:
opcagt -start

d Verify OV_SUDO is set. Run the following command:
ovdeploy -cmd set | grep SUDO
The following displayed:
OV _SUDO=<sudo_program>

Configure the managed node. These steps MUST be completed to successfully run the SPI
in a non-root HTTPS agent environment.

a From the OVO management server, deploy actions, commands, and monitors to the
managed node.

b Select the node in the Node Bank window.

¢ From the Application Bank window, select WBSSPI - WBSSPI Admin - Init Non-Root.
Edit the /etc/sudoers file using the visudo editor (installed with sudo):

a On the managed node, log in as root.

b Open the /<SPI_Config_DIR>/wasspi_wbs sudoers file

where <SPI_Config_DIR> is the location of the SPI’s configuration files on a managed
node. Refer to Managed Node File Locations on page 139 for more information.

¢ In a separate window, run the visudo command (for example, type:
/usr/local/sbin/visudo).

d From the wasspi wbs_ sudoers file, copy and append the following lines to the
sudoers file:
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e

Cmnd Alias WBSSPI _ADMN = /opt/OV/nonOV/perl/a/bin/perl -

wasspi wbs admin *

S

Cmnd Alias WBSSPI COLL = /opt/OV/nonOV/perl/a/bin/perl -S wasspi wbs ca

*

Cmnd Alias WBSSPI DISC = /opt/OV/nonOV/perl/a/bin/perl
wasspi wbs discovery.pl

Cmnd Alias WBSSPI LFEN = /opt/OV/nonOV/perl/a/bin/perl -S wasspi wbs le

*

Cmnd Alias WBSSPI_SHSC = /opt/OV/nonOV/perl/a/bin/perl -

shs collector.pl *

Cmnd Alias WBSSPI ADMNP = /opt/OV/nonOV/perl/a/bin/perl
/var/opt/OV/bin/instrumentation/wasspi wbs admin *

Cmnd Alias WBSSPI COLLP = /opt/OV/nonOV/perl/a/bin/perl
/var/opt/OV/bin/instrumentation/wasspi wbs ca *

Cmnd Alias WBSSPI DISCP = /opt/OV/nonOV/perl/a/bin/perl
/var/opt/OV/bin/instrumentation/wasspi wbs discovery.pl
Cmnd Alias WBSSPI LFENP = /opt/OV/nonOV/perl/a/bin/perl
/var/opt/OV/bin/instrumentation/wasspi wbs le *

Cmnd Alias WBSSPI SHSCP = /opt/OV/nonOV/perl/a/bin/perl
/var/opt/OV/bin/instrumentation/shs collector.pl *

S

<OV_Agent username> <nodename> = NOPASSWD: WBSSPI ADMN, WBSSPI COLL, \

WBSSPI DISC, WBSSPI LFEN, WBSSPI SHSC, WBSSPI ADMNP, WBSSPI COLLP, \

WBSSPI DISCP, WBSSPI LFENP, WBSSPI SHSCP

where <OV_Agent_username> is the OVO agent user account and
<nodename> is the name of the managed node.

Save the file and exit the visudo editor. Type :wgq

) Steps 3 and 4 must be performed every time the agent user is switched.
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WBS SPI in High Availability Environments

High availability is a general term used to characterize environments that are business
critical and therefore are protected against downtime through redundant resources. Very
often, cluster systems are used to reach high availability.

You can configure WBS SPI to accommodate cluster environments where failovers allow
uninterrupted WBS availability. WBS SPI monitoring, when synchronized with the cluster
environment, can switch off from the failed node to the active node.

Configuration Prerequisites

The prerequisites for using WBS SPI in high availability environments are:

e Management Server: HP-UX

e Node: HP-UX MCSG cluster

e OVO 8.x HTTPS Agent version (for details, refer to the Agent cluster support matrix.)

Configuring WBS SPI for High Availability Environments

>»

To configure WBS SPI for use in high availability environments complete the following tasks:
e Task 1: Create the WBS SPI monitoring configuration file
e Task 2: Create the clustered application configuration file

e Task 3: Configure WBS SPI

Task 1: Create the WBS SPI monitoring configuration file

WBS SPI uses a monitoring configuration file <appl name>.apm.xml that works in
conjunction with the clustered application configuration file.

<appl name>is the namespace_name. For more information refer to HP OpenView
Operations for UNIX HTTPS Agent Concepts and Configuration Guide.

The <appl name>.apm.xml file lists all the WBS SPI templates on the managed node so
that you can disable/ enable these templates as appropriate, for inactive/active managed
nodes.

To create this clustered application configuration file for your WBS environment, follow these
steps:

1 Use the following syntax to create the <appl name>.apm.xml file:
<?xml version="1.0"?>

<APMApplicationConfiguration>

<Application>
<Name> ... </Name>
<Template> ... </Template>

<StartCommand>wasspi wbs perl -S wasspi wbs clusterSvrApp -opt
startMonitor $instance</StartCommand>
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<StopCommand>wasspi wbs perl -S wasspi wbs clusterSvrApp -opt
stopMonitor $instance</StopCommand>

</Rpplication>
</APMApplicationConfiguration>
2 Enter application namespace under the <Name></Name> tag.

3 After the file is created save it in the $OvDataDir/bin/instrumentation/conf
directory.

) If there is only one WBS server running on the node, you must mention A/l under the
<template> tag.

Sample <appl_name>.apm.xml file

<?xml version="1.0"?>
<APMApplicationConfiguration>
<Application>

<Name>namespace name</Name>
<Template>All</Template>

<StartCommand>wasspi wbs perl -S wasspi wbs clusterSvrApp -opt
startMonitor $instance</StartCommand>
<StopCommand>wasspi wbs perl -S wasspi wbs clusterSvrApp -opt
stopMonitor $instance</StopCommand>

</Application>

</APMApplicationConfiguration>

) <appl name>.apm.xml is dependent on the application namespace. It is not
dependent on the instance level. Therefore, the start and stop actions are provided
with the associated instance name as their first parameter when they are executed
at package switch time. The environment variable $instanceName is set by C1Aw
when start or stop tasks are performed.

Task 2: Create the clustered application configuration file

The clustered application configuration file apminfo.xml, working in conjunction with the
<appl name>.apm.xnl file of WBS SPI, allows you to associate WBS SPI monitored
instances with cluster resource groups. As a result, when you move a resource group from one
node to another, in the same cluster, monitoring stops on the failed node and starts on the new
node.

To create the clustered application configuration file apminfo.xml follow these steps:
1 Use a text editor to create the file. The syntax is:
<?xml version="1.0" 2>
<APMClusterConfiguration>
<Application>
<Name>namespace name</Name>

<Instance>
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<Name><Instance Name></Name>
<Package><Package Name></Package>
</Instance>
<Application>
</APMClusterConfiguration>
2 Enter namespace_name under the <Name></Name> tag.

3 Save the apminfo.xml file to the $OvDataDir/conf/conf directory.

Sample apminfo.xml file

<?xml version="1.0" 2>
<APMClusterConfiguration>
<Application>
<Name>namespace name</Name>
<Instance>
<Name>instance name</Name>
<Package>test</Package>
</Instance>
</RApplication>

</APMClusterConfiguration>

Task 3: Configure WBS SPI

To configure WBS SPI follow these steps:

1 Launch the Discover WebSphere application with virtual node as the target. For details
about launching the discovery application see Task 3: Launch Discover WebSphere on
page 44.

2 Launch the Configure WBSSPI application with the virtual node as the target The
configuration editor opens.

3 Use the configuration editor to set the following properties (these properties are in
addition to the ones discovered by the Discover WebSphere application) :

e CLUSTERNAMESPACE
e CLUSTERINSTANCE

These properties should have the same value as defined in apminfo.xml file. For
example, CLUSTERNAMESPACE property must be set to namespace name and
CLUSTERINSTANCE must be set to instance name.

4 Copy the SiteConfig file from active node to passive node. The file is located in the
$OvDataDir/conf/wasspi directory.

5 Set the value of ADMIN_HOST property to the name of the managed node that was
activated because of failover.
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4 Using and Customizing WBS SPI

As you become familiar with the Smart Plug-in for WebSphere Application Server (WBS SPI),
you can determine which templates are most useful to you and which you might want to
change. This chapter assists you by providing more detail on the templates and how to make
those changes.

The following topics are covered:

e Basic Template Customizations

e Advanced Template Customizations

e Monitoring a WebSphere Server on Unsupported Platforms
¢ Restoring Default WBS SPI Templates

e Using Templates/Applications to View Annotation Reports
¢ (Checking WBS SPI Nodes for License Count

Basic Template Customizations

>»

After using the WBS SPI, you may decide that some WBS SPI templates need some
modification. Basic customization, such as changing a threshold (by modifying a metrics
template) or modifying alarm generation, are covered in this section.

Make copies of the original templates so that the default templates remain intact. Otherwise,
your customizations are overwritten when you upgrade to the next version.

Modifying Metrics Templates

Many metric attributes can be easily modified for all monitored instances of a WebSphere
server by following these steps:

1 Open the Message Source Templates window.
Open the SPI for WebSphere template group.
Open the desired impact template group and then the WBSSPI-Metrics template group.

Double-click the desired metric to open the Message and Suppress Conditions window.

u A 0 N

Double-click the desired condition to modify (there is usually only one).
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The Condition window opens.

E

Description

Condition

Ohbject Pattern

Threshold Duration

= Suppress Matched Condition Advanced Options...

= Suppress Unmatched Condition

@ + Message on Matched Condition
Set Attributes
Severity Application Message Group Object
critical
Message Text
L PI-2003.1: Admin Serve

Service Name

Message Type
Instructions... Message Correlation...
Actions
On Server Log Only (put directly into History Log)
Node Command

Automatic
Operator initiated

Forward to Trouble Ticket

Notification

0K Cancel Test Pattern Matchi

The following attributes can be modified:

e Threshold: Enter a value for the metric data that when exceeded would signify a
problem either about to occur or already occurring.

¢ Duration: The length of time that the incoming data values for a metric can exceed
the established threshold before an alarm is generated.

e Severity: Click the Severity button and select the desired severity setting.

e Message Text: Be careful not to modify any of the parameters—surrounded by <>
brackets, beginning with $—in a message.

e Actions: This field provides the ability to generate metric reports, or to add custom
programs. In the WBS SPI, automatic actions are configured to generate metric
reports showing data values at the time an exceeded threshold occurred. You can view
a generated WBSSPI report by opening the message’s Annotations.
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The following illustration of the Condition window shows a threshold setting of 95 for
WBSSPI-0005.2. This metric monitors the total number of times per minute clients must
wait for an available EJB (enterprise java bean). A value of more than 95 would start to
impact the server response time the client experiences, generating an alarm (a warning
message).

Description

WBE5SPI-0005.2: Major thresho 1|1

Condition

Object Pattern

Threshold

6 Click OK.
7  Re-distribute the modified template (described in Task 6: Distribute WBS SPI Templates
on page 47).

Modifying Alarm Generation

An alarm can be generated once or multiple times, depending on its Message Generation
setting in the Modify Threshold Monitor window.

To change the change the Message Generation, do the following:

1 Open the Message Source Templates window.

Open the SPI for WebSphere template group.

Open the desired impact template group and then the WBSSPI-Metrics Template group.
Select the template to modify.

Click Modify. The Modify Threshold Monitor window opens.

O A W0 N
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Monitor

External =

Threshold Type Message Generation

Maximuim Minimuim with Reset without Reset Continuous

Message Defaults

Sewverity Application Message Group Object

[unl: oW

Sarvice Name

Instructions. .. Message Correlation... Advanced Options...

Cancel Help

6 Modify the Message Generation:

e With Reset: Alarms are generated once when the threshold value is exceeded. At the
same time a reset threshold value is activated. Only when the reset threshold value is
exceeded, does the original threshold value become active again. Then when the
threshold value is again exceeded, another alarm is generated and the process starts
all over again.

e Without Reset: Alarms are generated once when the monitoring threshold value is
exceeded. Alarms reset automatically when metric values are no longer in violation of
the thresholds and are generated again when the threshold is exceeded.

¢ Continuously: Messages are sent/alerts generated each time the metric values are
collected and the threshold is exceeded.

7 Click OK.
8 Re-distribute the modified template (described in Task 6: Distribute WBS SPI Templates

on page 47).
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Advanced Template Customizations

The template changes suggested here range from making copies of default template groups in
order to customize a few settings, to deleting whole groups of metrics within a template’s
command line. This section is considered advanced because all changes described here,
whether simple or complex, require some advanced knowledge of the WBS SPI metrics.

Choosing Metrics To Customize

Determine which metrics you want to customize and what templates within the group you
want to use. Then, do the following:

1

o O A WN

Open the Message Source Templates window.

Highlight the group you want to use and click the Copy... button.

Rename and save the group.

Within the renamed template group, copy each original template and rename it.
Delete the originals from the new group.

Customize the renamed templates within the group, as necessary.

Creating a new template group allows you to keep custom templates separate from the
original default templates, which you copy and place within the new group.

Using the WBS SPI Collector/Analyzer Command

The wasspi wbs_ca command is used in every collector template, named according to its
collection interval. You can view the default command line parameters within each collector
template in the Command text box in the Modify Scheduled Action window.

The WBS SPI Collector/Analyzer Command Parameters

WBS SPI data collections are started with the wasspi_wbs_ca command, to which you can add
other parameters, as identified in the following table.

Parameter Description Syntax

-m Specifies the metric numbers or number -m <metric_number>

(metric) ranges on which to collect data. Example: -m 1,3-5,9-11,15
-matchver Specifies the specific WebSphere application | -matchver <version_number>

(match version)

server version to monitor. This option may
not be used with the -minver nor -maxver
options. If no matching versions are found,
the command does not execute.

Example: -matchver 4

—maxver

(maximum version) | server version to monitor. Use with -minver

Specifies the highest WebSphere application| -maxver <version_number>

) : : Example: -maxver 5
to specify a range of versions. If no versions

are found, the command does not execute.
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Parameter

Description

Syntax

-minver

(minimum version)

Specifies the lowest WebSphere application
server version to monitor. Use with -maxver
to specify a range of versions. If no versions
are found, the command does not execute.

-minver <version_number>

Example: -minver 4

-r Generate an ASCII report for the specified | -r
(report) metrics
-t Create a new template group by adding a | -m <metric_number> -t <prefix>-
(tag) prefix to an existing collector template Example: -m 220-223 -t DEV-
along with the metric numbers.
-1 List specific servers to monitor. May not be | -i <server_name>
(include) used with the -e option. Example: -i serverl,server3
-e Exclude specific servers from being -e <server_name>
(exclude) monitored. May not be used with the -i Example: -e server2, server4
option.
-x Specify a property/value: -x <property>=<property_value>
alarm: when off, overrides any default -x alarm=off
alarming defined for the metric.
prefix: Default: JMXUDM_. Specify the -x prefix=SALES
prefix of the metric ID.
print: when on, prints the metric name, -x print=on
instance name, and metric value to
STDOUT in addition to any configured
alarming or logging.
log: when off, prevents graphing or -x log=off
reporting functions.
Examples
e To specify metrics to collect:
— specific data on all configured servers:
wasspi_wbs ca -m 10-14,25,26
— data from specific servers only:
wasspi_wbs ca -m 245,246,260 -i serverl, server2
e To not collect data from specific servers:
wasspi_wbs ca -m 220-225 -e serverl,server2
60 Chapter 4



Using JMX Actions Command Parameters

The command parameters described in this section are used to run JMX actions. JMX actions
are one or more JMX calls (invoke, get, set) performed on an MBean instance or type. A single
JMX call can be performed from the command line. Multiple JMX calls can be specified in an
XML file or as a Metric subelement in a UDM file.

Parameter

Description

-a

Required

(action) Indicates a JMX action is performed.
Syntax: -a

-i

(include) Allows you to list specific servers on which to perform the JMX
actions. If this parameter is not specified, the JMX actions are performed on all
configured servers.

Syntax: -i <server_name>

Example: -i serverl, server3

—m

(metric) Specifies the metric ID containing the action to perform. This metric ID
must be defined in a UDM file. This option may not be used with the -mbean
nor -xml options.

Syntax: -m <metric_id>
Example: -m TestUDM 1000

Using and Customizing WBS SF/

6]



62

Parameter

Description

-mbean Performs a JMX call on the specified MBeans. This option may not be used with
the -m nor -xml options.
Syntax: -mbean <objectname> <action>
Example: -mbean WebSphere:type=ThreadPool, * -get maximumSize
where <action> (a JMX call) is one of the following:
-get Returns the value of the apecified attribute.
Syntax: -mbean <objectname> -get <attribute>
Example: -get maximumSize
-invoke [-type]|Executes an MBean operation with the specified
parameters. An operation may not require parameters
(therefore, —-type is not specified). A type parameter must be
specified for operations which accept parameters. -type
supports operation overloading.
Syntax: -mbean <objectname> -invoke <operation>
[-type <parameter_type> <parameter_value>] .
where <parameter_type> is one of the following: short, int,
long, double, float, boolean, java.lang.Short,
java.lang.Integer, java.lang.Long, java.lang.Double,
java.lang.Float, java.lang.Boolean, and java.lang.String.
Example: -invoke setInstrumentationLevel -type
java.lang.String pmi=L -type boolean true
-set Assigns the specified value to the specified attribute.
Syntax: -mbean <objectname> -set <attribute> <value>
Example: -set growable true
-0 (object) Specifies an MBean instance.
Syntax: -o <mbean_instance>
Example: -0 exampleJMSServer
-xml Specifies the XML file that contains the JMX actions to perform. This option
may not be used with the -m nor -mbean options.
Syntax: -xml <filename>
Example: -xml myJMxActions.xml
Examples

¢ Set the maximum size for an alarming thread pool to 500 (where
<SOPTION (instancename) > specifies an alarming instance):

wasspi wbs perl -S wasspi wbs ca -a
-mbean WebSphere:type=ThreadPool, * -set maximumSize 500 -o
<SOPTION (instancename) >

e  Set the instrumentation levels to low on all PMI modules:

wasspi wbs perl -S wasspi wbs ca -a
-mbean WebSphere:type=Perf,* -invoke setInstrumentationlLevel -type
java.lang.String pmi=L

® Use the sample UDM TestUDM_1000 in the wbs UDMMetrics-sample.xml file:
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wasspi wbs perl -S wasspi wbs-ca -a -m TestUDM 1000
-1 examplesServer

Use the sample actions xml file:

wasspi wbs perl -S wasspi wbs-ca -a
-xml /var/opt/OV/wasspi/wbs/conf/wbs JMXActions-sample.xml
-1 examplesServer

Changing the Collection Interval for Scheduled Metrics

To change the metric collection interval, simply change the Polling Interval in the appropriate
collector template. For example, to change the collection of default metrics from 5 minutes to
10 minutes for the WebSphere High Impact template group, follow these steps:

1
2

N OO0 0 AW

Open the Message Source Templates window.

Select the template group SPI for WebSphere and click WebSphere-Templates-High-Impact —
WBSSPI-Schedule-High.

Select the collector template WBSSPI-40-High-05min.

Click Modify... The Modify Scheduled Action window opens.

Change the Scheduled Action Name to WBSSPI-40-High-10min.

Change the Schedule interval in the Minute box from 5m to 10m. For example, 0, 10, 20...

Distribute the new templates (described in Task 6: Distribute WBS SPI Templates on
page 47).

Changing the Collection Interval for Selected Metrics

To change the collection interval for selected metrics, copy the appropriate collector template
and rename with a name reflecting the new interval, deleting all but the metrics you are
changing. Set the new interval. Edit the original template to remove the changing metrics.
For example, to change the collection interval to 10 minutes for metrics 221-225, you would
follow these steps:

1
2

Open the Message Source Templates window.

Select the template group SPI for WebSphere and click WebSphere-Templates-High-Impact —
WBSSPI-Schedule-High.

Select the template WBSSPI-40-High-05min.

Click Copy.... The Copy Scheduled Action window opens. In the Schedule Action Name
box, change the Scheduled Action Name name to WBSSPI-40-High-10min.

In the command box delete all metrics after -m except 221-225.

wasspi_nbs perl sy -5 wasspi_wbs ca -n 20,223,01, |

BaoENTUSER

Change the polling interval to 10m.
Click OK.

In the template group WBSSPI-Schedule-High, select the WBSSPI-40-High-05min template.
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9 Click Modify. The Modify Scheduled Action window opens. Delete 221-225 after -m from
the Command Box.

10 Re-distribute the modified templates as described in Task 6: Distribute WBS SPI
Templates on page 47.

Customize the Threshold for Different Servers

Customize the threshold as needed. For example, you may want to set the threshold to 20 for
SERVER_1 for metric 0212 and leave the threshold at 10 for all other servers. To do so, copy
the existing condition and modify it to serve as the exception. Follow these steps:

1 Double-click the metric to open the metric for customization (for example, double-click
WBSSPI-0212).

The Message and Suppress Conditions window is displayed.
2 Select the desired condition and click Copy... to make a copy of the condition.
3 Name the condition WBSSPI-0212.2.
4 In the Object Pattern field, enter the following details:
<ServerName>:<ServerPort>:<NodeName>:<*>:<*>:<*>

For Example: If you want to set threshold for the application server SERVER], enter the
following:

SERVER1 : <*>:<*¥>:<*¥> 1 <*x> 1 <* >

5 Click Test Pattern Matching... to test the pattern and verify pattern matching (you must set
up a match file first).

6 Change the value in the Threshold field from 10 to 20.

Creating Custom, Tagged Templates

Another advanced customization option is to use the tag option (-t on the command line),
which allows the collector/analyzer to recognize customized templates that have a tag
attached to the name. This option provides you with the flexibility of using more than a single
set of templates to define conditions pertaining to specific installations of a WebSphere server.
It also preserves templates from being overwritten when an upgraded version of the WBS SPI
is installed.

When multiple nodes are managed by a number of groups, this option allows you to create
specially tagged templates that are obviously separate from your original setup. In such a
case, you would make copies of the templates, rename them with the tag, re-work the collector
template to pick up the tagged names, then assign them to the various groups.

For example, you might create a group of templates and change each template name to
include CLIENTO1 in it. A metric monitor template might be named
CLIENTO01-WBSSPI_0212 (retaining the metric number, which must be used). The collector
template name would be named FIRST_CLIENT-40-05min. You could then set up another
group for SECOND_CLIENT and change all those templates to include the CLIENTO0Z2 in the
name.
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To create the new template group

1 Copy the original template group. In the Message Source Templates window select the
group and click Copy....

2 Name the new group according to how you plan to identify the new schedule and collector
templates; for example, if you are including CLIENTO1 in the template names, include
that within the new template group name.

3 In the Message Source Template window expand the new template group to show all
templates and select each template you plan to use, click Copy..., and rename it according
to your naming scheme.

¢ The names you give the new metric monitor templates in the group would contain the
new name followed by the original metric number. For example, a copy of
WBSSPI-0001 could be called CLIENT01-WBSSPI_0001.

¢ The name you give the new collector schedule template would also contain the
identifying name. You would also modify the scheduled collection for the new group by
inserting the -t property on the command line. For example:

wasspi_wbs ca -m 16 -t CLIENTOl1-

4 Delete all original templates from the new group.

Template Variables

The following variables are used by the WBS SPI templates. If you are creating your own
templates, you may use these variables.

Name Description

instancename The instance for which the metric is being reported for multi-instance
metrics.

map_port See port. This variable may be deprecated in future releases.

map_servername

The application server name with spaces replaced with underscores (“_").
Used for service map keys where spaces are prohibited.

Example: my server

node The node on which the application server is running.
Example: mool.hp.com

port The port on which the application server is listening. Corresponds to the
PORT configuration property.
Example: 9001

servername The application server name. Corresponds to the NAME configuration

property.
Example: my server
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Monitoring a WebSphere Server on Unsupported Platforms

The WBS SPI supports monitoring WebSphere server systems running on HP-UX, Solaris,
Linux (Red Hat), AIX, and Windows 2000. However, it is possible to configure the WBS SPI to
monitor WebSphere server systems running on unsupported platforms—systems we refer to
as “remote systems.”

The intent of this section is to help you determine if your environment is conducive to setting
up remote monitoring. If you determine that your environment meets the criteria described
below, you have some expertise in using the WBS SPI, and you have expertise in using the
WebSphere server, this section offers an example to get you started.

Requirements for Monitoring Remote Nodes

For a WebSphere server system running on an unsupported platform, you can use WBS SPI to
monitor that remote system if the following conditions apply (the last condition is optional):

e The remote system is covered by a purchased license (using Tier 1 pricing).

e The WBS SPI runs on at least one managed node on a supported platform: HP-UX,
Solaris, Linux (Red Hat), AIX, or Windows 2000.

e The local/proxy system and remote system must be running the same version of
WebSphere server. For example if the proxy system is running WebSphere server version
5, the remote system must also be running WebSphere server version 5.

¢ The remote system runs on a platform supported by the OVO agent software (optional, for
logfile monitoring).

Overview

The following section provides an overview of remote monitoring and shows how it is
implemented. Also included are details on how to set up the WBS SPI to access WebSphere
server metrics and logfiles on unsupported platforms by using both the WBS SPI and OVO
agent software.

Remote Monitoring
In a standard configuration, WBS SPI programs/templates are deployed on the local,

managed node. In a non-standard configuration, the local system is used as a proxy through
which remote metric information becomes accessible.
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Remote system data collection/interpretation relies on the local, managed node to act as the
proxy on which data collection is configured.

OpenView Operations OpenView Operations
Managed Node Management Server

Proxy System

Configuration entries requirement: Within the configuration, entries for both local and
remote systems are included. You can include multiple remote system entries in a local
system’s section. See example on Task 1: Configure the Remote WebSphere Server System on
page 68, showing how the remote entry appears (with system IP address).

Template deployment requirement: Templates for the correct WebSphere PMI level should be
deployed on the local node. If you need a separate template group (for example High Impact or
Medium Impact) to cover a different level, you can copy and rename the existing templates
and specify the WebSphere Server name on the command line using the -i or -e options. Refer
to a previous section in this chapter Using the WBS SPI Collector/Analyzer Command on
page 59 for details on using these command line parameters.

OVO agent deployment requirement (optional logfile monitoring): To access remote
WebSphere server logfiles, the OVO agent software must be installed on the remote system.
Using standard OVO processes, you can modify the standard logfile templates included with
the WBS SPI to specify the correct logfile names, then deploy them to the remote system.

) Monitoring remote systems using logfile versioning is not supported.

Configuring Remote System Monitoring

You can monitor a WebSphere server on remote systems (running on platforms other than
HP-UX, Solaris, Linux, AIX, or Windows 2000) by completing the following tasks.
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Task 1: Configure the Remote WebSphere Server System

Using the Config WBSSPI application in the OVO WBSSPI Application Bank, you configure
each local managed node that communicates with a remote WebSphere server. In the
configuration you include additional entries for remote WebSphere servers.

1 Choose a WebSphere server managed node from which to monitor the remote WebSphere
server.

2 At the OVO console, launch the Config WBSSPI application. In the Application Bank
window select WBSSPI - WBSSPI Admin - Config WBSSPI.

3 In the configuration that appears, include an entry for each remote WebSphere server
system: SERVER<n> ADDRESS=<DNS server name or IP address>

Be sure that NUM_SERVERS is set to the correct number of servers (<n>) and that
HOME and JAVA_HOME are set at the global level.

The illustration below shows how local and remote WebSphere servers are configured in
the same file. Notice, however, that for the remote servers, the

SERVER<n> ADDRESS=<IP_address> (SERVER2 ADDRESS=15.75.27.109 or

SERVER2 ADDRESS=harley.rose.hp.com) line is added:

HOME=/opt/WebServer/AppServer

JAVA HOME=/opt/WebServer/AppServer/java
NODE local node ({

NUM SERVERS=2

SERVER1 NAME=lara

SERVER1 PORT=900

SERVERZ NAME=harley

SERVERZ2 PORT=905

SERVERZ2 ADDRESS=harley.rose.hp.com

}

There are two WebSphere servers configured in the preceding configuration. SERVER1 is
the local server, running on an HP-UX managed node. SERVER2 is running on an
OVO-managed node, that is a non-Red Hat Linux system (a platform unsupported by
WBS SPI). The remote system is configured similar to that of the local system but
contains the new line SERVER2 ADDRESS=harley.rose.hp.com.

4 To verify that the SPI is monitoring the remote node, run the following command:

wasspi_wbs_perl -S wasspi_wbs_ca -m 5 -i <remote_server NAME|ALIAS> -x
print=on

You must use ALIAS if it is set for the remote server.
Task 2: Integrate the OpenView Performance Agent (Optional)
Since the OpenView Performance Agent (also known as the MeasureWare Agent) collection
occurs on the managed node (not the remote system), if you use PerfView and would like to

graph the remote system data, you must ensure that MeasureWare integration is enabled on
the (local) managed node.

Task 3: Assign Local Node to a WBS SPI node group

Assign the local managed node to the appropriate node group. For example, you would assign
the local node to the WBS High node group if the local and remote managed nodes are to
collect metrics that require the system be set at a high WebSphere PMI level.

68 Chapter 4



Configuring Remote Logfile Monitoring (Optional)

Monitoring remote system logfiles is supported if the following is true:
e The remote system that has an OVO agent running on it and
e The system does not re-version logfiles when they roll.

To set up logfile monitoring, at the OVO console you copy the WBS SPI logfile template and
then configure, assign, and deploy the copied logfile template to the remote system.

Configure the Logfile Template for Remote Logfiles
1 Open a copy of the WebSphere Log Template located under WBSSPI-Logfiles in the SPI
for WebSphere group. For example, SPI for WebSphere > WBSSPI-Lodfiles.

2 In the Logfile text box, enter the location of the logfile on the remote system: /<path>/
<file_name>.

3 Assign and deploy the logfile template to the remote OVO-managed node.

The log file template and the OVO agent, both present on the remote system, make
WebSphere server logfile monitoring possible.

OpenView Operations OpenView Operations
Managed Node Management Server
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Remote Monitoring Limitations

e The WBS SPI and the OVO agent do not support access to logfiles that are re-versioned
each time the logs are rolled.

e  When no OVO agent is present on the remote system, monitoring of WebSphere server
logfiles on the remote system cannot occur.
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¢ In the OpenView Operations Application Bank, WBS SPI applications cannot be executed
on remote systems.

¢ The proxy system and remote system must be running the same version of the WebSphere
server.

Restoring Default WBS SPI Templates

When WBS SPI templates are installed in OVO, the commands shown below automatically
uploads them when swinstall is run. Any customized template settings you may have done for
the previous installation are overwritten.

To restore the default SPI for WebSphere template groups you originally installed:
1 Delete all current templates.

Run the command:
/opt/OV/bin/OpC/opccfgupld -silent -replace \
-subentity var/opt/OV/share/tmp/OpC_appl/wasspi/wbs_set

Alternatively, you can use the -verbose option instead of the -silent option.
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Using Templates/Applications to View Annotation Reports

Some templates have actions defined with threshold violations or error conditions that
automatically cause reports to appear in the message Annotations. These reports are
snapshots of data values collected form the server around the time that the alarm occurred.

) The reports discussed in this section should not be confused with those generated by
OpenView Reporter, which show more consolidated, historical data generated as Web pages
in management-ready presentation format.

You can access the data as follows:

e To view the Message Details. Double-click a message in the OVO message browser, or just
select the message and click Annotations. Reports are available there, showing data
values on a single server.

e To view reports. Open both the Node Bank and Application Bank windows. Continue to
open application windows WBSSPI > WBSSPI Admin - Reports. Select a node and drag it
onto the WBS SPI metric report you need. These reports show all server data on a node.

Automatic Action Reports

Many metrics generate Automatic Action Reports. These reports show data on a single
WebSphere server instance with an exceeded threshold. They are generated as soon as the
alarm is triggered in OVO.

Viewing an Automatic Action Report

When an Automatic Action Report is executed from OVO, the server is queried for additional
data. If your message browser is set to display the SUTAONE column, you will see an “S”
under the “A” column (see illustration), which indicates that a successfully generated report is
available in the Annotations area of the Message Details.

=

Browser Actions View Window

Sev.Dup. SUIACNE Date Time
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To view an automatically generated metric report relating to an alarm condition, click
Annotations... in the Message Browser. Column descriptions provide further clarification.
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Application Bank Reports

Application Bank reports run for all WebSphere server instances configured on the managed
node. The reports generated from the Application Bank reflect the current state of a
WebSphere server on the managed node. You manually generate these reports in OVO by
dragging the managed node from the Node Bank window to a specific metric report among
those shown in the Application Bank window.

WBS SPI reports require that the targeted managed node have a PMI level setting at or above
the rating (as shown in the table below) for the metric you are selecting

Table 2 Performance Impact Ratings (PMI Levels) of Reporting

Metrics
Low 5,42,222,224,247,265
Medium 40, 221, 246, 262
High 41,212, 213, 220, 261, 263, 264

When manually generated, a report from the Application Bank > WBSSPI Reports window
shows that metric data for ALL WebSphere server instances on the managed node.

Application Group: WBSSPI Reports
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The Application Bank report below was generated for Metric #5 (1005).
= Output of Application No. 1

Default Server

MHMemllti 1Pt

Free i ) = Heap Memory

Checking WBS SPI Nodes for License Count

You can use an OVO reporting utility to check the number of templates you have installed on
your managed nodes. In reviewing the number of templates per managed node, you can see if
you have consistently installed templates across your managed systems. In addition, by
running this report, you can also ensure that the number of licenses you have purchased is in
compliance with the report results.

To run the report:

1 At the OVO console select the node or node group that you want to check.

2 From the Actions menu select Utilities > Reports....

3 In the Reports window among the reports listed select WBSSPI License Check.
4

Select an output destination and click OK.
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5 Integrating HP OpenView Reporting and
Graphing Products with WBS SPI

The Smart Plug-in for WebSphere Application Server (WBS SPI) can be integrated with the
following HP OpenView reporting and graphing products (these products must be purchased
separately):

e HP OpenView Reporter (Reporter)

e HP OpenView Performance Agent (OVPA)

e HP OpenView Performance Insight (OVPI)

e HP OpenView Performance Manager (OVPM)

HP OpenView Reporter: Reporter produces management-ready, web page reports, showing
historical and trending information. This is not the version of Reporter that is included with
HP OpenView Operations.

Working in conjunction with Reporter, the WBS SPI produces a variety of reports showing
consolidated information on the WebSphere Application Server.

Refer to Integrating with HP OpenView Reporter on page 77 for more information on how to
integrate WBS SPI with Reporter. After integrating WBS SPI with Reporter, every night,
Reporter generates reports that show the performance and availability of a WebSphere
Application Server on configured managed nodes.

HP OpenView Performance Agent: OVPA collects, summarizes, time stamps, and detects
alarm conditions on current and historical resource data across your system. It provides
performance, resource, and end-to-end transaction response time measurements, and
supports network and database measurement information. Refer to the HP OpenView
Performance Agent for UNIX User’s Manual for more information about OVPA.

If you are using OVPA, WBS SPI automatically uses it. If you want to use the HP OpenView
Operations subagent (CODA) that is included with HP OpenView Operations (does not
support OVPA), you must configure your managed nodes to do so. Refer to Integrating with
CODA on page 76 for more information.

HP OpenView Performance Insight: OVPI is a network management system that collects,
processes, and reports data. The data is used to generate reports. Refer to the HP OpenView
Performance Insight Administration Guide for more information about OVPI. Refer to the
Application Server Report Pack User Guide for more information about WBS SPI reports and
how to integrate WBS SPI with OVPI.

HP OpenView Performance Manager: OVPM provides graphing capability of WBS SPI
metrics. This is not the version of OVPM that is included with HP OpenView Operations.

Refer to Integrating with HP OpenView Performance Manager on page 82 for more
information on how to integrate WBS SPI with OVPM. After integrating WBS SPI with
OVPM, graphs are available the following day.
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Integrating with CODA

The WBS SPI can detect if you are using OpenView Performance Agent (OVPA or
MeasureWare Agent). If you are, the WBS SPI installation automatically uses it.

If you want to use the HP OpenView Operations subagent (CODA) included with OVO 7 .x,
you must configure the managed nodes to do so. Note that this configuration does not support

OVPA.

To use CODA, set up an empty file named nocoda.opt and store it on the managed node:

1 On the managed node, create a nocoda.opt file in the following directory:

Operating System

File Location

HP-UX, Linux, Solaris

/var/opt/0OV/conf/dsi2ddf/

AIX

/var/lpp/OV/conf/dsi2ddf/

Windows

\usr\ov\conf\dsi2ddf\

If the directory dsi2ddf does not exist, create it.

2 Save the empty file.
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Integrating with HP OpenView Reporter

WBS SPI must be installed and configured before it can be integrated with Reporter.

If you are upgrading the WBS SPI report package, you must remove the old version before
installing the new version. Refer to Task 14: Install the New Report Package (Optional) on
page 32 for information on how to remove the WBS SPI report package.

The WBS SPI report package must be installed on the Windows system running Reporter:

1 On the Windows client system, insert the Smart Plug-ins DVD-ROM (that contains the
reporting packages) into the DVD-ROM drive, and in Windows Explorer go to the
directory \OV REPORTER\WEBSPHERE SPI 04.20.000\ and double-click
WBSSPI-Reporter.msi -

2 Follow the instructions as they appear.

3 Check the Reporter status pane to note changes to the Reporter configuration.

’ For Windows 2000 managed nodes, during the installation, an error message may
appear that indicates the installer has detected an older version of the installer on
your system. You can safely ignore the message and continue.
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The Reporter main window displays IBM WebSphere Availability and Performance

reports.

15*Reporter

File Wiew Action Help
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P& E % 7L
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1| 1M WebSphere EJB Pool Misses

| 1BM ‘WebSphere EJG Pool Size
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| 16M ‘WebSphere EJB Response Time
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[]--@ Systemn Information

You can find instructions in the Reporter Help for assigning WBS SPI reports to the
targeted nodes. To access Help, select Reports or Discovered Systems in the left panel of
the Reporter main window and right-click it. Select Report Help or Discovered Systems
Help from the submenu that appears. See the topic “To assign a report definition to a
Discovered Systems Group.”

Add group and single system reports by assigning reports as desired. (See the Reporter
Help and the online Concepts Guide for complete information.

) Group and single system WBS SPI reports require that you identify systems by
their full name. For example, abc.xyz.comis acceptable while abc is not.

WABS SPI Reporter Reports

The reports available through the integration of HP OpenView Reporter and WBS SPI show
consolidated data on server performance and availability on all WebSphere server systems. In
addition, other reports show data for single systems. These reports are available the day
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following your installation of the WBS SPI report package on the Reporter Windows system.
See Integrating with HP OpenView Reporter on page 77 if you have not yet completed the
report package installation.)

The two tables that follow show all pre-defined reports.

Table 3  All/Group Reports
Report Title Description Metric
Availability Shows the percent uptime for all WebSphere servers by day. 2
Top 20 Servers— Transaction | Shows the average throughput for the top 20 execute queues of | 77
Throughput all servers.
Top 20 Servers—JDBC Shows the average throughput for all connections pools on the 66
Connection Pool Throughput server for the top 20 servers.
Top 20 Servers—Servlet Shows the total servlet request rate for the top 20 servers. 45
Request Rate
Top 20 Servers— Servlet Shows the total servlet sessions being handled by the top 20 41
Sessions servers.
Top 20 Servers— Servlet Shows the average response time for the top 20 requested 245
Average Response Time servlets for all servers for the reporting period.
Top 20 Servers— EJB Method | Shows the number of all EJB method calls per minute for the top | 22
Calls Rate 20 servers.
Top 20 Servers— Entity EJB Shows the number of all Entity EJB loads and stores to/from the |24
Load/Stores Rate database per minute for the top 20 servers.
Table 4 Single System Reports
Report Title Description Metric
Server Availability Details Contains spectrum graphs showing minutes of uptime by day and | 2
hour for each WebSphere server.
Admin Server Availability Shows the uptime percent for each WebSphere Admin server by |4
Details day.
EJB Average Response Time Shows the average response time for the top 20 EJBs for a server | 221
for the reporting period.
EJB Method Calls Rate Shows the number of all EJB method calls per minute for the top | 22
20 EJBs for a server.
Entity EJB Load/Stores Rate Shows the number of all EJB loads and stores to/from the 224
database per minute for the top 20 EJBs on a server.
EJB Pool Utilization Shows the EJB pool utilization as a percent for the top 20 EJBs | 220
on a server.
EJB Pool Misses Percent Shows the percent of time that a call to retrieve an EJB from the | 225
pool was not successful during the collection interval for the top
20 EJBs.
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Table 4

Single System Reports (cont’d)

Report Title Description Metric
EJB Pool Size Shows the average pool size for the top 20 EJBs for one server for| 223
each day.
JDBC Connection Pools Charts the throughput against the utilization for the JDBC 263
Throughput vs. Utilization connection pools on the selected server, one chart for each
connection pool.
JDBC Connection Pools - Charts the connection pool size against the average wait time for | 260
Size vs. Wait Time a connection for the JDBC connection pools on the selected
server, one chart for each connection pool.
JDBC Connection Pools - Charts the number of clients waiting for a database connection | 265
Clients Waiting vs. TimeoutRate| from the pool against the timeout rate for waiting clients for the
DB connection pools on the selected server, one chart for each
connection pool.
JCA Connections Utilization - Shows the JCA resource connection pool utilization as a percent. | 250
Top 20 Resources
Transaction Throughput Shows the average transaction throughput for the selected server| 77
by day.
Thread Pool Activity Charts the average size of the thread pool against the average 211
number of active threads for all thread pools on the selected
server, one chart for each thread pool.
Servlet Request Rate Shows the request rate (per second) for the top 20 servlets for one | 245
server for each day.
Servlet Average Response Time -| Show the average response time for the top 20 requested servlets | 246

Top 20 Servlets

for one server for the reporting period.

OVPI Reports for WBS SPI

The reports available through the integration of HP OpenView Performance Insight and WBS
SPI show consolidated data on server performance and availability on WebSphere application
server systems. Refer to the Application Server Report Pack User Guide for more information
about WBS SPI reports and how to integrate WBS SPI with OVPL.
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The table that follow shows all pre-defined reports.

Report Title Description Metric
Server Availability— The server availability chart plots the availability status |2, 77
Throughput of the application server on an hourly, daily, and monthly
basis. The transaction throughput chart displays the
number of transactions processed by the application
server per second.
EJB Pool Utilization The percentage of EJB pool utilization. 20
JDBC Throughput— The percentage of available JDBC connection in the 66, 263
Utilization connection pool and the number of clients serviced by the
connection pool per second.
Near Real Time Server | The server status for the last six hours. 2,77
Availability
Servlet Request Rate— | The servlet request rate measures the number of requests | 45, 246
Response Time for a servlet per second. The servlet response time chart
shows the average execution time for an individual
servlet.
EJB Load-Stores Rate | The number of all entity EJB loads and stores to and from | 24
the database per minute for the top 20 servers. For the
selected server, it lists the top 20 EJBs.
EJB Method Calls Rate | The number of all EJB method calls per minute for the top| 22
20 servers.
EJB Top 20 The percentage of EJB retrievals that were not successful | 25,
during the collection interval, the average pool size, and | 221,
the average response time in milliseconds for the top 20 | 223
EJBs.
JDBC Connection Pool | The average number of connections allocated per day for |61, 65,
Details the top 20 servers. The DB pool is shown along with 260,
clients waiting, client timeout rate, average pool size, and | 266
average wait time.
Servlet Sessions The total number of servlet sessions being handled by the | 41
top 20 servers.
Thread Pool Activity Comparison of the average size of thread pools with the | 210,
average number of active threads on the selected server. | 211
Transaction Throughput | The average number of transactions processed per second | 77
by the top 20 servers for the previous day.
81
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Integrating with HP OpenView Performance Manager

To integrate WBS SPI with OVPM, do the following:

1 Install and configure the WBS SPI. Verify that you have completed Task 1: Configure the
Management Server to Launch your Web Browser on page 35. Also, verify that you have
set the GRAPH_URL property. Refer to Property Definitions on page 155 for more
information about the GRAPH_URL property.

2 Ifyou are upgrading the WBS SPI graph package, you must remove the old version before
installing the new version. Refer to Task 15: Install the New Graph Package (Optional) on
page 33 for information on how to remove the WBS SPI graph package.

3 Install the graph package.
On a Windows system running OVPM, do the following:

a Insert the Smart Plug-ins DVD-ROM (that contains the reporting packages) into the
DVD-ROM drive, and in Windows Explorer go to the directory
\OV_PM\WEBSPHERE SPI 04.20.000\WINDOWS\ and double-click
HPOvSpiWbsGc-04.20.000.msi.

b  Follow the instructions as they appear.

On an HP-UX system running OVPM that is not the OVO management server, do the
following (if OVPM is installed on the OVO management server, the files are already
swinstalled when you install the SPI software):
a Mount the Smart Plug-ins DVD-ROM (that contains the reporting packages) and
type:
swinstall -s <mount_point>/OV_PM/WEBSPHERE SPI 04.20.000/HPUX/
HPOvSpiWbsGc-04.20.000.sdtape WBSSPI-GRAPHS

On a Solaris system running OVPM that is not the OVO management server, do the
following (if OVPM is installed on the OVO management server, the files are already
installed when you install the SPI software):

a Mount the Smart Plug-ins DVD-ROM (that contains the reporting packages) and
type:

/usr/sbin/pkgadd -d <mount_point>/OV_PM/WEBSPHERE SPI 04.20.000/
SOLARIS/HPOvSpiWbsGc-04.20.000.sparc all

4 To graph any WebSphere server metric, use the data source name WBSSPI METRICS.

Refer to the OVPM documentation for information on how to view the graphs. Graphs are
available the day following integration.

WSBS SPI Metrics Available for Graphs

The table that follow show the graphs available for mapping collected metric values. Use
OVPM to view any one of the metrics included in any of these tables.

Table5 JVM

Metric Number/Name Metric Description

1005_JVMMemUtilPct Percentage of heap space used in the JVM.
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Table 6

Server Performance

Metric Number/Name

Metric Description

1013_ ThrdPoolPctMax

Percentage of time Number of threads in pool reached
configured maximum size.

1014_ThrdPoolCrtRt

Number of threads created per minute.

Table 7 Enterprise Java

Beans (EJB)

Metric Number/Name

Metric Description

1020_EJBPoolUtil

Percentage of active beans in the pool.

1022_EJBMethCallsRt

Number of EJB method calls per minute.

1024_EJBEntDatLdStRt

Number of times an EJB was written to or loaded from the
database per minute.

1025_EJBPoolMissPct

Average Percentage of time a call to retrieve an EJB from the
pool failed.

1026_EJBConcLives

Average Number of bean objects in the pool.

Table 8 Servlets

Metric Number/Name

Metric Description

1040_ServSessAveLife

Average lifetime of a servlet session in milliseconds.

1041 _ServSessActSess

Number of sessions currently being accessed.

1042_ServInvSessRt

Number of sessions being invalidated per second.

Table 9

Web Applications

Metric Number/Name

Metric Description

1045_WebAppServReqRt

Number of requests for a servlet per second.

1047_WebAppServErrRt

Number of errors in a servlet per second.

1048_WebAppServLoad

Number of servlets currently loaded for a web application.

1049_WebAppServRelRt

Number of servlets reloaded for a web application per
minute.

Integrating HP OpenView Reporting and Graphing Products with WBS SPI
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Table 10 JDBC

Metric Number/Name

Metric Description

1061_JDBCConPoolWait

Average number of threads waiting for a connection from
connection pools

1062_JDBConPoolWtTim

Average time that a client waited for a connection in
milliseconds.

1065_JDBConPoolTimRt

Number of times a client timed out waiting for a connection
from the pool per minute.

1066_JDBCConPoolThru

Number of connections allocated and returned by
applications per second.

Table 11 Transactions

Metric Number/Name

Metric Description

1070_TranGlobDur

Average duration of global transactions.

1071_TranLocDur

Average duration of local transactions.

1072_TranGlobCommDur

Average duration of commits for global transactions.

1073_TranLocCommDur

Average duration of commits for local transactions.

1074_TranRollbackRt

Number per second of global and local transactions rolled
back.

1075_TranTimeoutRt

Number per second of timed out global and local
transactions.

1076_TranCommitRt

Number per second of global and local transactions that were
committed.

1078 TranStartRtt

Number per second of global and local transactions that were
begun.

Example Integration

The following is an example of how to graph multi-instance data stored in a data source by
reporting each OBJECTNAME for the METRICID for each SERVERNAME. The result is all
data for all instances are reported in one graph. The data for each SERVERNAME can also be

displayed in a separate graph.
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This example also uses the Java interface option of OVPM.

1 Start the Java Interface option of OVPM. The Performance Manager Java Interface

window opens.

Display | Design |

0) New & Open... [ Save | save As.. X Delete. [& Preview @ Help M

Datagource: i

Default Selection: ]Mnm

draw the graph.

[~ Complex Graph Design using multiple sources

Mote: The default selection is only used during graph design to preview the graph and refrieve metric
information. dnce you finish design and save the graph, you can then make mulliple selections to

2 From the Performance Manager Java Interface window,

General

Metries |
Sources |
it
Highlight
T-Filter

a Click the Display tab at the top of the window, and then the Sources tab at the right of

the window.

b Click - | next to the Datasource text box and select a data source
(WBSSPI_RPT METRICS).

¢ Click - |nextto the Default Selection text box and select the node on which the data
source resides.
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3 Click the General tab at the right of the window.

Display | Design |
| D_\\I@.eﬁﬂpan Sm E e Yiaa EPMIW ? Hmp ............................
el  General |
Sublitie: | Wetrics
Type: Im Sources
Description: —II
Highlight
Biorhotiintis Paints Every: T-Filter
Duration: |3 [gays =] | |5 minutes -
Ending: ©  Mow = Last Limit Number of Points to:
© Date: Tirne: I
| + Ef{oo: 00/
Shift
[~ Owerride Shitt Defaulls
Start |00: 00 |= Ston = I Skip Holidays
Days ¥ Sun P mMon ¥ Tue W wed B Thu B Fri | Sat
Metric Display Order:
" Average data value
= Label (alphabetical)
~ I

4 From this window,

a Select line from the Type drop-down list. This generates a line graph.
b Enter a Date Range.
c¢ Enter an interval using the Points Every drop-down list.

d Click Label (alphabetical) if you want the graph key sorted alphabetically.
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5 Click the Metrics tab at the right of the window and click Add. The Metric Selection
window opens.

Metric Selection X

w3 cPU ]
- [3¥% NETIF
M Fg
- [§# DIEK
- 3# WBSSPI_METRICS WRBSSPI_METRICS
= % WBSSPI_RPT_METRICS\WBSSPI_RPT_METRICS
; INTERWAL
METRICID
CBJECTMAME
SERVERMAME
SORTID
VALUE ||
YALUEID

Lahel: |
Type: IIinE 'l
W Axis: IIeﬂ vl

b o e A
") ) i G

color: [ ] Adto =]

Line Style

stle: [solid <] Marker [ione =] widh:f
Fill Style

Style: Isnlid vl

Mizsing Data: Ihidden vl

Filter: | |
0]58 I Cancel | Help |

6 From the Metric Selection window,

a Next to the WBSSPI_RPT METRICS data source, click + to expand it in the tree.
b Select the check box next to VALUE.
c¢ Click OK.
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7 In the window with the Metrics tab selected, VALUE is displayed. Select the line on which

VALUE is displayed and click Properties. The Metric Properties window opens.

Metric Properties - WBSSPI_RPT_METRICS:WBSSPI_RPT_METRICS:V...
Label [@@SERVERNAME @@OBJECTHAME
Type:  |lable =|
¥ e [let =]
Color I:l."d.ﬁu j

Line Style

giyle: [zoid =] warker | =] wadtn: |

Fill Shde

stte: Jsoid 7]
Mizsing Crata: lm Sum m
Instance: | |
Filter: LSERVERNAME=" G &L0BJECTMAME= J

Ok | Cancel | Help |

8 From the Metric Properties window,
a In the Label text box, enter:

— QE@SERVERNAME : @ROBJECTNAME if you are creating one graph with all
SERVERNAMESs

— @QROBJECTNAME if you are creating one graph with one SERVERNAME
b In the Marker drop-down list, select any marker other than none.
¢ In the Missing Data drop-down list, select:
— previous to use the previous value if data is missing from the data source
— zero to use the value zero if data is missing from the data source
d Click - | next to the Filter text box. The Metric Filter window opens.
& Metric Filter =
METRICID = | =] |n

9  From the Metric Filter window,
a Select METRICID from the first drop-down list.
b Select = from the second drop-down list (if it isn’t already selected).
c¢ Enter a metric number (for example, 11) in the text box.
d Click OK.
10 From the Metric Properties window,
a In the Filter text box, append the following:

— &&SERVERNAME=Q & §OBJECTNAME=@QQ if you want one graph to display all
SERVERNAME/OBJECTNAME combinations.
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— &&SERVERNAME="<server_ name>” &&OBJECTNAME=G if you want one graph to
display one SERVERNAME and all OBJECTNAMEs associated with the
multi-instance metric.

If you cannot edit the Filter text box, you can edit this item in the graph template file.
Refer to step 13 for more information.

b  Click OK.
1 Click Save As at the top of the window. The Save As window opens.

Save As A
Family: | j
Category: | j
Mame: | j

Help

12 From the Save As window,

a Enter a family (for example, WBSSPI_Graphs) in the Family text box. The family
name serves as a group to organize the graphs.

b Enter a name (for example, metric_11) in the Name text box to uniquely identify the
graph.

¢ Entering text into the Category text box is optional.

d Click OK. The information is saved in a graph template file named
VPI GraphsUser<family>.txt (for example,
VPI GraphsUserWBSSPI Graphs.txt).

For more information about this window, refer to the online help.

13 Edit the graph template file. The file is located in the OpenView data directory on the
system of the OVPM instance on which you are working. The graph file may look similar
to the graph in Figure 1.
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Figure 1

#*************************k**k******************

#* OpenView Performance Manager
#* user Defined Graph Templates
#* Last Updated: 07/25/04 04:31_30 AM by [1.2.3.4]

#**********************************************

FAMILY: WBSSPI_Graphs

GRAPH: Metricll
GRAPHBACKGROUND: None
DATERANGE: 1 day
GRAPHMULTIPLEGRAPHS: Yes
POINTSEVERY: raw
DATASOURCE: mwa
SYSTEMNAME : mool

CLASS: WBSSPI_RPT_METRICS:WBSSPI_RPT_METRICS
METRIC: VALUE

FILTER: METRICID=11&&SERVERNAME=Q&&OBJECTNAME=@
LABEL: @QE@SERVERNAME :@@QOBJECTNAME

COLOR: Auto

MARKER: rectangle

MISSINGDATA: previous

END_GRAPH:

GRAPH: Metricll_2
GRAPHBACKGROUND: None
DATERANGE: 1 day
GRAPHMULTIPLEGRAPHS: Yes
POINTSERVERY: raw
DATASOURCE: mwa
SYSTEMNAME: mool

CLASS: WBSSPI_RPT_METRICS:WBSSPI_RPT _METRICS
METRIC: VALUE

FILTER: METRICID=11

LABEL: @QE@SERVERNAME :@QOBJECTNAME

COLOR:Auto

MARKER: rectangle

MISSINGDATA: previous

END_GRAPH:

mool

There can be more than one set of data for a graph in the graph template file.

a

Add SUMFROMRAW: to the end of the first section of each graph (in the example above,
add SUMFROMRAW: after SYSTEMNAME : mool). This allows OVPM to summarized data

from the data source and cannot be added using the GUI.

If you were unable to edit the Filter text box in the Metrics Properties window in

step 10, edit the FILTER field.
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c¢ Save the file. The graph file now contains the following:

#*********************************************

#* OpenView Performance Manager

#* user Defined Graph Templates

#* Last Updated: 07/25/04 04:31_30 AM by [1.2.3.4] mool
#**********************************************
FAMILY: WBSSPI_Graphs

GRAPH: Metricll

GRAPHBACKGROUND: None

DATERANGE: 1 day

GRAPHMULTIPLEGRAPHS: Yes

POINTSEVERY: raw

DATASOURCE: mwa

SYSTEMNAME: mool

SUMFROMRAW :

CLASS: WBSSPI_RPT_METRICS:WBSSPI_RPT METRICS
METRIC: VALUE

FILTER: METRICID=11&&SERVERNAME=@Q&&OBJECTNAME=@
LABEL: @E@SERVERNAME:@QOBJECTNAME

COLOR: Auto

MARKER: rectangle

MISSINGDATA: previous

END_GRAPH:

GRAPH: Metricll_2
GRAPHBACKGROUND: None
DATERANGE: 1 day
GRAPHMULTIPLEGRAPHS: Yes
POINTSERVERY: raw
DATASOURCE: mwa
SYSTEMNAME: mool
SUMFROMRAW :

CLASS: WBSSPI_RPT METRICS:WBSSPI_RPT_METRICS
METRIC: VALUE

FILTER: METRICID=11&&SERVERNAME=@&&OBJECTNAME=@
LABEL: @@SERVERNAME:@EeOBJECTNAME

COLOR:Auto

MARKER: rectangle

MISSINGDATA: previous

END_GRAPH:
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14 From the Performance Manager Java Interface window, click the Display tab.

| Display | Design |
Select one or more sources to see a list of avallable graphs,
Sources: ||ndnidual Systems = Graphs:
[~ 5 [moat ﬁ| #-gail Userhick s

e R A * 5@ UserPauline

e B HP-UX x| | E-5f UserPauline Test

[=1-gall WebSphere SPI
Add.. ] Clear |  Find._ J 24 Metric11
] c— — Q}.{MBD‘IEH_?
System Information i -l fest -

Date Range Foints Every.

Duration: [1 |days  =|  |3minutes o

Ending  How Last [ Display graph in HTML

" Date: Time:
Shift
[~ Cwerride Shit Defaults
. —
Stant - Stop = jn
Days [ o [+ [~ [~ = #
Logon Diray Help

15 In this window,

a In the window below the Sources text box, navigate to the server on which the data
source resides.

b  In the Graphs window, navigate to the family of graphs and select the graph you
created.

c¢ Enter information into the Date Range dialog box and Points Every text box.

d Click Draw. The graph appears.

) If you edit the graph from the Design tab, the SUMFROMRAW: entry is deleted from
the graph template file. You must edit the graph template file and re-enter this
entry.

16 From the SPI, enable graphing

a From the OVO console, open the Node Bank window and select a node or groups of
nodes on which you want to enable graphing.

b Open the Application Bank window.
c¢ In the Application Bank window select WBSSPI > WBSSPI Admin.
d Double-click UDM Graph Enable.
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6 Basic Troubleshooting and Error Messages

Using the Self-Healing Info Application

Preferred troubleshooting method: Troubleshooting information is enhanced with
cross-referencing capabilities available through the HP support site: http://
support.openview.hp.com/self _healing.jsp. To access this information and the search
capabilities available on the site, you must first download and configure the Self-Healing
Services client software, an added benefit of your HP support contract. A link is then
automatically set up to the self-healing services web site, where your SPI problem can be
matched to similar SPI problems/solutions for increased troubleshooting effectiveness. Refer
to the Self-Healing Services section in the HP OpenView Smart Plug-ins DVD Installation
Guide for UNIX for information on how to download, configure, and use the software and its
automatic link to the HP web site support service.

Alternative troubleshooting method: If self-healing services is not installed/configured on
the node, you can use the Self-Healing Info application. This application also gathers SPI
troubleshooting data and stores it in a file that you submit to HP support for assistance. Refer
to Self-Healing Info on page 170 for more information about using this application.
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Log and Trace Files

Management Server

The following log file is found on the management server (typically, /<%OQOuvInstallDir%>/ is

/var/opt/0V)

File Type

Filename

Description

UNIX Managed Nodes

Log

/<%O0vlInstallDir%>/wasspi/wbs/log/
<managed node> disc_ server.log

Records the updates done by the WBSSPI Discovery policy to the
management server’s configuration for each managed node. Log files
are overwritten each time the discovery policy is run on the managed
node. Logging to this file is always enabled.

The following log and trace files are found on the managed nodes running on UNIX (typically,
/<OvAgentDir>/ is /var/opt/0OV/ or /var/lpp/0OV/):

File Type
Filename

Description

File Type
Directory

Description

File Type
Directory

Description

Log
/<OvAgentDir>/1og/javaagent.log

OVO discovery agent log file containing the status of the OVO
discovery agent. By default, logging to this file is enabled at
LoG_LEVEL 3. Set the LOG_LEVEL variable in <OvAgentDir>/conf/
svcDisc/OvJavaAgent.cfg to 6 or higher (up to 9) to capture
troubleshooting information (the higher the number, the more
information is collected). To disable this log, set the LOG_LEVEL to
0. Additional information can be configured in this file to define log
file size and the number of archived files kept. By default, the log file
size is 1MB and five archived versions are kept.

Log
/<OvAgentDir>/wasspi/wbs/log/config.log
Records output from the WBS SPI configuration scripts.

Log
/<OvAgentDir>/wasspi/wbs/log/errorlog

Records WBS SPI error messages. This log file is monitored by WBS
SPI policies.
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File Type
Directory

Description

File Type

Filename

Description

File Type

Directory

Description

File Type

Directory

Description

Basic Troubleshooting and Error Messages

Log
/<OvAgentDir>/wasspi/wbs/log/discovery.log
Records output from the WBS SPI discovery process.

Trace

/<OvAgentDir>/wasspi/wbs/log/discovery.trace (archived
files have a three digit number appended to the filename)

Discovery binary trace file used by your HP support representative.
By default, tracing to this file is enabled. To disable tracing, in
<OvAgentDir>/bin/instrumentation/

wasspi wbs discovery.pl, set the $trace_on variable to 0. To
enable this trace, set the $trace_on to 1. When instrumentation is
deployed, the wasspi wbs discovery.pl file is overwritten
(therefore, if you disable tracing, it becomes enabled when
instrumentation is deployed). Five archived versions are kept. A new
trace file is created when the discovery policy is run.

Trace

/<OvAgentDir>/wasspi/wbs/log/trace.log (archived files have
a three digit number appended to the filename)

Trace file used by your HP support representative. This file gives
information about the CollectorServer, regardless of whether the
Collector is set to PERSISTANT or TRANSIENT mode in the
SPIConfig file. The default value of the Collector Mode is
'PERSISTENT".

By default, tracing to this file is disabled. To enable this tracing, use
the Start Tracing application.

Trace

/<OvAgentDir>/wasspi/wbs/log/traceCollectorClient.log
(archived files have a three digit number appended to the filename)

Trace file used by your HP support representative. This file gives
information about the CollectorClient when the Collector is set to
'PERSISTENT' mode in the SPIConfig file. The default value of the
Collector Mode is 'PERSISTENT".

By default, tracing to this file is disabled. To enable this tracing, use
the Start Tracing application.
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Windows Managed Nodes

The following log and trace files are found on the managed nodes running on Windows
(typically, <OvAgentDir> is

\Program Files\HP OpenView\Installed Packages\{790 ...}\):

File Type Log

Filename \<OvAgentDir>\1og\javaagent.log

Description OVO discovery agent log file containing the status of the OVO
discovery agent. By default, logging to this file is enabled at LoG_LEVEL
3. Set the LoG_LEVEL variable in
<OvlnstallDir>\conf\svcDisc\OvJavaAgent.cfg to 6 or higher
(up to 9) to capture troubleshooting information (the higher the
number, the more information is collected). To disable this log, set the
LOG_LEVEL to 0. Additional information can be configured in this file
to define log file size and the number of archived files kept. By default,
the log file size is 1MB and five archived versions are kept.

File Type Log

Directory \<OvAgentDir> \wasspi\wbs\log\config.log

Description Records output from configuration scripts.

File Type Log

Directory \<OvAgentDir> \wasspi\wbs\log\errorlog

Description Records WBS SPI error messages. This log file is monitored by WBS

SPI policies.

File Type Log

Directory \<OvAgentDir> \wasspi\wbs\log\discovery.log

Description Records output from the WBS SPI discovery process.

File Type Trace

Filename \<OvAgentDir>\wasspi\wbs\log\discovery.trace (archived
files have a three digit number appended to the filename)

Description Discovery binary trace file used by your HP support representative.

By default, tracing to this file is enabled. To disable tracing, in
<OvAgentDir>\bin\instrumentation\wasspi wbs discovery.
pl, set the $trace_on variable to 0. To enable this trace, set the
$trace_on to 1. When instrumentation is deployed, the
wasspl wbs discovery.pl file is overwritten (therefore, if you
disable tracing, it becomes enabled when instrumentation is
deployed). Five archived versions are kept. A new trace file is created
when the discovery policy is run.
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File Type

Directory

Description

File Type

Directory

Description

Basic Troubleshooting and Error Messages

Trace

\<OvAgentDir> \wasspi\wbs\log\trace.log (archived files have a
three digit number appended to the filename)

Trace file used by your HP support representative. This file gives
information about the CollectorServer, regardless of whether the
Collector is set to PERSISTANT or TRANSIENT mode in the
SPIConfig file. The default value of the Collector Mode is
'PERSISTENT".

By default, tracing to this file is disabled. To enable this tracing, use the
Start Tracing application.

Trace

\<OvAgentDir>\wasspi\wbs\log\traceCollectorClient.log
(archived files have a three digit number appended to the filename)

Trace file used by your HP support representative. This file gives
information about the CollectorClient when the Collector is set to
'PERSISTENT' mode in the SPIConfig file. The default value of the
Collector Mode is 'PERSISTENT".

By default, tracing to this file is disabled. To enable this tracing, use
the Start Tracing application.
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Troubleshooting the Discovery Process

If the discovery process does not automatically discover multiple installations on a Windows
managed node, set the HOME_LIST property and run the Discover WebSphere application.

If the discovery process does not automatically discover and update the WBS SPI
configuration do the following:

1

Check for errors in the message browser of the managed nodes not being discovered.
Follow the instruction text of any error messages displayed.

Verify that a WebSphere application server is installed on the managed node. If an
application server is not installed, install an application server, and complete the
configuration tasks listed in Chapter 3, Configuring the WBS SPI.

Verify the WebSphere application server status. The application server must be running.
See Task 1: Verify the Application Server Status on page 40 for more information.

On a Windows managed node, verify the installation directory of the server (\Program
Files\WebSphere\AppServer or \WebSphere\AppServer). If the WebSphere
application server is not installed in the default path, configure the HOME property using
the non-default installation path.

On a UNIX managed node, if the WebSphere application server processes are not running
(use ps -ef to check for these processes), verify the installation directory of the server
(see WebSphere Application Server Default Installation Path (UNIX) on page 98 for the
default path). If the WebSphere application server is not installed in the default path,
configure the HOME property using the non-default installation path.

Table 12 WebSphere Application Server Default Installation Path (UNIX)

Operating System Default Installation Path
AIX /usr/WebSphere/AppServer
HP-UX, Linux, Solaris /opt/WebSphere/AppServer
6  Verify that the Config WBSSPI application is not running. Only one process can access the

configuration at a time. If Config WBSSPI is running, other processes that must access
the configuration (like the discovery process) hang until the configuration becomes
available.

Check if the OVO management server is suppressing duplicate messages:

a From the OVO console, select Actions = Server = Configure. The Configure
Management Server window opens.

b  Look for the “Suppress and count duplicate messages” check box. If this box is
checked, uncheck it.

Check the /<%0VAgentDir>/wasspi/wbs/log/discovery.log file for additional
information.

Restart the OVO management server:
a Stop all OVO GUIs that are running by selecting File — Exit.

b  Stop the OVO management server processes. Enter:
/opt/OV/bin/ovstop opc ovoacomm
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¢ Delete all OVO temporary files. All pending messages (messages not saved in the
database) and all pending actions (automatic actions, operator-initiated actions,
scheduled actions, and command broadcast) are lost. Enter:
rm -f /var/opt/OV/share/tmp/OpC/mgmt_sv/*

d Restart the OVO management server process. Enter:
/opt/0OV/bin/OpC/opcsv -start
/opt/OV/bin/OpC/opcsv -status

e Restart the OVO GUI. Enter: opc

Troubleshooting Applications

Problem

Configuration variable SERVER<n> STOP CMD missing for server Default
Server

Solution

Before you can successfully run the Stop WebSphere application, you must
set the STOP_CMD and USER properties. Set these properties using the
Config WBSSPI application. Refer to Configure WBSSPI on page 166 for
more information about this application.

Problem

Configuration variable SERVER<n> START CMD missing for server, Default
Server

Solution

Before you can successfully run the Start WebSphere application, you
must set the START_CMD and USER properties. Set these properties
using the Config WBSSPI application. Refer to Configure WBSSPI on
page 166 for more information about this application.

Problem

For WebSphere 6.1, Stop WebSphere application does not stop WebSphere
Application Servers.

Cause

Stop WebSphere application does not work well if security is enabled in

WBS and the username/password options are specified while setting the
STOP_CMD property.

Workaround

Edit the <connection type>.client .props file on the managed node. For
details refer to
http://www-1.ibm.com/support/docview.wss?uid=swg21142299
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Problem

When launched, the Verify application gives improper output.

Solution

Before you launch the Verify tool ensure that you have installed the latest
version of Self-Healing Service (SHS) component (version 2.20) from the
SPI DVD. If you upgrade WBS SPI without the SPI DVD then you must
upgrade the SHS component also. You can download the SHS component
from

http://support.openview.hp.com/self healing downloads.jsp.

Problem

When launched, the Self-Healing Info application gives improper output.

Solution

Ensure that you have installed the latest version of Self-Healing Service
(SHS) component (version 2.20) from the SPI DVD. If you have upgraded
WBS SPI without the SPI DVD then you must upgrade the SHS component
also. You can download the SHS component from
http:/support.openview.hp.com/self healing downloads.jsp.

Problem

When launching the applications, the applications hang or there is no output.

Solution

The applications will not work if the memory is low. Check the performance of
the node and the management server. The physical memory available must
be more than 500 MB.

Problem

Check WebSphere application shows a wrong status for a server instance or
does not give any output.

Solution

If a server is up and running but Check WebSphere application returns the
server status as NOT_RUNNING (or does not give any output), then turn ON
the monitoring for that particular server by using the Start Monitoring
application.

Problem

Datasource not getting created on RHEL 4.0 platform.

Solution

Ensure that you have installed the latest version of DSI2DDF component
(02.22.000) from the SPI DVD. If you have upgraded WBS SPI without the
SPI DVD, then you must upgrade the DSI2DDF component also. You can
download the latest DSI2DDF component from:
ftp://ovrntfs.rose.hp.com/prelim/dsi2ddf/02.22/HPUX11.00/
DSI2DDF_A.02.22.00.sdtape
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Error Messages

This section provides information on error messages resulting from conditions detected in the
operation of the Smart Plug-in for WebSphere Application Server (WBS SPI), not the
WebSphere server. The error messages discussed here are all within the WBSSPI Message
Group.

For any given problem, only the most recent error message is displayed (the older error
message is automatically acknowledged). This reduces the number of error messages
displayed in the message browser.

WASSPI-]

Description | Unable to create the lock file <filename>. File already exists.
Severity Critical
Help Text Probable Cause:

Temporary lock files are used to avoid collisions when multiple WebSphere SPI data
collector processes attempt to access the same data file. This error occurs when the lock file
cannot be created after several attempts because it already exists.

Suggested Action:

If a file by the same name already exists, it may not have been deleted by a previous run of
the WebSphere SPI data collector. You should delete this file manually.

WASSPI-2

Description | Cannot access the SPI configuration.
Severity Critical
Help Text Probable Cause:

A WebSphere SPI configuration file could not be located or accessed. Either the file does
not exist or there was a problem reading the file.

Suggested Action:

1 Verify that the collector template that runs the WebSphere SPI data collector specifies
the correct directory on the command line. The option
-Dwasspi .config.dir=<configDirectory>must be specified on command line
invocation of the data collector. <configDirectory> must be /var/opt/OV/wasspi/wbs/conf
on Unix platforms or /usr/OV/wasspi/wbs/conf'on NT platforms.

2 Verify that the WebSphere SPI has been configured correctly by running the Verify
utility from the Application Bank. If the configuration is not correct, run the
WebSphere SPI configuration utility from the Application Bank to reinstall the files.

3 Refer to the text following the error message in the WebSphere SPI error log to help
identify the underlying cause of the problem, e.g. an I/O exception. You can view the
SPI error log for a managed node by using the 'View Error File' application in the
Application Bank window. You can view the SPI error log for a managed node by using
the 'View Error File' application in the Application Bank window. The error message
can be identified by the date/time stamp.
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WASSPI-3

Description | Error parsing command line.

Severity Critical

Help Text Probable Cause:

The WBS SPI data collector command line is incorrectly specified in a schedule template.

Suggested Action:

1 Refer to the text following the error message in the WebSphere SPI error log to help
identify the data collector command line syntax error. You can view the SPI error log
for a managed node by using the View Error File application in the Application Bank
window. The error message can be identified by the date/time stamp.

2 Ifthe error occurred in a schedule template that shipped with the WebSphere SPI,
reinstall the SPI and run the WebSphere SPI configuration utility from the Application
Bank.

3 Ifthe error occurred in a schedule template not shipped with the WebSphere SPI,
correct the schedule template that contains the incorrect command line. Refer to the

WebSphere SPI User's Guide for more information on the WebSphere SPI data
collector command line.
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WASSPI-4

Description | Error getting the metric definitions.
Severity Critical
Help Text Probable Cause:

The WBS SPI data collector could not read the metric definitions XML document. This
error can be caused by a missing configuration property, an I/O error, an XML parsing
error, a missing file, or a corrupted serialized data file.

Suggested Action:

1 Refer to the text following the error message in the WebSphere SPI error log to help
identify the underlying cause of the problem. You can view the SPI error log for a
managed node by using the 'View Error File' application in the Application Bank
window. The error message can be identified by the date/time stamp.

2 Ifthe METRIC_DEFINITIONS_FILE property is missing from the WebSphere SPI
configuration file, reinstall the SPI and run the SPI configuration utility from the
Application Bank.

3 Ifthe problem is with the metric definitions file (MetricDefinitions.xml) that is shipped
with the WebSphere SPI, then reinstall the WebSphere SPI. Run the SPI configuration
utility from the Application Bank.

4 If the problem is with a user-defined metric definitions file that is not shipped with the
WebSphere SPI, verify that this XML file adheres to the MetricDefinitions.dtd
specification. Refer to the WebSphere SPI's User's Guide for more information on
writing user-defined metrics. Reinstall your user-defined metric definition file. Run the
SPI configuration utility and verify that the UDM_DEFINITIONS_FILE property in
the SPI configuration file, is specified correctly.

6 Ifthe underlying error is ClassNotFound, then this is an internal error. Report this to
HP support.

WASSPI-5

Description | Error processing metric <metric_number>.
Severity Major
Help Text Probable Cause:

An error occurred while trying to collect data or perform calculations for the specified
metric.

Suggested Action:

Refer to the text following the error message in the WebSphere SPI error log to help
identify the underlying cause of the problem. The error messages previous to this one may
also provide more information about the problem. You can view the SPI error log for a
managed node by using the View Error File application in the Application Bank window.
The error message can be identified by the date/time stamp.
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WASSPI-6

Description | Required property <property name> is missing from the WebSphere configuration.

Severity Major

Help Text Probable Cause:

The specified required property is missing from the WebSphere SPI configuration file.
Suggested Action:

1 Run the WebSphere SPI configuration utility from the Application Bank. Verify that

you have specified the correct server information for the WebSphere servers on this
managed node.

2 Verify the property is specified correctly in the WebSphere SPI configuration file (/
var/opt/0OV/wasspi/wbs/confSiteConfig on Unix platforms or /usr/0ov/
wasspi/wbs/confSiteConfig on NT platforms) on the managed node in question.

WASSPI-7

Description | Unable to contact server <server_name> at url=<URL>, port=<port>.

Severity Critical

Help Text Probable Cause:

The specified server is not running at the specified port.

Suggested Action:

1 Run the WebSphere SPI configuration utility from the Application Bank. Verify that you

have specified the correct server name and port information for the WebSphere servers
on this managed node.

2 Verify that the properties, SERVERx_NAME and SERVERx_PORT, are specified
correctly in the WebSphere SPI configuration file (/var/opt/0OV/wasspi/wbs/conf
SiteConfig on Unix platforms or /usr/0V/wasspi/wbs/confSiteConfigon NT
platforms) on the managed node in question.

3 Verify that WebSphere server is running on the managed node.
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WASSPI-8

Description | Error saving graphing or reporting data to file <file name>.

Severity Critical

Help Text Probable Cause:

If the error message specifies the reporting data file, the agent on the managed node may
be in an inconsistent state.

Suggested Action:
Restart the agent on the managed node.

Probable Cause:

The specified graphing or reporting data file could not be found or an I/O error occurred
when trying to access the file.

Suggested Action:

1 Refer to the text following the error message in the WebSphere SPI error log to help
identify the underlying cause of the problem. You can view the SPI error log for a
managed node by using the View Error File application in the Application Bank
window. The error message can be identified by the date/time stamp.

Identify the steps to reproduce the problem.

Turn on tracing and reproduce the problem. Refer to the WebSphere SPI User's Guide
for instructions on how to turn on tracing.

4 Run the Gather Info application.
5 Contact HP support with the information gathered in the previous steps.

WASSPI-9

Description | Unable to retrieve property <property. name>.

Severity Critical

Help Text Probable Cause:
A required property is missing from one of the WebSphere SPI configuration files.
Suggested Action:

1 Refer to the text following the error message in the WebSphere SPI error log to help
identify the underlying cause of the problem. You can view the SPI error log for a
managed node by using the View Error File application in the Application Bank
window. The error message can be identified by the date/time stamp.

2 Run the WebSphere SPI configuration utility from the Application Bank. Verify that
you have specified the correct information for the WebSphere servers on the managed
node in question.

3 Verify that the missing property is now specified in the WebSphere SPI configuration
file (/var/opt/0OV/wasspi/wbs/conf SiteConfig on Unix platforms or /usr/ov/
wasspi/wbs/confSiteConfig on NT platforms) on the managed node in question.
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WASSPI-10

Description | Encountered problem accessing file <filename>.

Severity Critical

Help Text Probable Cause:

The specified file could not be found, created, or accessed. This file could be a temporary
file.

Suggested Action:

1 Refer to the text following the error message in the WebSphere SPI error log to help
identify the underlying cause of the problem. You can view the SPI error log for a
managed node by using the View Error File application in the Application Bank
window. The error message can be identified by the date/time stamp.

2 Verify that you have enough disk space to create temporary files.

WASSPI-11

Description | No servers have been specified in the WebSphere SPI configuration file.

Severity Major

Help Text Probable Cause:

The number of WebSphere instances specified in the WebSphere SPI configuration file for
the managed node in question is 0.

Suggested Action:

1 Run the WebSphere SPI configuration utility from the Application Bank. Verify that
you have specified the correct server name and port information for the WebSphere
servers on this managed node.

2 Verify that the property, NUM_SERVERS, in the WebSphere SPI configuration file
(/var/opt/0OV/wasspi/wbs/conf SiteConfig on Unix platforms or /usr/ov/
wasspi/wbs/confSiteConfig on NT platforms) is set to the number of WebSphere
servers on this managed node.
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WASSPI-12

Description | Command <command> returned error exit code <exit code>.
Severity Critical
Help Text Probable Cause:

A command started by the WebSphere SPI collector has returned an error (non-zero) exit
code.

Suggested Action:
1 Identify the steps to reproduce the problem.

2 Turn on tracing and reproduce the problem. Refer to the WebSphere SPI User's Guide
for instructions on how to turn on tracing.

3 Run the Gather Info application.
4 Contact HP support with the information gathered in the previous steps.

WASSPI-13

Description | Exception occurred while running an opcmon process.
Severity Critical
Help Text Probable Cause:

The WebSphereS SPI data collector attempted to run a process to execute an opcmon call.
Either the process could not be created or was interrupted.

Suggested Action:

For UNIX systems, make sure the kernel configurable parameters NPROC and MAXUPRC are
set high enough to allow process creation.

WASSPI-14

Description | Unable to find file <file_name>.
Severity Critical
Help Text Probable Cause:

A file required by the WebSphere data collector could not be found.
Suggested Action:

1 Refer to the text following the error message in the WebSphere SPI error log to help
identify the underlying cause of the problem. You can view the SPI error log for a
managed node by using the View Error File application in the Application Bank
window. The error message can be identified by the date/time stamp.

Reinstall the WebSphere SPI on the managed node.

Run the WebSphere SPI configuration utility from the Application Bank.
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WASSPI-15

Description | Error parsing XML document <file_name>.

Severity Critical

Help Text Probable Cause:
An error occurred while parsing the specified XML document.
Suggested Action:

1 Refer to the text following the error message in the WebSphere SPI error log to help
identify the underlying cause of the problem. You can view the SPI error log for a
managed node by using the View Error File application in the Application Bank
window. The error message can be identified by the date/time stamp.

2 If the XML document was provided by the user, correct the document. Refer to the
WebSphere SPI User's Guide for more information about the correct format for a
user-defined metric definition document.

3 If the XML document is a document that is shipped with the WebSphere SPI, run the

SPI configuration utility from the Application Bank to reinstall the WebSphere SPI
configuration files.

WASSPI-16

Description | A bad filter (<filter_value>) was specified for metric <metric_number>.

Severity Major

Help Text Probable Cause:

A metric filter is incorrectly specified in the metric definitions XML document.
Suggested Action:

1 Ifthe metric is specified in an XML document that was provided by the user, correct the

document. Refer to the WebSphere SPI User's Guide for more information about the
correct format for a user-defined metric definition document.

2 Ifthe metric is a pre-defined metric that is shipped with the WebSphere SPI, run the
SPI configuration utility from the Application Bank to reinstall the WebSphere SPI
configuration files.
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WASSPI-18

Description | Error logging to datasource <datasource_class_name>. Logging process returned exit code
<exit_code>.

Severity Warning

Help Text Probable Cause:

The agent on the managed node may be in an inconsistent state.
Suggested Action:

Restart the agent on the managed node.

Probable Cause:

The ddflog process started by the WebSphere SPI data collector returned a non-zero error
code.

Suggested Action:
1 Identify the steps to reproduce the problem.

2 Turn on tracing and reproduce the problem. Refer to the WebSphere SPI User's Guide
for instructions on how to turn on tracing

3 Run the Gather Info application.
4 Contact HP support with the information gathered in the previous steps.

WASSPI-19

Description | Encountered problem instantiating XSLT transformer with <file_name>.
Severity Major
Help Text Probable Cause:

The XSL document that specifies the auto action report output contains errors.
Suggested Action:

1 Reinstall the WebSphere SPI.

2 Run the WebSphere SPI configuration utility from the Application Bank.

WASSPI-20

Description | Encountered problem creating report for metric <metric_number>.
Severity Major
Help Text Probable Cause:

An error occurred while producing a text report for the specified metric.
Suggested Action:

1 Reinstall the WebSphere SPI.

2 Run the WebSphere SPI configuration utility from the Application Bank.
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WASSPI-21

Description | Encountered problem instantiating factory implementation <class name>.
Severity Critical
Help Text Probable Cause:

The java property specifying the class name is incorrect or the class does not implement
the AppServerFactory interface.

Suggested Action:

Verify that the java property appserver. implementation is set to the fully qualified
name of the class which implements the AppServerFactory interface.

For example, if set on the java command-line:

-Dappserver.implementation=com.hp.openview.wasspi.WBSAppServerFactory

WASSPI-22

Description

The PMI instrumentation level was changed from <old_level> to <new_level> for module
<module_name> in server <server_name>.

Severity

Warning

Help Text

Probable Cause:

A requested metric's impact rating exceeded the instrumentation level settings of the
application server. The instrumentation level of the appropriate PMI module was raised to
enable collection of the requested metric.

WASSPI-23

Description

Error initializing collector analyzer for server <server_name>.

Severity

Critical

Help Text

Probable Cause
An exception was encountered while preparing to monitor server <server_name>.
Suggested Action

1 Refer to the text following the error message in the WebSphere SPI error log to help
identify the underlying cause of the problem. You can view the SPI error log for a
managed node by using the View Error File application in the Application Bank window.
The error message can be identified by the date/time stamp.

Identify the steps to reproduce the problem.

3 Turn on tracing and reproduce the problem. Refer to the WebSphere SPI User's Guide
for instructions on how to turn on tracing.

Run the Gather Info application.
5 Contact HP support with the information gathered in the previous steps.
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WASSPI-24

Description | Error logging in to server <server_name> with login <login>.

Severity Critical

Help Text Probable Cause:

A security exception occurred while logging in to server <server_name>.
Suggested Action:

1 Run the WebSphere SPI configuration utility from the Application Bank.

2 Verify that you have specified the correct login and password on the managed node on
which the error occurred.

3 Verify the login has appropriate permissions.

WASSPI-25

Description | Performance monitoring service is not enabled on server <server_name>.

Severity Warning

Help Text Probable Cause:

PMI service is not enabled on server <server_name>.

Suggested Action:

1 Use the WebSphere Administrative Console to enable PMI on server <server_name>.
2 Restart server <server_name>.

WASSPI-26

Description | The data logging process for server <server_name> timed-out.

Severity Major

Help Text Probable Cause

Depending on your configuration, either OVPA or CODA failed to exit before the
time-out.

Suggested Action

1 Restart CODA using command opcagt -start.

2 Restart OVPA using command mwa restart.
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WASSPI-27

Description | RMI collector unable to process <command>.

Severity Warning

Help Text Probable Cause
An exception was encountered while performing an rmid related operation.
Suggested Action

1 Refer to the text following the error message in the WebSphere SPI error log to help
identify the underlying cause of the problem. You can view the SPI error log for a
managed node by using the View Error File application in the Application Bank window.
The error message can be identified by the date/time stamp.

Identify the steps to reproduce the problem.

3 Turn on tracing and reproduce the problem. Refer to the WebSphere SPI User's Guide
for instructions on how to turn on tracing.

4 Run the Gather Info application.

5 Contact HP support with the information gathered in the previous steps.

WASSPI-30

Description | Failed to start <rmid_path> on port <port>.

Severity Critical

Help Text Probable Cause:
The specified path is already in use.
Suggested Action:

Run the WebSphere SPI configuration utility from the Application Bank. Set the
RMID_PORT property to a port number which is not currently in use.

WASSPI-31

Description | Lost connection to RMI collector while processing <command>.

Severity Warning

WASSPI-32

Description | Unable to retrieve metadata for mbean <JMX-ObjectName>.

Severity Warning
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WASSPI-33

Description | No actions matched server <server name>, version <version>.
Severity Warning
Help Text Probable Cause: JMXAction elements define FromVersion and ToVersion tags which do

not match the server version.

Suggested Action: If the action is valid on the server, then either adjust the JMXAction
definition's FromVersion/ToVersion elements or the server's VERSION property.

WASSPI-34

Description | Metric <metric id> does not define any actions.
Severity Warning
Help Text Probable Cause: The metric ID specified with the action -m option does not define a

JMXActions element.

Suggested Action: Correct the action -m option if an incorrect metric ID was specified.
Otherwise, add a JMXActions definition to the metric definition.

WASSPI-35

Description | Error executing action <action command-line>.
Severity Major
Help Text Probable Cause:

An unexpected error occurred while executing the action.
Suggested Action:

View the managed node's errorlog to determine the root cause which is logged following
the error message.

WASSPI-36

Description

MBean <JMX objectname> on server <server name>, does not expose operation <operation
name>.

Severity

Warning

Help Text

Probable Cause:

An action's JMXCalls element defines an operation not exposed by the specified MBean.
Suggested Action:

Correct the JMXCalls element or remove the operation from the element.
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WASSPI-37

Description

MBean <JMX objectname> on server <server name>, does not expose attribute <attribute
name> for write.

Severity

Warning

Help Text

Probable Cause:

An action's JMXCalls element defines a write attribute exposed by the specified MBean as
read-only.

Suggested Action:

If it is a custom MBean, update the MBean's management interface so the attribute is
writable. Otherwise, remove the attribute definition from the JMXCalls element.

WASSPI-38

Description

MBean <JMX objectname> on server <server name>, does not expose attribute <attribute
name>.

Severity

Warning

Help Text

Probable Cause: An action's JMXCalls element defines an attribute not exposed by the
specified MBean ObjectName.

Suggested Action: Correct the JMXCalls element or remove the attribute from the
element.

WASSPI-39

Description | Error invoking operation <operation name> on MBean <JMX objectname>.

Severity Major

Help Text Probable Cause:
An unexpected error occurred while invoking an operation on the specified MBean. The
managed resource may have thrown an exception.
Suggested Action:
View the managed node's errorlog to determine the root cause which is logged following
the error message.
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WASSPI-40

Description | Error setting attribute <attribute name> on MBean <JMX objectname>.
Severity Major
Help Text Probable Cause:

An unexpected error occurred while setting an attribute on the specified MBean. The
managed resource may have thrown an exception.

Suggested Action:

View the managed node's errorlog to determine the root cause which is logged following the
error message.

WASSPI-41

Description | Error getting attribute <attribute name> from MBean <JMX objectname>.
Severity Major
Help Text Probable Cause:

An unexpected error occurred while getting an attribute from the specified MBean. The
managed resource may have thrown an exception.

Suggested Action:

View the managed node's errorlog to determine the root cause which is logged following
the error message.

WASSPI-42

Description | Error running command <command>.
Severity Critical
Help Text Probable Cause

A command started by the WebSphere SPI collector reported an error.
Suggested Action
1 Identify the steps to reproduce the problem.

2 Turn on tracing and reproduce the problem. Refer to the WebSphere SPI User's Guide
for instructions on how to turn on tracing.

3 Run the Gather Info application.
Contact HP support with the information gathered in the previous steps.
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WASSPI-43

Description | Error publishing event <event-type>.
Severity Major
Help Text Probable Cause

An unexpected error occurred while a publisher was handling a metric or collect event.
Suggested Action

View the managed node’s error log to determine the cause which is logged following the
error message.

WASSPI-201

Description | File <filename> not found.

Severity Critical

Help Text Probable Cause:
A configuration file could not be found.
Suggested Action:

Run the WebSphere SPI configuration utility from the Application Bank. Verify that the
correct information has been specified for the WebSphere servers on the managed node on
which the error occurred.

WASSPI-202

Description

Cannot read file <filename>.

Severity

Critical

Help Text

Probable Cause:

e A file could not be opened or it could not be found.

e Permissions may be incorrect or a directory may be corrupt.
Suggested Action:

1 Run the WebSphere SPI configuration utility from the Application Bank. Verify that
the correct information has been specified for the WebSphere servers on the managed
node on which the error occurred.

2 Verify that the permissions are correct for the ITO user to read this file.
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WASSPI-203

Description | Cannot write file <filename>.
Severity Critical
Help Text Probable Cause:

Permissions may be incorrect, or a file or directory may be corrupt.
Suggested Action:

1 Run the WebSphere SPI configuration utility from the Application Bank. Verify that
the correct information has been specified for the WebSphere servers on the managed
node on which the error occurred.

2 Verify that the permissions are correct for the ITO user to write this file.

WASSPI-204

Description | Error sending opcmsg <message>.
Severity Critical
Help Text Probable Cause:

There was a problem running opcmsg. opcmsg may be missing or not have permissions to
execute (ITO installation errors) or the system process table may be full.

Suggested Action:
Confirm that ITO is properly installed and deployed to the managed node.

Ensure that the process table is not full. If it is, consider having the system administrator
increase it.

WASSPI-205

Description | Error sending opcmon <command>.
Severity Critical
Help Text Probable Cause: There was a problem running opcmon. opcmon may be missing or not

have permissions to execute (ITO installation errors) or the system process table may be
full.

Suggested Action:
Confirm that ITO is properly installed and deployed to the managed node.

Ensure that the process table is not full. If it is, consider having the system administrator
increase it.
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WASSPI-206

Description | Cannot read directory <directory>.

Severity Critical

Help Text Probable Cause:
The permissions on the directory prevent the ITO user from reading it or the directory is
corrupt.
Suggested Action:

Verify that the permissions are correct for the ITO user for this directory.

WASSPI-207

Description | Cannot move <filename> to <filename>.
Severity Critical
Help Text Probable Cause:

1 Insufficient permissions.

2 Insufficient disk space.

3 File table problems.

Suggested Action:

1 Verify that the permissions are correct for the ITO user.
2 Verify that there is enough disk space to create files.

3 Run the WebSphere SPI configuration utility from the Application Bank.

WASSPI-208

Description

WBSSPI must be configured before it can be used.

Severity

Critical

Help Text

Probable Cause:
The SPI has not been configured on this node.
Suggested Action:

1 Run the WebSphere SPI configuration utility from the Application Bank. Verify that
you have specified the correct information for the WebSphere servers on the managed

node on which the error occurred.

2 Run the Verify utility from the application band to confirm that the SPI has been

successfully configured.
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WASSPI-209

Description | Cannot contact WebSphere Server.

Severity Critical

Help Text Probable Cause:

e The server could be down or not responding.

e The SPI may be configured incorrectly.
Suggested Action:

1 Verify that WebSphere is up and running properly.

2 Run the WebSphere SPI configuration utility from the Application Bank. Verify that
the correct information has been specified for the WebSphere servers on the managed
node on which the error occurred.

WASSPI-210

Description | Cannot configure SPI.

Severity Critical

Help Text Probable Cause:
The SPI configuration process failed.
Suggested Action:

1 Refer to the text following the error message in the WebSphere SPI error log to help
identify the underlying cause of the problem. The error messages previous to this one
will provide more information about the problem. You can view the SPI error log for a
managed node by using the View Error File application in the Application Bank
window. The error message can be identified by the date/time stamp.

2 Reinstall the SPI and run the WebSphere SPI configuration utility from the
Application Bank.

WASSPI-211

Description | Cannot create directory <directory>.

Severity Critical

Help Text Probable Cause: There are insufficient permissions for the ITO user to create the
directory or there is insufficient disk space.
Suggested Action:

Verify that the permissions are correct for the OVO user for this directory. Verify that
there is enough disk space.
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WASSPI-213

Description | Improper parameters to program <name>. Usage: <usage>.

Severity Critical

Help Text Probable Cause:

The parameters to the program are incorrect.
Suggested Action:

Correct the parameters.

WASSPI-214

Description | Cannot run program <program name>.

Severity Critical

Help Text Probable Cause:

The program failed to run. It may be missing, permissions may be incorrect, the process
table may be full.

Suggested Action:

1 Verify that the file exists. If it is a SPI program and the file is missing, reinstall the SPI
and run the WebSphere SPI configuration utility from the Application Bank.

2 Verify that the permissions are correct for the ITO user.

WASSPI-216

Description | Configuration variable <name> missing for server <server_name>.

Severity Critical
Help Text Probable Cause: A required SPI configuration variable was not found.
Suggested Action:

1 Run the WebSphere SPI configuration utility from the Application Bank.

2 Verify that the correct information has been specified in the configuration for the
managed node on which the error occurred.
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WASSPI-218

Description | WebSphere monitoring has been turned OFF for <server_name>.
Severity Warning
Help Text Probable Cause:
Collection has been turned off for the specified server.
Suggested Action:

If desired, collection can be turned on by setting COLLECT = ON in the SiteConfig file in
the SPI configuration directory on the managed node. The configuration directory is /var/
opt/0OV/wasspi/wbs/conf on Unix platforms or /usr/0OV/wasspi/wbs/conf on NT
platforms.

WASSPI-219

Description | WebSphere monitoring has been turned ON for <server name>.
Severity Critical
Help Text Probable Cause:

Collection has been turned on for the specified server.

Suggested Action:

If desired, collection can be turned on by setting COLLECT = OFF in the SiteConfig file in
the SPI configuration directory on the managed node. The configuration directory is /

var/opt/0OV/wasspi/wbs/conf on Unix platforms or /usr/0V/wasspi/wbs/conf on
NT platforms.

WASSPI-221

Description | <file_name> does not exist.
Severity Critical
Help Text Probable Cause:

The specified file does not exist. If it is a log file, no entries have ever been logged to it. If
it is a property file, then it has not been configured.

Suggested Action:

Log files: If there have never been any entries written to the file, no action is necessary.
Otherwise, run the WebSphere SPI configuration utility from the Application Bank.

Property files: Run the WebSphere SPI configuration utility from the application bank.
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WASSPI-222

Description | <file_name> is empty.
Severity Critical
Help Text Probable Cause:

The specified file is empty. If it is a log file, no entries have ever been logged to it, or the
entries have been cleaned out. If it is a property file, then it is not properly configured.

Suggested Action:

If the file is a configuration file, run the WebSphere SPI configuration utility from the
Application Bank.

WASSPI-223

Description | Cannot read <file_name>.
Severity Critical
Help Text Probable Cause:

1 A file could not be opened or it could not be found.
2 Permissions may be incorrect or a directory may be corrupt.
Suggested Action:

1 Run the WebSphere SPI configuration utility from the Application Bank. Verify that
you have specified the correct information for the WebSphere servers on the managed
node on which the error occurred.

2 Verify that the permissions are correct for the ITO user to read this file.

WASSPI-224

Description

ddfcomp returned an error configuring <name>.

Severity

Critical

Help Text

Probable Cause: ddfcomp returned an error. This could be because neither MeasureWare
nor CODA is installed on the system or because of an error configuring MeasureWare or

CODA.

Suggested Action:

1 If the performance agent is not installed, this error can be ignored.
2 Identify the steps to reproduce the problem.

3 Turn on tracing and reproduce the problem. Refer to the WebSphere SPI User's Guide
for instructions on how to turn on tracing.

Run the Gather Info application.
5 Contact HP support with the information gathered in the previous steps.
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WASSPI-225

Description | No logfiles were found. Did you run Config WBSSPI?
Severity Critical
Help Text Probable Cause:

The logfile list is empty.
Suggested Action:

Reinstall the SPI and run the WebSphere SPI configuration utility from the Application
Bank.

WASSPI-226

Description | Cannot read file <file_name>.
Severity Critical
Help Text Probable Cause:

e A file could not be opened or it could not be found.

e Permissions may be incorrect or a directory may be corrupt.

Suggested Action:

1 Run the WebSphere SPI configuration utility from the Application Bank.

2 Verify that you have specified the correct information for the WebSphere servers on the
managed node on which the error occurred.

3 Verify that the permissions are correct for the ITO user to read this file.

WASSPI-227

Description | No OpenView performance agent is installed. Data source will not be configured.
Severity Warning
Help Text Probable Cause:

If a performance tool is available, the SPI integrates with it. This warning indicates that
none is available.

Suggested Action:

If you should have a performance agent installed, verify that it is installed correctly and is
running; reinstall it if necessary. Otherwise, this message can be ignored.
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WASSPI-228

Description | ddflog returned an error logging <logfile-name>: <system-error-msg>
Severity Critical
Help Text Probable Cause:
The agent on the managed node may be in an inconsistent state.
Suggested Action:

Restart the agent on the managed node.
Probable Cause:

ddflog returned an error. This could be because the SPI was not properly configured to
support logging performance data.

Suggested Action:
1 Try reconfiguring the WASSPI on the node having the problem.
2 Otherwise, examine the system error message, if any, for clues to the problem.

3 Turn on tracing and reproduce the problem. Refer to the WebSphere SPI User's Guide
for instructions on how to turn on tracing.

Run the Gather Info application.
5 Contact HP support with the information gathered in the previous steps.

WASSPI-229

Description | Cannot connect to directory <directory-name>

Severity Critical

Help Text Probable Cause:
The directory does not exist, or the user the agent is running under does not have
appropriate permissions to the directory.
Suggested Action:
1 Run the WebSphere SPI configuration utility from the Application Bank
2 Reinstall the SPI and run the WebSphere SPI configuration.
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WASSPI-230

Description | Cannot get lock <file> after <time>
Severity Critical
Help Text Probable Cause:

The lock file <file> was not cleared in the <time> indicated. This could be due to a very
slow running or hung SPI process. Also could be a SPI process that had a lock was killed
before the lock it had open had been cleared.

Suggested Action:
Make sure no SPI processes are running. Manually remove the lock file.

WASSPI-23]

Description | Error starting JRE <JVM_file>: <message>
Severity Critical
Help Text Probable Cause: Some error occurred starting Java. This could be that the specified JVM

does not exist, has bad permissions, or that there are system resource limitations such as
process table entries or memory, or that the JAVA_HOME variable in the SPI SiteConfig
file is not set correctly.

Suggested Action:

Check your JAVA_HOME or HOME variables in the SPI configuration file. Check for other
errors generated at the same time, they may indicate the real cause.

WASSPI-232

Description | Server <name> specified on command line, but not in configuration
Severity Critical
Help Text Probable Cause: There was a -i or -e specified on the collector command line which

specified a server name that was not listed in the SPI configuration. The collector only
knows about servers listed in the configuration.

Suggested Action:
1 Specify a correct server name on the command line.

2 Run the WebSphere SPI configuration utility from the Application Bank. Verify the
WebSphere server names are correctly listed and spelled in the SPI configuration file.
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WASSPI-234

Description | Error running program <file>, return value: <n>
Severity Critical
Help Text Probable Cause:

The SPI attempted to run some tool or auxiliary program and encountered an error doing
so. The tool or program is shown in the message as <file> and the return code from
attempting to run it is shown as <n>.

Suggested Action:

If the tool is a SPI tool, make sure the SPI has been installed and configured correctly. If
not, reinstall or reconfigure. If it is a system tool, make sure there are no system problems
that prevent the tool from running.

WASSPI-235

Description | Restart of MeasureWare agents failed
Severity Warning
Help Text Probable Cause:

The SPI attempted to automatically restart the MeasureWare agents and the automatic
attempt failed.

Suggested Action:

Restart the MeasureWare agents manually using the mwa restart server command.

WASSPI-236

Description | Failure when running XSLT on <xml> with stylesheet <xsl/>: <message>
Severity Critical
Help Text Probable Cause:

As part of setting up graphing for user defined metrics, a translation of the UDM XML is
done. This message indicated that the translation failed for some reason.

Suggested Action:
Review the message shown. It is most likely that there is an error in the XML.

WASSPI-237

Description | Setting up Data Source <datasource>
Severity Normal
Help Text This is an informational message that a OVPM or MeasureWare datasource was setup.
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WASSPI-238

Description | No User Defined Metrics found
Severity Warning
Help Text Probable Cause:

The UDM Graph Enable application was run, but no UDM metrics had been defined.
Suggested Action:
Check that the UDM XML file has been named correctly.

WASSPI-240

Description | UDM Data Logging integration Complete
Severity Information
Help Text The UDM Graph Enable application successfully executed and UDM graph metrics will be

available for graphing.

WASSPI-241

Description | Cannot delete file <file>
Severity Critical
Help Text Probable Cause:

The SPI attempted to delete a file, but was unable to do so. It may be that the protection of
the file is set so that the ITO user cannot delete it, or that there is some system problem
preventing the file from being deleted.

Suggested Action:

Make sure the protection of the file is correct.

WASSPI-242

Description | UDM graphing successfully disabled.
Severity Information
Help Text The UDM Graph Disable application successfully executed.
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WASSPI-254

Description | Java exited with an error
Severity Critical
Help Text Probable Cause:

While running the collector or other java application, either Java encountered an error of
some kind, or the Java application exited with an error exit.

Suggested Action:
Check for other errors generated at the same time, they may indicate the real cause.
Review the SPI's error log, it may give some other clues.

WASSPI-303

Description

The SPI configuration for <node_name> was updated by discovery in the OVO server.

Help Text

This is a normal operation performed by the Discovery application or the
WBSSPI-Discovery scheduled template action. This message is sent to inform an operator
that the WBSSPI Discovery has:

e found WebSphere application servers on a managed node that have not been
configured,

¢ found new WebSphere application servers on a configured node, or
e detected changes in the application servers configuration.

The WBSSPI-Discovery components automatically update these changes in the SPI
configuration.

Please review the new configuration details that are included as part of the message text
and verify the information for correctness.

WASSPI-501

Description

Retrieving configuration data from the OVO server

Help Text

This is a normal operation performed by the Discovery application or the
WBSSPI-Discovery scheduled template action. Upon successful operation, the entry in the
‘A’ (Action) column for this message should change from R (running) to S (success).
However, if the entry in this column changes to F (fail), the operation was not completed
successfully. Please select this node and run the Discovery application again.

If the problem persists, please refer to the document HP OpenView Smart Plug-in for
WebSphere Application Server Configuration Guide. The chapter called Configuring the
WBS SPI provides instructions on how to manually configure the WBS SPI.
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WASSPI-502

Description

Updating the WBSSPI configuration data with discovered information

Help Text

This is a normal operation performed by the Discovery application or the
WBSSPI-Discovery scheduled template action. Upon successful operation, the entry in the
‘A’ (Action) column for this message should change from R (running) to S (success).

However, if the entry in this column changes to F (fail), the operation was not completed
successfully. Please select this node and run the Discovery application again.
If the problem persists, please refer to the document HP OpenView Smart Plug-in for

WebSphere Application Server Configuration Guide. The chapter called Configuring the
WBS SPI provides instructions on how to manually configure the WBS SPI.

WASSPI-503

Description

The configuration for <node_name> node has been automatically updated by the WBSSPI
Discovery ...

Help Text

This is a normal operation performed by the WBSSPI Discovery policy action. It sends this
message to inform an operator that the WBSSPI Discovery either discovered WebSphere
application servers on a managed node that has not been configured or detected changes in
the application servers configuration. The Discovery components automatically update
these changes in the SPI configuration.

Please review the new configuration details that are included as part of the message text
and verify the information for correctness. The new configuration can also be viewed by
launching the WBSSPI Configure tool.

WASSPI-541

Description

No running WebSphere application servers found
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Help Text Probable Cause: A WebSphere application server is not present (or not running) on the
node.

Verification: Verify the presence of an application server on the node, and check that the
application server is running.

Suggested Action: Create or start one or more application servers on the node. Select the
node and run the Discovery application again.

Please make sure that all of the application servers you wish to monitor are running, before
the WBSSPI-Discovery template is deployed or the Discovery application is launched. Only
the servers that are running will be automatically configured.

NOTE: If it has been confirmed that WebSphere application servers exist on the system and
are in the running state, then this message indicates that the WBSSPI Discovery is unable
to discover the application servers. Please try the followings:

1 Launch the Discovery application.

2 Select the Default Properties item corresponding to this managed node. Select the
HOME_LIST property from the Select a Property to Set... menu and click Set Property.

3 Enter the HOME directory where WebSphere application server programs are installed
on this node. If there are more than one installation instance of WebSphere, enter the
HOME directories, separated by a semicolon. (For example, /opt/WebSphere/AppServer;/
opt/ibm/ WebSphere5/AppServer).

Click Next and complete the operation.

5 Allow the WBSSPI Discovery application to complete. (A message starting with
WASSPI-303 appears in the Message Browser with the node name embedded in the
message text).

If the WBSSPI configurations are not properly updated and the application servers are not
displayed on the Service Navigator's Services tree, check the WBSSPI Discovery log file
called <OvAgentDir>/wasspi/wbs/log discovery.log on the managed node for any
ERROR log entries.

Probable Cause: Unsuccessful login to the secured WebSphere application server
environment.

Verification: Launch the WebSphere administrative console on the node and check if
security is enabled. Please also make sure that the LOGIN and PASSWORD properties for
this node are present and valid in the WBSSPI configuration. Launch the Config WBSSPI
application and verify the accuracy of the information. The PASSWORD information is
encrypted for security purposes.

Suggested Action: Select the node and run the Discovery application. Set the correct
LOGIN/PASSWORD properties for the node (overwrite the existing encrypted data). Allow
the WBSSPI-Discovery process to run again on the selected node.
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Help Text
Contd.

WebSphere Application Server Version 4
Probable Cause: WebSphere 4.0 AdminServer is not running on the node.

Verification: Verify that the WebSphere 4.0 AdminServer is running by launching the
administrative console on the node.

Suggested Action: If the administrative console fails to launch on the node, please start
the WebSphere 4.0 AdminServer. Select the node and run the Discovery application again.

Note: If problem persists, please refer to the HP OpenView Smart Plug-in for WebSphere
Application Server Configuration Guide. The chapter called Configuring the WBS SPI
provides instructions on how to manually configure the WBS SPI.

Note: A WebSphere 4.0 AdminServer is identified by the port number it uses. Therefore,
precautions should be taken when adding or modifying configuration information. If the
port number is not the default value (port 900) or if multiple instances of the AdminServer
are present, make sure that correct information is entered for the specific instance of the
AdminServer.

WASSPI-561

Description

Failed to communicate with the WebSphere 4 AdminServer on port: <port number>

Help Text

Probable Cause: WebSphere 4.0 AdminServer is not running on the node.

Verification: Verify that the WebSphere 4.0 AdminServer is running by launching the
administrative console on the node.

Suggested Action: If the administrative console fails to launch on the node, please start
the WebSphere 4.0 AdminServer. Select the node and run the Discovery application again.

Probable Cause: Unsuccessful login to the secured WebSphere application server
environment.

Verification: Launch the WebSphere administrative console on the node and check if
security is enabled. Please also make sure that the LOGIN and PASSWORD properties for
this node are present and valid in the WBSSPI configurations. Launch the Config WBSSPI
application and verify the accuracy of the information. The PASSWORD information is
encrypted for security purposes.

Suggested Action: Select the node and run the Discovery application. Set the correct
LOGIN/PASSWORD properties for the node (overwrite the existing encrypted data). Allow
the WBSSPI-Discovery process to run again on the selected node.

Note: If problem persists, please refer to the HP OpenView Smart Plug-in for WebSphere
Application Server Configuration Guide. The chapter called Configuring the WBS SPI
provides instructions on how to manually configure the WBS SPI.

Note: A WebSphere 4.0 AdminServer is identified by the port number it uses. Therefore,
precautions should be taken when adding or modifying configuration information. If the
port number is not the default value (port 900) or if multiple instances of the AdminServer
are present, make sure that correct information is entered for the specific instance of the
AdminServer.

Basic Troubleshooting and Error Messages 131



WASSPI-562

Description | Security access failure. Missing or invalid LOGIN/PASSWORD parameter for WebSphere
4 AdminServer on port: <port number>
Help Text Probable Cause: The values for the LOGIN and PASSWORD properties for this node are

missing from the WBSSPI configuration or incorrect information was entered.

Verification: Launch the WebSphere administrative console on the node and check if
security is enabled. Please also make sure that the LOGIN and PASSWORD properties for
this node are present and valid in the WBSSPI configurations. Launch the Config WBSSPI
application and verify the accuracy of the information. The PASSWORD information is
encrypted for security purposes.

Suggested Action: Select the node and run the Discovery application. Set the correct
LOGIN/PASSWORD properties for the node (overwrite the existing encrypted data). Allow
the WBSSPI-Discovery process to run again on the selected node.

Note: If problem persists, please refer to the HP OpenView Smart Plug-in for WebSphere
Application Server Configuration Guide. The chapter called Configuring the WBS SPI
provides instructions on how to manually configure the WBS SPI.

Note: A WebSphere 4.0 AdminServer is identified by the port number it uses. Therefore,
precautions should be taken when adding or modifying configuration information. If the
port number is not the default value (port 900) or if multiple instances of the AdminServer
are present, make sure that correct information is entered for the specific instance of the
AdminServer.

WASSPI-563

Description

Security access failure. Invalid LOGIN/PASSWORD parameter for WebSphere 4
AdminServer on port: <port number>

Help Text

Probable Cause: The values for the LOGIN and PASSWORD properties for this node are
missing from the WBSSPI configurations, or incorrect information was entered.

Verification: Launch the WebSphere administrative console on the node and check if
security is enabled. Please also make sure that the LOGIN and PASSWORD properties)
for this node are present and valid in the WBSSPI configurations. Launch the Config
WBSSPI application and verify the accuracy of the information. The PASSWORD
information is encrypted for security purposes.

Suggested Action: Select the node and run the Discovery application. Set the correct
LOGIN/PASSWORD properties for the node (overwrite the existing encrypted data). Allow
the WBSSPI-Discovery process to run again on the selected node.

Note: If problem persists, please refer to the HP OpenView Smart Plug-in for WebSphere
Application Server Configuration Guide. The chapter called Configuring the WBS SPI
provides instructions on how to manually configure the WBS SPI.

Note: A WebSphere 4.0 AdminServer is identified by the port number it uses. Therefore,
precautions should be taken when adding or modifying configuration information. If the
port number is not the default value (port 900) or if multiple instances of the AdminServer
are present, make sure that correct information is entered for the specific instance of the
AdminServer.
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WASSPI-564

Description | Security access failure. Unable to communicate with the WebSphere 4 AdminServer on
port: <port number>

Help Text Probable Cause: WebSphere 4.0 AdminServer is not running on the node.

Verification: Verify that the WebSphere 4.0 AdminServer is running by launching the
administrative console on the node.

Suggested Action: If the administrative console fails to launch on the node, please start
the WebSphere 4.0 AdminServer. Select the node and run the Discovery application again.

Probable Cause: The values for the LOGIN and PASSWORD properties for this node are
missing from the WBSSPI configurations, or incorrect information was entered.

Verification: Launch the WebSphere administrative console on the node and check if
security is enabled. Please also make sure that the LOGIN and PASSWORD properties for
this node are present and valid in the WBSSPI configurations. Launch the Config WBSSPI
application and verify the accuracy of the information. The PASSWORD information is
encrypted for security purposes.

Suggested Action: Select the node and run the Discovery application. Set the correct
LOGIN/PASSWORD properties for the node (overwrite the existing encrypted data). Allow
the WBSSPI-Discovery process to run again on the selected node.

Note: If problem persists, please refer to the HP OpenView Smart Plug-in for WebSphere
Application Server Configuration Guide. The chapter called Configuring the WBS SPI
provides instructions on how to manually configure the WBS SPI.

Note: A WebSphere 4.0 AdminServer is identified by the port number it uses. Therefore,
precautions should be taken when adding or modifying configuration information. If the
port number is not the default value (port 900) or if multiple instances of the AdminServer
are present, make sure that correct information is entered for the specific instance of the
AdminServer.

Basic Troubleshooting and Error Messages 133



WASSPI-565

Description

Security access failure. Unable to log in to the WebSphere 4 AdminServer on port:
<port number>

Help Text

Probable Cause: The values for the LOGIN and PASSWORD properties for this node are
missing from the WBSSPI configurations, or incorrect information was entered.

Verification: Launch the WebSphere administrative console on the node and check if
security is enabled. Please also make sure that the LOGIN and PASSWORD properties for
this node are present and valid in the WBSSPI configurations. Launch the Config WBSSPI
application and verify the accuracy of the information. The PASSWORD information is
encrypted for security purposes.

Suggested Action: Select the node and run the Discovery application. Set the correct
LOGIN/PASSWORD properties for the node (overwrite the existing encrypted data). Allow
the WBSSPI-Discovery process to run again on the selected node.

Note: If problem persists, please refer to the HP OpenView Smart Plug-in for WebSphere
Application Server Configuration Guide. The chapter called Configuring the WBS SPI
provides instructions on how to manually configure the WBS SPI.

Note: A WebSphere 4.0 AdminServer is identified by the port number it uses. Therefore,
precautions should be taken when adding or modifying configuration information. If the
port number is not the default value (port 900) or if multiple instances of the AdminServer
are present, make sure that correct information is entered for the specific instance of the
AdminServer.
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WASSPI-571

Description | Failed to communicate with WebSphere Application Server

Help Text WebSphere Application Server versions 5

Probable Cause: A WebSphere application server is not present (or not running) on the
node.

Verification: Verify the presence of an application server on the node, and check that the
application server is running.

Suggested Action: Create or start one or more application servers on the node. Select the
node and run the Discovery application again.

Please make sure that all of the application servers you wish to monitor are running,
before the WBSSPI-Discovery template is deployed or the Discovery application is
launched. Only the servers that are running will be automatically configured.

WebSphere Application Server versions 5

Probable Cause: Unsuccessful login to the secured WebSphere application server
environment.

Verification: Launch the WebSphere administrative console on the node and check if
security is enabled. Please also make sure that the LOGIN and PASSWORD properties for
this node are present and valid in the WBSSPI configurations. Launch the Config WBSSPI
application and verify the accuracy of the information. The PASSWORD information is
encrypted for security purposes.

Suggested Action: Select the node and run the Discovery application. Set the correct
LOGIN/PASSWORD properties for the node (overwrite the existing encrypted data). Allow
the WBSSPI-Discovery process to run again on the selected node.

Note: If problem persists, please refer to the HP OpenView Smart Plug-in for WebSphere

Application Server Configuration Guide. The chapter called Configuring the WBS SPI
provides instructions on how to manually configure the WBS SPI.

WASSPI-572

Description | WebSphere Login Error - Missing Login Data

Help Text WebSphere Application Server versions 5

Probable Cause: The values for the LOGIN and PASSWORD properties for this node are
missing from the WBSSPI configurations.

Verification: Launch the WebSphere administrative console on the node and check if
security is enabled. Please make sure that the LOGIN and PASSWORD properties for this
node are present and valid in the WBSSPI configurations. Launch the Config WBSSPI
application and verify the accuracy of the information. The PASSWORD information is
encrypted for security purposes.

Suggested Action: Select the node and run the Discovery application. Set the correct
LOGIN/PASSWORD properties for the node (overwrite the existing encrypted data). Allow
the WBSSPI-Discovery process to run again on the selected node.

Note: If problem persists, please refer to the HP OpenView Smart Plug-in for WebSphere
Application Server Configuration Guide. The chapter called Configuring the WBS SPI
provides instructions on how to manually configure the WBS SPI.
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WASSPI-573

Description

WebSphere Login Error - Invalid Login Data

Help Text

WebSphere Application Server versions 5

Probable Cause: The discovery application was unable to authenticate itselfin a secured
WebSphere server environment. This is likely due to incorrect values for the LOGIN and
PASSWORD properties being provided in the WBSSPI configurations for this node.

Verification: Launch the WebSphere administrative console on the node and check if
security is enabled. Please make sure that the LOGIN and PASSWORD properties for this
node are present and valid in the WBSSPI configurations. Launch the Config WBSSPI
application and verify the accuracy of the information. The PASSWORD information is
encrypted for security purposes.

Suggested Action: Select the node and run the Discovery application. Set the correct
LOGIN/PASSWORD properties for the node (overwrite the existing encrypted data). Allow
the WBSSPI-Discovery process to run again on the selected node.

Note: If problem persists, please refer to the HP OpenView Smart Plug-in for WebSphere

Application Server Configuration Guide. The chapter called Configuring the WBS SPI
provides instructions on how to manually configure the WBS SPI.

WASSPI-58]

Description

INTERNAL ERROR - <error message>

Help Text

Probable Cause: Read the error message that accompanies the message text to
determine the cause of the problem. The WBSSPI Discovery application may not function
properly due to one (or more) of the following conditions on the managed node:

e A WBSSPI Discovery application, script, or data file is missing, has been removed, or is
placed in non-standard directory paths.

e There were problems with the OpenView agent installation.
e The OpenView agents installation directory cannot be determined.

e OpenView operator account that runs the WBSSPI Discovery does not have the
permission to open/read the specified file or execute the required script/command.

¢ General network errors.
Suggested Action: Check with the OpenView or the IT specialist in the organization on

matters related to these issues. Once the problems have been resolved, select the node and
run the Discovery application again.

Note: If problem persists, please refer to the HP OpenView Smart Plug-in for WebSphere
Application Server Configuration Guide. The chapter called Configuring the WBS SPI
provides instructions on how to manually configure the WBS SPI.

Contact your HP support representative if the problem cannot be resolved or if further
assistance is needed.
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WASSPI-585

Description | SYSTEM ERROR - <error message>

Help Text Probable Cause: Read the error message that accompanies the message text to
determine the cause of the problem. The WBSSPI Discovery application may not function
properly due to one (or more) of the following conditions on the managed node:

e Operating system commands used by WBSSPI Discovery are missing, have been
removed, or are placed in non-standard directory paths.

¢ The system's PATH variable has not been set for certain system commands.

e Required operating system files or software installation registry cannot be found or is
in a non-standard directory path.

¢ OpenView operator account that runs the WBSSPI Discovery does not have the
permission to open/read system files or execute the necessary system commands.

e General network errors.

Suggested Action: Check with the OpenView or the IT specialist in the organization on
matters related to these issues. Once the problems have been resolved, select the node and
run the Discovery application again.

Note: If problem persists, please refer to the HP OpenView Smart Plug-in for WebSphere
Application Server Configuration Guide. The chapter called Configuring the WBS SPI
provides instructions on how to manually configure the WBS SPI.

WASSPI-591

Description | WEBSPHERE ERROR - <error message>

Help Text Probable Cause: Read the error message that accompanies the message text to
determine the cause of the problem. The WBSSPI Discovery application may not function
properly due to one (or more) of the following conditions on the managed node:

e WebSphere commands used by WBSSPI Discovery are missing, have been removed, or
are placed in non-standard directory paths.

¢ OpenView operator account that runs the WBSSPI Discovery does not have the
permission to open/read files or execute commands in the WebSphere installation
directories.

Suggested Action: Check with the OpenView or the WebSphere application server
specialist in the organization on matters related to these issues. Once the problems have
been resolved, select the node and run the Discovery application again.

Note: If problem persists, please refer to the HP OpenView Smart Plug-in for WebSphere
Application Server Configuration Guide. The chapter called Configuring the WBS SPI
provides instructions on how to manually configure the WBS SPI.
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Description | An unknown error appears in the WebSphere SPI error log.

Severity Warning

Help Text Suggested Action:

1 Refer to the text following the error message in the WebSphere SPI error log to help
identify the problem. You can view the SPI error log for a managed node by using the
'View Error File' application in the Application Bank window. The error message can be
identified by the date/time stamp.

Identify the steps to reproduce the problem.

3 Turn on tracing and reproduce the problem. Refer to the WebSphere SPI User's Guide

for instructions on how to turn on tracing.

Run the 'Gather Info' application.

5 Contact HP support with the information gathered in the previous steps.
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A File Locations

You can find the Smart Plug-in for WebSphere Application Server (WBS SPI) configuration
files and error logs in specific directories.

OVO Management Server File Locations

Operating

System File File Location

HP-UX Configuration | /opt/OV/wasspi/wbs/conf
Solaris Configuration | /opt/OV/wasspi/wbs/conf

Managed Node File Locations

On DCE-based managed nodes or UNIX managed nodes that were already running the WBS
SPI and are being switched to a non-root HTTPS agent environment (UNIX only: if these
directories do not exist, refer to the next table for file locations):

Operating System File File Location

HP-UX, Solaris, Linux | Configuration | /var/opt/OV/wasspi/wbs/conf

HP-UX, Solaris, Linux | Error Logs /var/opt/OV/wasspi/wbs/log

AIX Configuration | /var/lpp/0V/wasspi/wbs/conf

AIX Error Logs /var/lpp/0OV/wasspi/wbs/log

Windows (DCE) Configuration | \usr\ov\wasspi\wbs\conf

Windows (DCE) Error Logs \usr\ov\wasspi\wbs\log

Windows (HTTPS) Configuration | \Program Files\HP OpenView\data\
wasspi\wbs\conf

Windows (HTTPS) Error Logs \Program Files\HP OpenView\data\
wasspi\wbs\log
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On newly configured WBS SPI managed nodes in the non-root HTTPS agent environment

(UNIX only):

Operating System File File Location

HP-UX, Solaris, Linux | Configuration |/var/opt/0OV/conf/wbsspi
HP-UX, Solaris, Linux | Error Logs /var/opt/0OV/log/wbsspi
AIX Configuration | /var/lpp/OV/conf/wbsspi
AIX Error Logs /var/lpp/OV/log/wbsspi
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B The Configuration

This appendix contains information about the configuration structure, how to use the

configuration editor, descriptions of the configuration properties, and samples of the
configuration.

Structure

See Sample Configurations on page 161 for examples of the configuration. The basic structure
of the configuration is (lines preceded by # are treated as comments and are ignored):

# Global Properties
<property>=<value> ...

# GROUP Block
GROUP <group name>
{

<node name> ...

}

# NODE Block

NODE <node name | group name>
{

<property>=<value> ...

}

Global Properties

# Global Properties
<property>=<value> ...

Properties defined at the global level apply to all nodes. However, these global properties can

be overridden by properties set within a GROUP or NODE block or by server-specific
properties.

GROUP Block

# GROUP Block
GROUP <group name>
{

<node name> ...

}
GROUP blocks are used to group nodes together that have common properties.
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<group_name> identifies the group of nodes with common properties. If a GROUP block
<group_name> is repeated within the configuration, the last definition takes precedence.

<node name> lists the nodes in the group and is the primary node name configured in OVO.
) The node name specified in a GROUP block matches the value returned by the OVO variable

$OPC_NODES, which is the primary node name configured in OVO.

Set the common properties of the group using the NODE block.

Using the configuration editor, view, set, or edit GROUP block properties by selecting the
Default Properties item in the <Group Name> folder.

NODE Block

# NODE Block
NODE <node name | group name>

{

<property>=<value> ...

}

Properties set in a NODE block apply to nodes belonging to the group defined by
<group_name> (to set common properties for a group) or to the specified <node_name> (to set
properties for a single node).

For a group, enter the <group name> defined by the GROUP block and define the group’s
common properties.

For a single node, enter the <node name> and define the properties.

If a property definition is repeated within the NODE block, the last definition takes
precedence.

Using the configuration editor, view, set, or edit NODE block properties by selecting the
Default Properties item in the <Node Name> folder.

Server-Specific Properties

Each property specified as SERVER<n>_property refers to a specific WebSphere server
instance. When more than one WebSphere server instance is running on a given managed
node, the number <n> differentiates the servers. Numbering begins at “1” and each
WebSphere server instance is assigned a unique number.

Property Precedence

The order of precedence (highest to lowest) of properties defined in the configuration are:
1 SERVER<n>_property (server-specific)

2 NODE <node_name> {<property>} (property defined for a node)

3 NODE <group_name> {<property>} (property defined for a group)

4 <property> (global property)
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The Configuration Editor

Use the configuration editor to view and edit the configuration. You must update the
configuration using this editor only.

The main features of the configuration editor are:
e Tree
e Buttons

e Actions

Configure WBSSPI - Tree

The Config WBSSPI tree that appears in the left pane of the Config WBSSPI application’s
main window shows the WBS SPI configuration in a tree structure.

The following is an example of the tree.

’ If no application servers or groups are configured, the “Application Servers” and “Groups”
folders are not displayed. If you are running Config WBSSPI for the first time and you did not
select any nodes before you launched the application, the “Nodes” folder is not displayed.

=F ] Configuration
=k 7 Defaults
I— Default Properties
=k T fpplication Servers
|— <App_Serverl_Name:
=F 7 Groups
.:l- 7 <Group_Mame:
I— Default Properties
=k T fpplication Servers
|— <App_Server?_Name:
=F ] Nodes
=k 7 <Mode_Name>
I— Default Properties
=k T fpplication Servers
|— <App_Server3_Name:

where the icons are defined as follows:

o | The configuration properties can be viewed.
The configuration properties can be viewed and set.
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The following table lists each item in the tree and a brief description of the item.

Item Name

Description

Application Servers

A folder that contains a list of all the application servers.
This folder can appear under Defaults (global properties),
Group_Names (GROUP block), or Node_Names (NODE
block).

<Application_Server_Name>

The server name as defined in WebSphere.

Configuration

A folder that contains all WBS SPI configuration
information for the WebSphere environment.

Default Properties

Lists the configuration properties that have been set. This
item appears under Defaults (global properties),
Group_Names (GROUP block), or Node_Names (NODE
block).

Defaults

A folder that represents the global properties. Default
properties set at this level apply to all nodes. However,
these properties can be overridden by properties set under
the GroupName and Node_Name folders (refer to Property
Precedence on page 142 for more information).

Groups

A folder that represents the GROUP block.

<Group_Name>

A folder that identifies the name of a group of nodes with
common properties. Default properties set at this level
apply to all nodes that belong to the specified group. These
properties can be overridden by properties set under the
Node_Name folders (refer to Property Precedence on

page 142 for more information).

Nodes

A folder that represents the NODE block.

<Node_Name>

A folder that represents a single node whose name matches
the value returned by the OVO variable $OPC_NODES, which
is the primary node name configured in OVO. Default
properties set at this level apply to the specified node only
(refer to Property Precedence on page 142 for more
information).
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Configure WBSSPI - Buttons

The following buttons are available in Config WBSSPI:

Button

Description

Cancel

Exit Config WBSSPI.

If you set configuration properties without saving them, these changes are not
saved.

If you added or removed an application server, node, or group without saving the
change or if you modified a configuration property, a Confirm Cancel window
appears. Click Save and Exit to save the changes before exiting, Exit without Save to
exit without saving the changes, or Return to Editing to continue editing the
configuration (changes are not saved).

Finish

Exit Config WBSSPI. Appears instead of the Next button if you launched Config
WBSSPI without selecting any nodes.

Next

Exit Config WBSSPI. Takes you to the “Confirm Operation” window that lists the
nodes you selected before you started Config WBSSPI. The selected managed
nodes’ configurations are updated with your changes. If you made changes to
nodes that were not selected (are not displayed in the “Confirm Operation”
window), the changes are saved to the OVO management server’s configuration,
but to make the changes to those managed node’s configuration, you must select
those managed nodes from the node bank, restart Config WBSSPI, and then exit.

Save

Save changes to the OVO management server’s configuration and continue
editing the configuration. You may also select File > Save to save your changes.

Configure WBSSPI - Actions

Actions that you can perform depend upon the item that is selected in the tree and from where
you access the action. The following actions can be accessed from the Actions menu, File
menu, or by right-clicking on an item in the tree.

Action Description Selected Tree Item
Add Application Add an application server. See Add | 3 Application Servers
Server Application Server on page 146 for | @3 Defaults
more information. 9 <Group Name>
3 <Node_Name>
Add Group Create a group to which you can 3 Any item in the tree
assign nodes that have common e Any item in the tree
properties. See Add Group on
page 148 for more information.
Add Node Add a managed node to the Nodes 23 Any item in the tree
folder. Add Node on page 149 for Any item in the tree
more information.

The Configuration
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Action Description Selected Tree Item
Exit Exit the Config WBSSPI application.| 3 Any item in the tree

This action is available from the File | & Any item in the tree

menu. If any changes were made that

have not been saved, the Confirm

Cancel window appears.
Remove Application| Remove an application server or all | :3 Application Servers
Server/Remove ALL| listed application servers. See <Application Server Name>
App Servers Remove Application Server/Remove

ALL App Servers on page 149 for
more information.

Remove Group/

Remove a WBS SPI group or all

23 Groups

Remove ALL listed WBS SPI groups. See Remove | @3 c.group name>
Groups Group/Remove ALL Groups on B
page 149 for more information.
Remove Node/ Remove a managed node or remove | :3Nodes
Remove ALL Nodes | all managed nodes. See Remove A <Node Name>
Node/Remove ALL Nodes on
page 150 for more information.
Save Save changes to the configuration. 23 Any item in the tree
This action is available from the File | & Any item in the tree

menu only if changes were made to
the configuration.

Set Configuration

Set WBS SPI configuration

B <Application_Server. Name>

Properties tab properties. See Set Configuration e Default Properties
Settings Tab on page 150 for more
information.
View Configuration | View WBS SPI configuration 23 Any item in the tree
Settings tab properties. See View Configuration | ef Any item in the tree

Settings Tab on page 152 for more
information.

Add Application Server

Add an application server at the global properties, GROUP, or NODE level in the WBS SPI

configuration.

If a node contains duplicate server names (the NAME property is set to the same value), you
are prompted to set the ALIAS property (to uniquely identify each server). Refer to Property
Definitions on page 155 for more information about the ALIAS property.
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The Configuration

Before adding an application server,

for WebSphere
server version 4:

If the WebSphere administrative server port number is the same for all
managed nodes, set the PORT property at the global properties level.

If the WebSphere administrative server port number is the same for a
group, set the PORT property at the GROUP level.

If the WebSphere administrative server port number is the same for a
node, set the PORT property at the NODE level

Setting the PORT property at those levels allows you to use the “Use
inherited Server Port” check box. See step 4 for more information about
this check box. Set Configuration Settings Tab on page 150 for more
information about setting the PORT property. See Configuration
Properties on page 153 for more information about the PORT property.

for WebSphere
server version 5,
6.0, and 6.1:

Set the PORT property to the application server’s
BOOTSTRAP_ADDRESS port number at the application server level of
configuration (the BOOTSTRAP_ADDRESS is unique for each server on
a managed node). See Set Configuration Settings Tab on page 150 for
more information about setting the PORT property. See Configuration
Properties on page 153 for more information about the PORT property.

To add an application server, do the following:

1 Right-click one of the following items in the tree: Defaults (global properties level),
Application Servers (global properties level), <Group_Name> (GROUP level), or
<Node_Name> (NODE level) and select Add Application Server.

The Config WBSSPI Application: Add App Server window appears.

2 Enter the “Application Server Name.” This is the name of the application server as
defined in WebSphere and is case-sensitive.

3 Enter the “Server Port.”

For WebSphere server version 4, this is the bootstrap port number for the WebSphere
administrative server.

For WebSphere server version 5 and above, this is the BOOTSTRAP_ADDRESS port
number for the application server.

If the “Use inherited Server Port” check box is selected, you may not enter a port number
in the “Server Port” field.

4 If available, select the “Use inherited Server Port: xxX” check box if you want to use the
specified port number (“xxx”).

If the PORT property is not set, the check box is not available.

If you do NOT want to use the specified port number, unselect the check box and enter a
port number in the “Server Port” field.

If you select the check box, you may not enter a port number in the “Server Port” field.

The specified port number is determined by the value set for the PORT property at the
global properties, GROUP, and/or NODE level:

e Ifthe PORT property is set at the global properties level, WBS SPI is configured to
use this same port number on all nodes and groups for all WebSphere version 4
administrative servers or for all WebSphere version 5 and above application servers.
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For WebSphere version 5 and above, if there is more than one application server per
node, only one server can use the inherited server port. The PORT property must be
edited for the other application servers.

e Ifthe PORT property is set at the GROUP level, WBS SPI is configured to use this
same port number for the group for all WebSphere version 4 administrative servers or
for all WebSphere version 5 application servers. For WebSphere version 5, if there is
more than one application server per node in the group, only one server can use the
inherited server port. The PORT property must be edited for the other application
servers.

The port number set at the GROUP level takes precedence over the port number set
at the global properties level.

e Ifthe PORT property is set at the NODE level, WBS SPI is configured to use this
same port number for that node for all WebSphere version 4 administrative servers or
for all WebSphere version 5, 6.0, and 6.1 application servers. For WebSphere version
5, 6.0, and 6.1 if there is more than one application server per node, only one server
can use the inherited server port. The PORT property must be edited for the other
application servers.

The port number set at the NODE level takes precedence over the port number set at
the global properties level.

5 Click OK.
The NAME and PORT properties are set.

The application server is added and its properties are displayed. You may also set
additional configuration properties for this server. Set Configuration Settings Tab on
page 150 for more information.

6 Click Save to save your changes.

If you do not want to add this application server, right-click the application server name,
select Remove Application Server, and click Save.

Add Group

Assign nodes to a group that have common properties in the WBS SPI configuration.
To add a group, do the following:
1 Right-click any item in the tree and select Add Group.

The Config WBSSPI Application: Add Group window opens.

2 Enter the “Group Name.” The group name identifies the group of nodes with common
properties and is NOT case-sensitive.

3 Click OK.
The group is added and the Set Configuration Properties tab for the group is appears.

4  Select Add Node to Group, select one node from the list to add to the group, and click OK.
Repeat this step until all nodes are added to the group.

5 Set the configuration properties for this group using the Select a Property to Set pulldown
list. See Set Configuration Settings Tab on page 150 for more information.

6 Click Save to save your changes.

If you do not want to add the group, right-click the group name, select Remove Group, and
click Save.
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Add Node

Add a managed node to the WBS SPI configuration.
To add a node, do the following:
1 Right-click any item in the tree and select Add Node.

If no additional managed nodes are available to add to the configuration, the following
message appears:

All available managed nodes have been added to the configuration.
Click OK to exit this action.

2 From the pulldown menu, select a node to add.

3 Click OK.
The node is added and the Set Configuration Properties tab for the node appears.

4  Set the configuration properties for this node using the Select a Property to Set pulldown
list. See Set Configuration Settings Tab for more information.

5 Click Save to save your changes.

If you do not want to add the node, right-click the node name, select Remove Node, and
click Save.

Remove Application Server/Remove ALL App Servers

Remove a WebSphere server or all listed WebSphere servers from the WBS SPI configuration.
To remove an application server, do the following:
1 Right-click the application server name and select Remove Application Server.

The selected application server name is removed from the list and its configuration
properties are removed from the configuration.

2 Click Save to permanently remove the application server.

Click Cancel to cancel the removal of the application server (the application server name
appears the next time you run Config WBSSPI). In the “Confirm Cancel” window, click
Exit without Save.

To remove ALL application servers, do the following:
1 Right-click the Application Servers folder and select Remove ALL App Servers.

The selected Application Servers folder and all application servers listed in the selected
folder are removed (all configuration properties for the listed application servers are
removed from the configuration).

2 Click Save to permanently remove the application servers.

Click Cancel to cancel the removal of all application servers (the Application Servers
folder and all application server names listed in the folder appear the next time you run
Config WBSSPI). In the “Confirm Cancel” window, click Exit without Save.

Remove Group/Remove ALL Groups

Remove a WBS SPI group or all listed WBS SPI groups from the WBS SPI configuration.
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To remove a group, do the following:

1

Right-click the group server name and select Remove Group.

The selected group is removed from the list and its configuration properties are removed
from the configuration.

Click Save to permanently remove the group.

Click Cancel to cancel the removal of the group (the group name appears the next time you
run Config WBSSPI). In the “Confirm Cancel” window, click Exit without Save.

Remove Node/Remove ALL Nodes

Remove a managed node or all listed managed nodes from the WBS SPI configuration.

To remove a node, do the following:

1

Right-click the node name and select Remove Node.

The selected node is removed from the list and its configuration properties are removed
from the configuration.

Click Save to permanently remove the node.

Click Cancel to cancel the removal of the node (the node name appears the next time you
run Config WBSSPI). In the “Confirm Cancel” window, click Exit without Save.

To remove ALL nodes, do the following:

1

Right-click the Nodes folder and select Remove ALL Nodes.

The selected Nodes folder and all nodes listed in the selected folder are removed (all
configuration properties for the listed nodes are removed from the configuration).

Click Save to permanently remove the nodes.

Click Cancel to cancel the removal of all nodes (the Nodes folder and all node names listed
in the folder appear the next time you run Config WBSSPI). In the “Confirm Cancel”
window, click Exit without Save.

Set Configuration Settings Tab

Set WBS SPI configuration properties at the global properties level or for the selected
application servers, groups (GROUP level), or nodes (NODE level).

Items with the p& icon are the only items for which you can set configuration properties
(Default Properties and <Application Server. Name>).

To set the configuration properties of an item, select the item and click the Set Configuration
Properties tab in the right pane.

Setting a Property

To set a property in the configuration, do the following:

1

2
3
4

Select a property from the “Select a Property to Set” pulldown menu.
Select Set Property. The property and an empty value filed appear in the table.
Click the empty value field and enter a value.

Repeat steps 1 - 3 for each property to set.
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The Configuration

5 Click Save.

For the LOGIN and PASSWORD properties, when you select Set Property, a separate window
opens. Enter the login and password values in this window.

See Configuration Properties on page 153 for more information about individual properties.
Modifying a Property

To modify a property (except LOGIN) in the configuration, do the following:

1 Select the property from the table.

2 Double-click the value field.

3 Edit the value.

If a node contains duplicate server names (the NAME property is set to the same value),
you are prompted to set the ALIAS property (to uniquely identify each server). Refer to
Property Definitions on page 155 for more information about the ALIAS property.

4  Repeat steps 1 - 3 for each property to modify.

5 Click Save.

To modify the LOGIN property in the configuration, do the following:

1 Select LOGIN/PASSWORD from the Select a Property to add pulldown menu.

2 Select Set Property. The Set Access Info for Default Properties window opens.
3 Enter the new password and verify password.

4 Click OK.

5 Click Save.

See Configuration Properties on page 153 for more information about individual properties.

Removing a Property

To remove a property from the configuration, do the following:
1 Select the property from the table.

2  Click Remove Property.

3 Repeat steps 1 - 2 for each property to remove.

4 Click Save.

AUTO_DISCOVER

The AUTO_DISCOVER check box that appears near the bottom of the window sets the
AUTO_DISCOVER property. You can only set this property by selecting or unselecting the check
box.

Selecting the check box (default) causes the discovery templates (if distributed) to
automatically update the WBS SPI configuration information in the service map and
configuration. If the discovery templates are not distributed, the service map is created but
not updated.
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View Configuration Settings Tab

View all WBS SPI configuration properties set in the configuration on the OVO management
server or the WBS SPI configuration properties for the selected application servers, groups, or
nodes.

To view the configuration properties of an item, select the item and click the View Configuration
Settings tab in the right pane.

The following table describes the view when the specified item is selected.

Item Name Description of View

Application Servers View all configuration properties set for all the listed
application servers.

<Application_Server_Name> | View all configuration properties set for the application
server (these properties can be modified by selecting the Set
Configuration Properties tab).

Configurations View all configuration properties saved in the configuration
on the OVO management server.

Default Properties View all configuration properties that are set (these
properties can be modified by selecting the Set Configuration
Properties tab).

Defaults View all configuration properties set at the global properties
level.

Groups View all configuration properties set for all the listed groups.

<Group_Name> View all configuration properties set for the specific group.

Nodes View all configuration properties set for the listed nodes.

<Node_Name> View all configuration properties set for the specific node.

View Inherited Properties

A View Inherited Properties check box appears near the bottom of the window. By selecting
this check box, the view of the configuration properties changes to show all inherited
properties (those properties defined at a global properties level or GROUP level) that affect
the selected item. Inherited properties are denoted by “<*>” appearing after the property.

By unselecting this check box, the view shows only the configuration properties set at that
level for the selected item.

Inherited properties can only be modified at the level they are set. If “<*>” appears after the
property, the property cannot be modified at that level. For example, if the property HOME is
set at the global properties level (under the Defaults folder), it can only be modified in the
Default Properties listed under the Defaults folder. Although HOME appears (with “<*>” after
it) in a <Group_Name>'s Default Properties view, HOME cannot be modified at this level.

Properties set lower in the tree take precedence over those properties set higher in the tree.
For example, if the property HOME is set at the global properties level (under the Defaults
folder) and the property HOME is set at the GROUP level, the GROUP level property value
takes precedence.
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Configuration property precedence is as follows (listed from highest to lowest:

1 Server-specific
NODE level

2
3 GROUP level
4 Global properties level

Configuration Properties

The Configuration

Table 13 on page 154 lists all properties by WBS SPI requirements, where:

Property Name of the property.

Requirements  Lists the property requirements for specific
components where:

R - Required: the property must be set.

C - Conditional: the property may need to be
set if certain conditions are met.

O - Optional: the property is not required for
the component to work.

blank - Not Applicable: the property does not affect
this component.

WBS SPI Configuration requirements for the WBS SPI to work.
Discovery Requirements for the discovery process to work.
Process

Auto-Discovered The property is automatically set by the discovery

process.

Level of The level at which this property can be set within the
Configuration  configuration structure.

Default The global, group, or node level within the
Properties configuration structure.

Application The server-specific level within the configuration
Server structure.

Refer to Configuration Properties on page 153 for a description of the property.
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Table 13 Properties Listed by WBS SPI Requirements

Property

Requirements

WBS SPI

Discovery
Process

Auto-
Discovered

Level of
Configuration

Default
Properties

Application
Server

HOME

C

v

v

JAVA_HOME

v

NAME

PORT

NI NN

ADDRESS

ALIAS

AUTO_DISCOVER

COLLECT_METADATA

NN NS NS AN IR NN N

GRAPH_URL

HOME_LIST

JMB_JAVA_HOME

JMX_CLASSPATH

NI N N RN N

LOGFILE

LOGIN

PASSWORD

PROFILE_HOME

NI NS RN RN N

RMID_PORT

RMID_START_TIME

NI NN IENR RN

START_CMD

STOP_CMD

TYPE

<

USER

VERSION

NI NN IENR N

MAX_ERROR_LOG_SIZE

TIMEOUT

<

UDM_DEFINITIONS_SO
URCE

| O] O] Q| ] |l | ] al |l a]l al ol al ol | al ol ol al |l Q| @ H| H| =
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Property Definitions

WBS SPI
Property Requirements Description
ADDRESS Conditional The domain name or IP address where the server is
Required if the server | listening. If not specified, the server is listening on the
is running on a virtual primary IP of the node on which the server is running.
IP address or is on a Example: SERVER1_ADDRESS = product.hp.com
remote node
ALIAS Conditional Unique name on a managed node assigned to an application

Required if more than
one application server
on a system share the
same server name

server if more than one application server on a system
share the same server name. The alias, if set, is the name
used in messages, reports, and graphs (otherwise,
SERVER<n>_NAME is used).

If SERVER<n>_ALIAS is modified, the data for the old alias is
saved but is not mapped to the new alias.

Example:

NODE petstore.hp.com {
SERVER1 NAME=dog
SERVER1 ALIAS=beagle
SERVER2 NAME=dog
SERVER2 ALIAS=dachshund

}

NODE flying ace.hp.com {
SERVER1 NAME=snoopy
SERVER1 ALIAS=beagle
SERVERZ NAME=snoopy
SERVERZ ALIAS=red baron

}

AUTO_DISCOVER

Conditional

Required if you do not
want the discovery
templates to
automatically overwrite
the configuration

Default: AUTO_DISCOVER check box is selected.

Select the AUTO_DISCOVER check box to automatically
update the WebSphere configuration information in the
service map and configuration.

Unselect the AUTO_DISCOVER check box if you do not
want the discovery templates to automatically overwrite the

information configuration information.
COLLECT_ Conditional Default: OFF. Enter “ON” to collect metadata (MBean
METADATA information) displayed by the JMX Metric Builder

Required if you want to
use the MBean
Explorer in the JMX
Metric Builder
application.

application. The metadata is used to create UDMs (user
defined metrics).

Metadata for each MBean server is temporarily saved to the
following file: /var/opt/OV/wasspi/wbs/
metadata/<managed node>/<NAME | ALIAS>.xml or
/var/opt/0OV/metadata/wbs/<managed node>/

<NAME [ALIAS>.xml (UNIX) or
<80vAgentDir$>\wasspil\wbs\metadata\

<managed node>\<NAME | ALIAS>.xml (Windows)
where NAME and ALIAS are the properties set for the
managed node and ALIAS is always used if it is set.

The Configuration
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WBS SPI

Property Requirements Description
GRAPH_URL Conditional The fully-qualified URL used to launch OVPM. Set at the

Required if you want to | 8lobal level only.

view graphs with Example: GRAPH_URL=http://systeml.hp.com/

OVPM HPOV_Reports/ovpm.htm (OVPM 4 on Windows)
GRAPH_URL=http://system2.hp.com:8080/0VPM/
index.html (OVPM 5 on UNIX or Windows)

HOME Required The directory where the WebSphere server is installed.
Example:
HOME = /opt/WebSphere/AppServer or
HOME = C:/WebSphere/AppServer

HOME_LIST Conditional For Windows managed nodes only. A list of WebSphere

Required if the server installation directories, each directory separated by a

discovery process does semicolon. Set this property only if there are multiple

not find multiple server| installations of the WebSphere server on a Windows
installations on the managed node that the discovery process does not find.
same node After setting this property, run the Discover WebSphere
application.
JAVA_HOME Required The directory where Java is installed that is used by the

Required if using a
Java version not

collector. The value of JAVA_HOME must include the path
to JAVA.EXE (path to the Bin directory of Java) and not the

supplied with path to the actual JAVA_HOME directory.
WebSphere The java engine is expected to be $JAVA_HOME/bin/java.
Example: $JAVA_HOME = /opt/WebSphere/AppServer/
java/bin
JMB_JAVA_HOME Conditional The directory where Java (JDK 1.4.1 or higher) is installed

Required if you are

that is used by the JMX Metric Builder on the OVO

using the JMX Metric | Mmanagement server. The JDK must be version 1.41 or
Builder higher.
JMX_CLASSPATH Conditional The location of the jar files implementing JMX.

Required if you are

Example: SERVER]1_JMX_CLASSPATH = /JMX/Sun/lib/

configuring a JMX jmxri.jar
collector
LOGFILE Conditional A comma-separated list of fully qualified filenames of
Required only if there | WebSphere server logfiles.
are WebSphere logfiles | Example: SERVER1 LOGFILE =
to be monitored that /opt/WebSphere/myserver/websphere.log
are not the default ones| SERVER2 LOGFILE =
C:/WebSphere/myserver/websphere.log
LOGIN Conditional A WebSphere-defined user (not a system user) that is used
Required if security is | to monitor a WebSphere server.
enabled on WebSphere | Example: SERVER1_LOGIN = janedoe
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Property

WBS SPI
Requirements

Description

MAX_ERROR_LOG_
SIZE

Optional

Required if you want an
error logfile larger than
2MB

Default: 2MB. The maximum number of MB allowed for
the error logfile. When the error logfile reaches the
maximum limit, it is renamed as a backup file and logging

resumes. When a new backup file replaces an old backup
file, the old backup is deleted.

Example: MAX_ERROR_LOG_SIZE = 20

NAME?

Required

The server name as defined in WebSphere. Use the
WebSphere administrative console to obtain this
information.

Example: SERVER]1_NAME = exampleServer

NUM_SERVERS

Optional

The number of WebSphere servers on the managed node.
Example: NUM_SERVERS = 3

PASSWORD

Conditional

Required if security is
enabled on WebSphere

The password for the WebSphere-defined user (USER or
SERVER<n>_USER).

Example: SERVER]1_PASSWORD = janedoel23

PORTP

Required

For WebSphere server version 4

Default: 900. The bootstrap port number for the
WebSphere administrative server. Verify that this is the
same as the port number configured in admin.config.

Example: SERVER1_PORT = 900

For WebSphere server version 5 and above

Default: the bootstrap port number of the application
server. The bootstrap port number for the WebSphere
application server. Verify that this is the same as the port
number listed in the administrative console.

Example: SERVER1_PORT = 2809

PROFILE_HOME

Conditional

Required for
WebSphere server
version 6.0 and 6.1

For WebSphere server version 6.0

The directory for the application server profile:
<WebSphere Home>/profiles/default.

For WebSphere server version 6.1

The directory for the application server profile:
<WebSphere Home>/profiles/AppSrvO0l.

Examples:

PROFILE HOME = /opt/WebSphere/AppServer/profiles/
default

PROFILE HOME = C:/WebSphere/AppServer/profiles/
AppSrv0l

The Configuration
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WBS SPI

Property Requirements Description
RMID_PORT Conditional Default: WebSphere Application Server 4: 9243;
Required if the default WebSphere Application Server 5: 9242;JMX connector: 9241
port on which rmid The port on which rmid listens. By default, if an OVO
listens is already in use| managed node is monitoring application servers and MBean
servers using the JMX connector, the SPI uses two ports
(one for the application servers and one for the MBean
servers). For example, if you are monitoring a WebSphere
Application Server version 5 and an MBean server, the SPI
uses port 9242 and 9241. If RMID_PORT is set, the SPI
uses this one port for all servers (this property cannot be set
at the application server level). For example, if you are
monitoring a WebSphere Application Server and an MBean
server and set RMID_PORT to 9250, the SPI uses port 9250
only.
Example: RMID PORT=9250
RMID_START_ Conditional Default: 30 (seconds)
TIME Required if rmid takes | The amount of time, in seconds, to wait for rmid to start
longer than 30 seconds | before timing out.
to start Example: RMID_START TIME=60
START CMD Conditional A system command that is run when the OVO Application
Required if you want to | Bank Start WebSphere application is used. This command
start the WebSphere | is run by SERVER<n>_USER which must be configured in
application server from | order for the Start WebSphere application to work.
the OVO console NOTE: This command must exit; that is, the WebSphere
process must run in the background or as a service, and it
must be protected from its parent process dying.
Example: SERVER]1_START CMD = /sbin/init.d/
WebSphere start
STOP_CMD Conditional A system command that is run when the OVO Application
Required if you want to | Bank Stop WebSphere application is used. This command is
stop the WebSphere run by SERVER<n>_USER which must be configured in order
application server from | for the Stop WebSphere application to work.
the OVO console Example: SERVER1_STOP_CMD = /sbin/init.d/
WebSphere stop
TIMEOUT Optional Default: 120 (seconds). The maximum amount of time, in
seconds, WBS SPI tries to connect to WebSphere. When the
specified time is exceeded, WBS SPI sends an alarm to the
message browser indicating hat WebSphere is unavailable.
If metric 1002_ServerStatusRep is being collected, the
unavailability of the server is logged.
If no time limit is desired, set this property to -1.
Example: SERVER1_TIMEOUT=30
TYPE Conditional Default: websphere. The type of JMX connector server. Set
Required if you are to websphere for WebSphere server version 5 and ovrmi for
configuring a JMX other JMX connector servers.
collector Example: SERVER]_TYPE=ovrmi
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Property Requirements Description

UDM_DEFINITIONS_| Optional Default: /opt/0OV/wasspi/wbs/conf/

SOURCE wasspi_wbs_udmDefinitions.xml. The fully qualified path
name to or file name of the metric definitions XML file on
the OVO management server. If a path name is set, the
wasspi_wbs_udmDefinitions.xml file is the assumed file
name of the UDM file.

Example: SERVER]1 _UDM DEFINITIONS SOURCE = /opt/OV/
wasspi /wbs/conf /udm.xml
USER Conditional The system username for starting and stopping the
Required if you want to | WebSphere server from the OVO Application Bank.
start and/or stop the The default is the username under which the OVO agent
WebSphere application | runs.
server from the OVO | Example: SERVER]_USER = websphere
console

VERSION Conditional Default: 4.0 0. The version number of the WebSphere

Required if you are
configuring remote
monitoring

server in the format Major# <space> [Minor#] where:

e Major# - The primary version number (for example, for
example, if the version is 4.0.1 the Major# is 4.0)

e Minor# - The secondary version number (for example, if
the version is 4.0.1 the Minor# is 1).
If Minor# is not specified, the default value is 0.

Example: SERVER]1_VERSION = 4.0 1

The Configuration
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a. For WebSphere server version 4, the WebSphere administrative server displays the server names of all configured
application servers in a domain. Use these names when defining NAME.

=] S|
Console View Tools Help
® | & @ w| X K-
= % WebSphere Administrative Domain |2 Name
0 Virtual Hosts [ Installed EJB Hodules
[ Server Groups _|E2 Installed beb Hodules
= B3 Modes :
= ) dukat
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(2 Generic Servers i
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Node startup state: [Last state

Maximum startup attemptss |2

Options,,.
Clear

Typ
@ 1716703 10:... Console Ready.

For WebSphere server version 5 and above, the WebSphere administrative console displays the server names of all
configured applications servers. Use these names when defining NAME.

‘A websphere Administrative Console - Microsoft Internet Explorer provided by ard 4 -1oj x|
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N JEIAE el el el R
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w 10z s . .
ser " Application Servers
oursunc?
Anspplication server |s & sarver which provides services required to run enterprize applcstions. 1]
B Servers
Applcabion Servers
B Applications Totat 1
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B Security B Preferences
B Erwironment New| Delete |
B System Admi — s
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| | - |sereen rode2
L
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WebSphere Configuration Problems
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[ Preterances
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b. For WebSphere server version 4, the default value configured for PORT is 900. However, if the bootstrap port
number is configured in the HOME/bin/admin.config file, use the port number configured in this file. In
admin.config, search for com.ibm.ejs.sm.adminServer.bootstrapPort=<nnnnn>

For WebSphere server version 5 and above, the default value configured for PORT is the bootstrap port number for
the application server. According to the WebSphere documentation, the port number can be found using the
administrative console: Servers — Application Servers — server_name — End Points
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Sample Configurations

The sample WBS SPI configurations with entries contained in this section illustrate various
features and utilization methods.

Example 1: Single Node/Two Servers

The simple example below is for a single node running two servers: the administration server
and one managed server. The properties HOME and JAVA_HOME are global defaults that apply to
all servers and nodes. When the file is saved, passwords are encrypted.

HOME = /opt/WebSphere/AppServer
JAVA HOME=/opt/WebSphere/AppServer/java

NODE main.hp.com

{
SERVER]1 NAME= adminserver
SERVERI_PORT: 900
SERVER]I LOGIN= system
SERVER1 PASSWORD = password

SERVER2 NAME= managedserver
SERVER2_PORT: 905

SERVER2 LOGIN= system
SERVER2 PASSWORD= password

Example 2: Multiple Nodes/Repeated Properties

The Configuration

The example that follows shows how you can configure a group of related systems that have
numerous properties in common. Some nodes, however, may have one or two properties that
you need to specify differently. You can address these kinds of situations in two steps:

1 Use the Add Group action in the configuration editor to name the group, specify the nodes
in it, and set the configuration properties. See Add Group on page 148 for more
information.

2 Use the Add Node action in the configuration editor to define individual node properties
(either for nodes not in the group or for nodes in the group that have some unique/
separate properties). See Add Node on page 149 for more information.

Properties set for a node take precedence over the same properties set for a group. See
Property Precedence on page 142 for the complete order of property precedence.

In the example, the global default properties HOME and JAVA_HOME are overridden for node
europa.hp.com. Since the start commands are set to use the system init command “/sbin/
init.d/WebSphere start” which runs at system boot and starts all of the WebSphere
servers, we have configured USER to be root.

HOME = /opt/WebSphere/AppServer
JAVA HOME = /opt/WebSphere/AppServer/java
USER = root

GROUP production
{
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mercury.hp.com
venus.hp.com
mars.hp.com
jupiter.hp.com

NODE production
{
SERVER]1 NAME= partsserver
SERVER1 PORT= 900
SERVER]1 LOGIN= system
SERVER1 PASSWORD= password
SERVER1 ADMIN HOST= earth.hp.com
SERVER1 ADMIN PORT= 900
SERVER1 START CMD= /sbin/init.d/WebSphere start

SERVER2 NAME= orderserver

SERVER2 PORT= 910

SERVER2 LOGIN= system

SERVER2 PASSWORD= moresecret

SERVER2 START CMD= /sbin/init.d/WebSphere start

NODE jupiter.hp.com
{
SERVER1 PASSWORD= differentlpassword
SERVER2 PASSWORD= differentZpassword
}

NODE europa.hp.com

{
SERVER1 HOME = /opt/websphere
SERVER1 JAVA HOME = /opt/websphere/java
SERVER]1 NAME= testserver
SERVER1 PORT= 920
SERVER]1 LOGIN= system
SERVER1 PASSWORD= mypssword

Example 3: WebSphere Servers with Virtual IP Addresses

This example shows how to configure WebSphere servers that use virtual IP addresses. The
property SERVER<n>_ADDRESS is set to the name or IP address where the server is listening.

NODE saturn.hp.com
{
SERVER1 HOME = /opt/WebSphere/AppServer
SERVER1 JAVA HOME = /opt/WebSphere/AppServer/java
SERVER]1 NAME= partsserver
SERVER1 PORT= 900
SERVER1 ADDRESS= juno.hp.com
SERVER]1 LOGIN= system
SERVER1 PASSWORD= mypssword

SERVER2 HOME = /opt/WebSphere/AppServer
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SERVER2 JAVA HOME = /opt/WebSphere/AppServer/java
SERVERZ2 NAME= orderserver

SERVERZ2 PORT= 901

SERVERZ2 ADDRESS= 15.15.1.1

SERVERZ LOGIN= system

SERVERZ PASSWORD= mypssword

Example 4: Administrative Privileges Using Same Login Information

The example below shows the location of the LOGIN and PASSWORD properties if this
information is used for all WebSphere administrative privileges. When the file is saved, the
password is encrypted.

HOME = /opt/WebSphere/AppServer

JAVA HOME = /opt/WebSphere/AppServer/java
LOGIN = admin

PASSWORD = password

NODE main.hp.com

{
SERVER]1 NAME = serverl
SERVERliPORT = 900

SERVERZ2 NAME = server?2
SERVER2_PORT = 905

NODE europa.hp.com

{
SERVER1 HOME = /opt/wbs/appserver
SERVER1 JAVA HOME = /opt/wbs/appserver/java
SERVER]1 NAME= testserver
SERVER1 PORT= 915

Example 5: Administrative Privileges Using Different Login Information

The Configuration

The example below shows the location of the LOGIN and PASSWORD properties if this
information is different for administrative privileges. On the main.hp.com node, SERVER1 and
SERVER2 have separate administrative privileges. When the file is saved, the passwords are
encrypted.

HOME = /opt/WebSphere/AppServer
JAVA HOME = /opt/WebSphere/AppServer/java

NODE main.hp.com
{
SERVER]1 NAME = serverl
SERVERl_PORT = 900
SERVER]1 LOGIN = serverl admin
SERVER1 PASSWORD = serverl password

SERVER2 NAME = server?2
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SERVERZ2 PORT = 905

SERVER2 LOGIN = server2 admin

SERVERZ2 PASSWORD = server2 password
}

NODE europa.hp.com

{
LOGIN = europa_ admin
PASSWORD = europa_ password

SERVER]1 NAME= testserver
SERVER1 PORT= 915

SERVER2 NAME= anotherserver
SERVER2 PORT= 920
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C Applications

The Smart Plug-in for WebSphere Application Server (WBS SPI) applications include
configuration and troubleshooting utilities.

WBSSPI Admin applications include:
e Configure WBSSPI

e Discover WebSphere

¢ Init Non-Root

e Self-Healing Info

e Start/Stop Monitoring

e Start/Stop Tracing

e Verify

e View Error File

e View Graphs

WebSphere applications include:
¢ Check WebSphere

e Start/Stop WebSphere

e View WebSphere Log
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WBSSPI Admin

The following applications are found in the WBSSPI Admin application group. These
applications require the “root” user permission, therefore it is recommended that this group
be assigned to the OVO administrator.

Additional WBSSPI Admin applications for user defined metrics (UDMs) are available with
the WASSPI-UDM-BLDR software bundle. Refer to the HP OpenView Smart Plug-in User
Defined Metrics User Guide for more information about how to install the software bundle and
the additional applications.

Configure WBSSPI

Launches the configuration editor and maintains the WBS SPI configuration.

If you are configuring WBS SPI for the first time, use the WBSSPI Discover WebSphere
application to automatically set basic configuration properties. Refer to Chapter 3,
Configuring the WBS SPI for more information.

Purpose

Launches the configuration editor allowing the OVO administrator to maintain the WBS SPI
configuration by viewing, editing, or setting configuration properties.

Function

Configure WBSSPI does the following:

e Updates the configuration on the OVO management server and selected managed nodes.
e C(Creates the directories and files required by WBS SPI on the selected managed nodes.

e Sets up data sources for reporting and graphing.

e Sets up the WebSphere server log files and WBS SPI error log file for monitoring.

Configuration information for all WebSphere instances on all OVO managed nodes is
maintained on the OVO management server. Configuration information for a specific
WebSphere instance on an OVO managed node is maintained on that managed node (each
managed node maintains a subset of the configuration information maintained on the OVO
management server).

When saved, changes made with the configuration editor are always saved on the OVO
management server.

If a specific OVO managed node is selected when this application is launched, changes to the
configuration affecting any WebSphere servers on that managed node are automatically
saved on that managed node.

If no managed nodes are selected when this application is launched, changes to the
configuration are not saved on any managed nodes.

If a specific OVO managed node is selected when this application is launched and changes are
made that affect a WebSphere server on a non-selected managed node, the changes are saved
to the configuration on the OVO management server, but are not saved to the non-selected
managed node. You must select the affected managed node, re-run this application, and, upon
exiting the application, the changes are saved to the managed node.
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To Launch Configure WBSSPI

At the OVO console, select the nodes in the Node Bank window.
Select Application Bank.

In the Application Bank window select WBSSPI - WBSSPI Admin - Config WBSSPI. (If the
items do not appear, select Map - Reload.)

The Introduction window opens.
Select Next.

The configuration editor opens. Refer to The Configuration Editor on page 143 for more
information about using the configuration editor.

Optionally, select Save to save any changes made to the configuration. Once you save your
changes, you cannot automatically undo them.

Select Finish or Next to save any changes and exit the editor.

If you selected Next, the Confirm Operation window opens. Select OK.

’ If you select Cancel and made changes to the configuration, those changes remain
in the configuration on the management server. To make the changes to the
selected managed nodes’ configuration, you must select those nodes in the Node
Bank window, start the Config WBSSPI application, select Next from the
configuration editor, and then select OK.

If you have added an application server or added/edited the HOME and/or PORT properties,
run the Discover WebSphere application on the managed nodes on which the application
server/properties were added or edited. Running the Discover WebSphere application
updates the service map.

Discover WebSphere

Applications

Sets basic configuration properties needed for discovery.

Purpose

Launches the configuration editor allowing the OVO administrator to configure WBS SPI by
setting initial configuration properties.

Function

Discover WebSphere does the following:

Updates the configuration on the OVO management server and selected managed nodes.

Configuration information for all WebSphere instances on all OVO managed nodes is
maintained on the OVO management server. Configuration information for a specific
WebSphere instance on an OVO managed node is maintained on that managed node (each
managed node maintains a subset of the configuration information maintained on the OVO
management server).

When saved, changes made with the configuration editor are always saved on the OVO
management server.
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An OVO managed node must be selected when this application is launched, and changes to
the configuration affecting any WebSphere servers on that managed node are automatically
saved on that managed node.

If a specific OVO managed node is selected when this application is launched and changes are
made that affect a WebSphere server on a non-selected managed node, the changes are saved
to the configuration on the OVO management server, but are not saved to the non-selected
managed node. You must select the affected managed node, re-run this application, and, upon
exiting the application, the changes are saved to the managed node.

To Launch Discover WebSphere

1
2
3

At the OVO console, select the nodes in the Node Bank window.
From the Window menu, select Application Bank.

In the Application Bank window select WBSSPI > WBSSPI Admin and double-click
Discovery.
(If the above does not appear as described, select Map - Reload.)

The Introduction window opens. This window contains brief information about the
Discovery application.

Select Next.

A second Introduction window opens. This window displays information about which
properties may be required in order for the discovery process to work.

Read this information and select Next.

If you have not set the WBS SPI LOGIN and PASSWORD properties, the Configure
Access Info for Default Properties window opens.

If you have already set the LOGIN and PASSWORD properties, the configuration editor
opens. Go to the next step.

Set the LOGIN and PASSWORD properties to the WebSphere login and password
configured in Task 2: Collect WebSphere Login Information on page 41. The WebSphere
administrative login information is required when security is enabled. If security is not
enabled, leave these fields blank, select Next, and go to step 9.

The LOGIN and PASSWORD properties set in this window are used as the default
WebSphere administrative login and password (they are set at the global properties level).
That is, if no NODE level or server-specific LOGIN and PASSWORD properties are set,
this WebSphere login and password are used by WBS SPI for all administrative
privileges. For more information about the configuration structure, refer to Structure on
page 141.

If the WebSphere administrative login and password are the same for all WebSphere
application servers on all OVO managed nodes, do the following:

a Set the LOGIN and PASSWORD properties in the “Set Access Info for Default
Properties” window.

b Select Next.
¢ Gotostep9.

If the WebSphere administrative login and password are different for different instances
of WebSphere, you must customize the WBS SPI configuration by setting the LOGIN and
PASSWORD properties at the NODE or server-specific level (for more information about
the configuration structure, refer to Structure on page 141).
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a Set the LOGIN and PASSWORD properties to the most commonly used WebSphere
login and password in the Set Access Info for Default Properties window.

b  Select Customize to open the configuration editor.

7 From the configuration editor, set the configuration properties. Refer to The Configuration
Editor on page 143 for more information about using the configuration editor.

8 Select Next to save any changes and exit the editor.
9 The Confirm Operation window opens. Select OK.

) If you select Cancel and made changes to the configuration, those changes remain in the
configuration on the management server. To make the changes to the selected managed
nodes’ configuration, you must select those nodes in the Node Bank window, start the
Discovery application, select Next from the configuration editor, and then select OK.

Init Non-Root

Updates the /var/opt/0OV/bin/instrumentation/wasspi wbs platdef.pmn file and
generates the wasspi wbs sudoers configuration file on the selected managed nodes.

Purpose

Simplifies the configuration of a non-root HTTPS agent on a UNIX managed node (OVO 8.x
only). Refer to Configuring a Non-Root HTTPS Agent on a UNIX Managed Node (OVO 8.x
Only) on page 50 for all the steps necessary to configure a non-root HTTPS agent on a UNIX
managed node.

Function

Init Non-Root does the following for the selected managed nodes:

1 Runs the wasspi wbs perl -S wasspi_ wbs makePlatdef -force command to set the
proper SPI path configuration and updates the
/var/opt/OV/bin/instrumentation/wasspi wbs platdef.pmand
wasspl wbs platdef.prop files.

2 Generates the wasspi wbs_ sudoers configuration file.

To Launch Init Non-Root

1 At the OVO console, select a node in the Node Bank window.
2 From the Window menu, select Application Bank.

3 In the Application Bank window select WBSSPI - WBSSPI Admin — Init Non-Root.
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Self-Healing Info

Collects data to be sent to your HP support representative.

) Your HP support contract entitles you to access cross-referenced information through the HP
OpenView self-healing services web site (http:/support.openview.hp.com/self_healing.jsp),
linking you to a database where similar information and subsequent problem solutions
increase troubleshooting effectiveness. Refer to the HP OpenView Smart Plug-ins DVD
Installation Guide for UNIX and the section covering Self-Healing Services for more details.

Required Setup

If you are collecting data for a reproducible problem, do the following before running the
Self-Healing Info application:

1 Run the Start Tracing application. Refer to Start/Stop Tracing on page 173 for more
information.

2 Reproduce the problem.

Purpose

Allows the OVO administrator to collect data to be used by your HP support representative.

Function

Self-Healing Info does the following for all managed nodes:

¢ Runs and saves data using the Verify application (see Verify on page 174 for more
information).

e Recursively lists all files in the following directories:
— <OV _AGT DIR>/bin/OpC/actions/
— <OV_AGT DIR>/bin/OpC/cmds/
— <OV_AGT DIR>/bin/OpC/monitor/

— <OV_AGT DIR>/wasspi/wbs/

¢ Displays the contents of the following files:
— <OV_AGT DIR>/conf/OpC/nodeinfo
— <OV_AGT DIR>/wasspi/wbs/conf/SiteConfig
— <OV _AGT DIR>/wasspi/wbs/conf/SPIConfigCfgFiles
— <OV_AGT DIR>/wasspi/wbs/conf/SPIConfigLogFiles
— <OV _AGT DIR>/wasspi/wbs/conf/version
¢  Runs the following commands:
— opcagt -status
— codautil -obj
— <OV_AGT DIR>/bin/OpC/monitor/wasspi wbs ca -m 5 -x print=on

— <OV_AGT DIR>/bin/OpC/monitor/wasspi wbs ca -m 5 -x print=on -debug
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e Copies all files in the following directories:
— <OV _AGT DIR>/wasspi/wbs/log/
— <OV _AGT DIR>/wasspi/wbs/tmp/
e Copies the following files:
— <OV _AGT DIR>/conf/OpC/le
— <OV _AGT DIR>/conf/OpC/msgi
— <OV_AGT DIR>/conf/OpC/monitor
— <OV_AGT DIR>/wasspi/wbs/conf/version
¢ On the management server, verifies the following directories exist:
— /opt/OV/wasspi/wbs/bin/
— /opt/0OV/wasspi/wbs/conf/
¢ On the management server, verifies the following files exist:
— /opt/OV/wasspi/wbs/bin/parseDefs.pl
— /opt/OV/wasspi/wbs/bin/wasspi wbs_ app graphs
— /opt/OV/wasspi/wbs/bin/wasspi wbs editcfg
— /opt/OV/wasspi/wbs/bin/wasspi wbs lib.pl
— /opt/OV/wasspi/wbs/bin/wasspi wbs optaction graphs
— /opt/OV/wasspi/wbs/bin/wasspi xterm
— /opt/0OV/wasspi/wbs/conf/SiteConfig
e On the management server, copies the following file
— /opt/ov/wasspi/wbs/conf/SiteConfig
Self-Healing Info does the following for Windows managed nodes:
e Displays the contents of the following files:
— <OV_AGT DIR>/bin/OpC/install/opcinfo
— <OV_AGT DIR>/conf/dsi2ddf/ddflbd.mwc
Self-Healing Info does the following for UNIX managed nodes:
e Collects the following information:
— Up time
— Detailed OS version
— ulimit values
e Displays the contents of the following files:
— /opt/0V/bin/OpC/install/opcinfo
— <OV _AGT DIR>/conf/dsi2ddf/ddflbd.rc
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¢  Runs the following commands:
— ps -ef
— <OV_AGT DIR>/bin/OpC/cmds/wasspi wbs osinfo
— df -k
— uname -—a
— hostname
where <OV_AGT DIR>is:
e on a UNIX managed node: /var/opt/0OV
¢ on a Windows managed node: depends on the installation of the product
The data is saved in the following file:
e on a UNIX managed node: /tmp/wasspi_wbs_support.tar

¢ on a Windows managed node: wasspi_wbs_support.zip in one of the following
directories (the exact location is displayed):

— STEMPS%

— STMP%

— %SystemDrive$%\temp\

— C:\temp\

— %temp% if JAVA HOME or SERVER<n> JAVA HOME is defined

— Stemp%\wasspi wbs_ support)\

’ This file may be hidden on some Windows managed nodes. If you do not see the
file, open Windows Explorer and, from the Tools menu, select Folder Options. Click
the View tab. Under Hidden files and folders, select Show hidden files and folders.

To Launch Self-Healing Info

1 At the OVO console, select a node in the Node Bank window.
2 From the Window menu, select Application Bank.

3 In the Application Bank window select WBSSPI - WBSSPI Admin and double-click
Self-Healing Info.
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Start/Stop Monitoring

Starts/stops the collection of metrics for one application server or all application servers on a
managed node.

Purpose
Allows the OVO administrator to start or stop the WBS SPI from collecting metrics from an
application server.

These metrics generate alarms (when thresholds are exceeded) and are used to create reports
(automatically or manually generated) and graphs. The reports and graphs are used to
analyze trends in server usage, availability, and performance.

Typically, the OVO administrator would stop monitoring on a managed node if the node is not
running for a known reason (for example, the node is down for maintenance). Stopping the
monitoring prevents unnecessary alarms from being generated.

Run the Verify application to determine if monitoring is started or stopped. By default,
monitoring is on.

Function

Start Monitoring starts the collection of metrics for one or all application servers on a
managed node.

Stop Monitoring stops the collection of metrics for one or all application servers on a managed
node.

To Launch Start/Stop Monitoring

1 At the OVO console, select a node in the Node Bank window.
2  From the Window menu, select Application Bank.

3 In the Application Bank window select WBSSPI > WBSSPI Admin and double-click Start
Monitoring or Stop Monitoring.

Start/Stop Tracing

Starts/stops the tracing of the collection of metrics.

Purpose

Starts/stops the tracing of the collection of metrics into a file. Run this application only when
instructed by your HP support representative.

Run the Self-Healing Info application to collect the files created by this application as part of
the data to be used by your HP support representative.

Function

Start Tracing saves information about the collection of metrics into a file.

Stop Tracing stops saving information about the collection of metrics.
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To Launch Start/Stop Tracing

1

At the OVO console, select a node in the Node Bank window.

2 From the Window menu, select Application Bank.

3

Verify

Verify that WBS SPI is properly installed on the server or managed node.

In the Application Bank window select WBSSPI - WBSSPI Admin and double-click Start
Tracing or Stop Tracing.

Purpose

Allows the OVO administrator to verify that the WBS SPI is properly installed on the server
or managed node.

Function

Verify does the following for all managed nodes:

Checks that the following directories exist:

<OV_AGT DIR>/wasspi/wbs/conf/
<OV_AGT DIR>/wasspi/wbs/datalog/
<OV_AGT DIR>/wasspi/wbs/history/
<OV_AGT DIR>/wasspi/wbs/1lib/
<OV_AGT DIR>/wasspi/wbs/log/

<OV_AGT DIR>/wasspi/wbs/tmp/

Checks that the following files exist:

<OV_AGT DIR>/wasspi/wbs/conf/MBeanReports.dtd
<OV_AGT DIR>/wasspi/wbs/conf/MBeanReports.xsl
<OV_AGT DIR>/wasspi/wbs/conf/MetricDefinitions.dtd
<OV_AGT DIR>/wasspi/wbs/conf/MetricDefinitions.ser
<OV_AGT DIR>/wasspi/wbs/conf/MetricMap

<OV_AGT DIR>/wasspi/wbs/conf/OVIrace.sample
<OV_AGT DIR>/wasspi/wbs/conf/ReportsHeader.xsl
<OV_AGT DIR>/wasspi/wbs/conf/ReportsUtil.xsl
<OV_AGT DIR>/wasspi/wbs/conf/SiteConfig

<OV_AGT DIR>/wasspi/wbs/conf/SPIConfig

<OV _AGT DIR>/wasspi/wbs/conf/SPIConfigCfgFiles

<OV _AGT DIR>/wasspi/wbs/conf/SPIConfigLogFiles

<OV AGT DIR>/wasspi/wbs/conf/trigger

<OV _AGT DIR>/wasspi/wbs/lib/GraphSP.xsl
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— <OV_AGT DIR>/wasspi/wbs/lib/JspiCola.jar
— <OV_AGT DIR>/wasspi/wbs/lib/MetricMap.xsl
— <OV _AGT DIR>/wasspi/wbs/lib/xalan.jar

— <OV_AGT DIR>/wasspi/wbs/lib/xerces.jar

Verify does the following for Windows managed nodes:

Checks that the following files exist:

— <OV_AGT DIR>/bin/OpC/cmds/wasspi wbs admin.exe

— <OV_AGT DIR>/bin/OpC/cmds/wasspi wbs debug.exe

— <OV_AGT DIR>/bin/OpC/cmds/wasspi wbs spiapps.exe

— <OV_AGT DIR>/bin/OpC/cmds/wasspi wbs udmgraphs.exe
— <OV_AGT DIR>/bin/OpC/cmds/wasspi wbs verify.exe

— <OV_AGT DIR>/bin/OpC/monitor/wasspi wbs ca.exe

— <OV_AGT DIR>/bin/OpC/monitor/wasspi wbs config.exe
— <OV_AGT DIR>/bin/OpC/monitor/wasspi wbs files.exe
— <OV_AGT DIR>/bin/OpC/monitor/wasspi wbs le.exe

— <OV_AGT DIR>/bin/OpC/monitor/wasspi wbs logdata.exe
— <OV_AGT DIR>/bin/OpC/monitor/wasspi wbs setpath.exe
Checks that the following files exist and the version is higher than A.01:
— <OV _AGT DIR>/bin/OpC/monitor/ddfcomp.exe

— <OV_AGT DIR>/bin/OpC/monitor/ddfcomp coda.exe

— <OV_AGT DIR>/bin/OpC/monitor/ddflog.exe

— <OV_AGT DIR>/bin/OpC/monitor/ddflog coda.exe

— <OV_AGT DIR>/bin/OpC/monitor/ddfutil.exe

— <OV_AGT DIR>/bin/OpC/monitor/ddfutil coda.exe

Verify does the following for UNIX managed nodes:

Checks that the following files exist:

— <OV_AGT DIR>/bin/OpC/cmds/wasspi_ wbs_ admin

— <OV_AGT DIR>/bin/OpC/cmds/wasspi wbs_ debug

— <OV_AGT DIR>/bin/OpC/cmds/wasspi_ wbs_ spiapps
— <OV_AGT DIR>/bin/OpC/cmds/wasspi wbs_ udmgraphs
— <OV_AGT DIR>/bin/OpC/cmds/wasspi wbs verify

— <OV_AGT DIR>/bin/OpC/monitor/wasspi setpath

— <OV_AGT DIR>/bin/OpC/monitor/wasspi wbs ca

— <OV_AGT DIR>/bin/OpC/monitor/wasspi wbs config
— <OV_AGT DIR>/bin/OpC/monitor/wasspi wbs config.pl
— <OV _AGT DIR>/bin/OpC/monitor/wasspi wbs files

— <OV_AGT DIR>/bin/OpC/monitor/wasspi wbs le
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— <OV_AGT DIR>/bin/OpC/monitor/wasspi wbs lib.pl
— <OV_AGT DIR>/bin/OpC/monitor/wasspi wbs logdata
— <OV_AGT DIR>/bin/OpC/monitor/wasspi xterm

¢  Checks that the following files exist and the version is higher than A.01:
— <OV_AGT DIR>/bin/OpC/monitor/ddfcomp
— <OV_AGT DIR>/bin/OpC/monitor/ddfcomp coda
— <OV _AGT DIR>/bin/OpC/monitor/ddflog
— <OV _AGT DIR>/bin/OpC/monitor/ddflog coda
— <OV _AGT DIR>/bin/OpC/monitor/ddfutil
— <OV _AGT DIR>/bin/OpC/monitor/ddfutil coda

where <OV_AGT DIR>is:

e on a UNIX managed node: /var/opt/OvV

e on a Windows managed node: depends on the installation of the product

To Launch Verity

1 At the OVO console, select a node in the Node Bank window.

2  From the Window menu, select Application Bank.

3 In the Application Bank window select WBSSPI - WBSSPI Admin and double-click Verify.
If the Verify application is successful, the following message appears:

Installation is clean

View Error File

View the WBS SPI error log file.

Purpose

Allows the OVO administrator to view the contents of the error log file.

Function

View the contents of the WBS SPI error log file <OV_AGT DIR>/wasspi/wbs/log/errorlog
where <OV_AGT _DIR> typically is:

e /var/opt/0vVon UNIX managed nodes

® /Program Files/HP OpenView/Installed Packages/
{790 ...} on Windows managed nodes
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To Run View Error File

1 At the OVO console, select a node in the Node Bank window.
2 From the Window menu, select Application Bank.

3 In the Application Bank window select WBSSPI - WBSSPI Admin and double-click View
Error File.

View Graphs

View OpenView Performance Manager (OVPM) graphs in a web browser.

Required Setup

OVPM must be installed and you must edit the ovweb. conf file (see Task 1: Configure the
Management Server to Launch your Web Browser on page 35 for more information) before
this application can run successfully.

If you are using Netscape Navigator, use version 6.0 or higher. Do not use Netscape Navigator
4.79 with this application.

Purpose

Allows the OVO administrator to view WBS SPI graphs in OVPM from the OVO console.

Function

Launches a web browser to display WBS SPI metric data in OVPM graphs.

To Launch View Graphs

1 At the OVO console, select a node in the Node Bank window.
2  From the Window menu, select Application Bank.

3 In the Application Bank window select WBSSPI > WBSSPI Admin — View Graphs.
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WebSphere

The following applications are found in the WBSSPI WebSphere application group.

Check WebSphere

Displays a status report for the WebSphere instances on the selected managed nodes.

Purpose

Allows the OVO administrator to quickly check the status of each application server running

on a managed node.

Function

Check WebSphere displays the following information for each application server on the

selected nodes:

Information

Description

Server Name

The server name as defined in WebSphere.

Server State

The status of the WebSphere server.

Start Date

The date when the WebSphere server was started.

Port

The port on which the WebSphere server listens.

Admin Server Host

The location of the WebSphere administration server for this
WebSphere instance.

Admin Server Port

The port of the WebSphere administration server for this
WebSphere instance.

Current Open Socket Count

The number of open sockets for the WebSphere server.

WebSphere Version

The version number of the WebSphere server.

If the WBS SPI has been configured to not collect metrics for a WebSphere server, the
message Collection is temporarily OFF for <server_name> is displayed.

To Launch Check WebSphere

1 At the OVO console, select a node in the Node Bank window.

2  From the Window menu, select Application Bank.

3 In the Application Bank window select WBSSPI > WebSphere and double-click Check

WebSphere.

178

Appendix C



Start/Stop WebSphere

Starts/Stops a WebSphere application server from the OVO console.

Required Setup

The START _CMD, STOP_CMD, and USER configuration properties must be set before these
applications can run successfully.

Purpose

Allows the OVO administrator to start/stop a WebSphere application server from the OVO
console. The OVO administrator can start/stop an application server or all application servers

on the selected managed nodes and does not have to log in to each WebSphere Administration
Server to perform these functions.

Function

Start/Stop WebSphere starts/stops an application server or all application servers on the
selected managed nodes.

To Launch Start/Stop WebSphere

1 At the OVO console, select a node in the Node Bank window.

2 From the Window menu, select Application Bank.

3 In the Application Bank window select WBSSPI - WebSphere and double-click Start
WebSphere or Stop WebSphere. The START WBS or STOP WBS window opens.

4 Select the server you want to start/stop from the options given.

View WebSphere Log

View the WebSphere server log files.

Purpose

Allows the OVO administrator to select a WebSphere server log file to view without having to
log in to the system on which a WebSphere server is running.

Function

View WebSphere Log does the following:

e  When View WebSphere Log is run without entering a parameter, a numbered list of
available log files for a managed node is presented.

e  When View WebSphere Log is run with a parameter entered, if the parameter is not valid
(a non-numeric value is entered or the number entered does not correspond to the list of

available log files), a numbered list of available log files for the managed node is
presented.

e  When View WebSphere Log is run with a valid parameter, the contents of the
corresponding log file for the managed node is presented.
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You may only enter one numeric value in the parameter field. This is the number used to
designate the log file to view for all managed nodes selected. Select one log file per managed
node to view each time you launch the application.

If you keep the Application Status window open and re-launch the application, the output in
the Application Status window accumulates.

To Launch View WebSphere Log

1
2
3

10
1

12
13

14
15

At the OVO console, select a node in the Node Bank window.
From the Window menu, select Application Bank.

In the Application Bank window select WBSSPI > WebSphere and double-click View
WebSphere Log.

Select the managed nodes on which you want to view the WebSphere server log file.

Select Launch. The Edit Parameters window appears. If you know the number of the log
file you want to view, enter it into the Parameters field. Otherwise, leave this field blank
to list available log files to view.

Select Launch. The Application Status window opens.
In the Launched Applications field, check the Status of the application for each node:
e Started/Starting - The application is running.

e Succeeded - A list of available log files to view appears. Highlight the node in the
Launched Applications field and scroll through the Application Output field to view
the list of available log files.

e Failed - The application did not succeed. Highlight the node in the Launched
Applications field and scroll through the Application Output field for more
information about the problem.

Double-click View WebSphere Log.
Select the managed nodes on which you want to view the WebSphere server log file.
Select Launch. The Edit Parameters window appears.

In the Parameters text box, enter the number of the log file you want to view. Only one log
file can be selected.

If you do not remember the number of the log file, go to the Application Status window,
highlight the node in the Launched Applications field, scroll through the Application
Output filed to view the list of available log files, and enter the number of the log file you
want to view in the Edit Parameters window.

Select Launch.

In the Application Status window, highlight the node on which to view the selected log file
and scroll through the Application Output filed to view the log file.

Repeat steps 8-11 for each log file you want to view.

Select Close to close the Application Status window.
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Glossary

agent

A program or process running on a remote device or computer system that responds to
management requests, performs management operations, or sends performance and event
notification. An agent can provide access to managed objects and MIB variables, interpret
policy for resources and do configuration of resources.

application

Packaged software that provides functionality that is designed to accomplish a set of related
tasks. An application is generally more complex than a tool.

ASCII

American Standard Code for Information Interchange.

assigned policy

A policy that has been assigned to one or more resources in the computing environment but
which has not yet been deployed or installed on those resources.

automatic action

A pre-configured program or script that is executed in response to an event, message, or a
change in information in the management database. without operator intervention.

client

When the context is network systems, a computer system on a network that accesses a service
from another computer (server). When the context is software, a program or executable
process that requests a service from a server.

client console

An instance of the user interface that appears on the client system while the application runs
on a server.

command

An instruction to a computer program that causes a specified operation to be carried out.
Commands are typically typed by users on a command line.

configuration

In a network context, the complete set of inter-related systems, devices and programs that
make up the network. For example the components of a network may include computer
systems, routers, switches, hubs, operating systems and network software. The configuration
of the network determines the way that it works and the way that it is used. In a software
context, the combination of settings of software parameters and attributes that determine the
way the software works, the way it is used, and how it appears.
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configuration file

A file that contains specifications or information that can be used for determining how a
software program should look and operate.

configure

To define and modify specified software settings to fulfill the requirements of a specified
environment, application or usage.

connection

A representation of a logical or physical relationship between objects.

console

An instance of the user interface from which the user can control an application or set of
applications.

customization

The process of designing, constructing or modifying software to meet the needs and
preferences of a particular customer or user.

customize

To design, construct or modify software to meet the needs and preferences of a particular
customer or user.

data type

A particular kind of data; for example database A repository of data that is electronically
stored. Typically databases are organized so that data can be retrieved and updated.

deploy

To install and start software, hardware, capabilities, or services so that they work in the
business environment.

Deployed application

An application and its components that have been installed and started to work in the
business environment.

deployed policy

A policy that is deployed on one or more resources in the computing environment.

deployment

The process of installing and activating software, hardware, capabilities or services so that
they work in the business environment.

Deployment package

A software package that can be deployed automatically and installed on a managed node.

error log

An output file containing error messages.



event

An event is an unsolicited notification such as an SNMP trap or WMI notification generated
by an agent or process in a managed object or by a user action. Events usually indicate a
change in the state of a managed object or cause an action to occur.

HP OpenView

A family of network and system management products, and an architecture for those
products. HP OpenView includes development environments and a wide variety of
management applications.

Hypertext Transfer Protocol (HTTP).

The protocol that World Wide Web clients and servers use to communicate.

HTTPS

Hypertext Transfer Protocol Secure.

icon

An on-screen image that represents objects that can be monitored or manipulated by the user
or actions that can be executed by the user.

managed object

A network, system, software or service object that is both monitored for performance, status
and messages and is manipulated by means of actions in the management software.

management console

An instance of the user interface from which the user can control the management application
or set of management applications. The console may be on the system that contains the
management software or it may be on another system in the management domain.

management server

A server that provides management services, processes, or a management user interface to
clients. A management server is a type of management station.

message

A structured, readable notification that is generated as a result of an event, the evaluation of
one or more events relative to specified conditions, or a change in application, system,
network, or service status.

message browser

A graphical user interface that presents notifications that are generated as a result of an
event, the evaluation of one or more events relative to specified conditions or a change in
application, system, network, or service status.

message description

Detailed information about an event or message.
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message key

A message attribute that is a string used to identify messages that were triggered from
particular events.The string summarizes the important characteristics of the event. Message
keys can be used to allow messages to acknowledge other messages, and allows for the
identification of duplicate messages.

message severity level

A property of a message indicating the level of impact of the event or notification that
initiated the message. See also severity level.

metadata
Data that defines data.

metric

A measurement that defines a specific operational or performance characteristic.

Microsoft Management Console (MMC)

A Microsoft product that provides a software framework for the management of IT
environments. Management products are added or "snapped into" the management console
and thus extend the management capability of the Microsoft Management Console.

module

A self-contained software component that performs a specific type of task or provides for the
presentation of a specific type of data. Modules can interact with one another and with other
software.

node

When the context is network, a computer system or device (for example, printer, router,
bridge) in a network. When the context is a graphical point to point layout, a graphical
element in a drawing that acts as a junction or connection point for other graphical elements.
Oovo

HP OpenView Operations

OVPA
HP OpenView Performance Agent

OVPM

HP OpenView Performance Manager

parameter

A variable or attribute that may be given an arbitrary value for use during an execution of
either a computer program or a procedure within a program.

parameter type

An abstraction or categorization of a parameter that determines the particular kind of data
that is valid for the parameter. For example a parameter type could be IP Address which



indicates that parameter values must have 4 numbers separated by decimals with the value
for each number being in the range of 0 to 255.

parameter value

A value that is given to a variable.

policy

A set of one or more specifications rules and other information that help automate network,
system, service, and process management. Policies can be deployed to various targets (for
example, managed systems, devices, network interfaces) providing consistent, automated
administration across the network.

Policy management

The process of controlling policies (for example, creating, editing, tracking, deploying,
deleting) for the purposes of network, system or service management.

policy type
An abstraction or categorization of policies based on the function of the policy or the services
that the policy supports.

port

If the context is hardware, a location for passing information into and out of a network device.
If the context is ECS, a location for passing information into and out of a correlation node.

server

If the context is hardware plus software, a computer system that provides a service (for
example, management capabilities, file storage capabilities) to other computer systems
(clients) on the network. If the context is a software component, a program or executable
process that responds to and services requests issued by clients.

severity level
A property of an object indicating the status of the object. Severity level is based on the impact
of events or messages associated with the object.

SMART Plug-In (SPI)

Prepackaged software that installs into a management console and provides management
capabilities specific to a given type of business application, database, operating system, or
service.

trace log

An output file containing records of the execution of application software
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A

actions
customizing, 56

Add Application Server action, 145, 146
Add Group action, 145, 148

adding
nodes to WBS SPI node group, 47

Add Node action, 145, 149
ADDRESS property, 155
ALIAS property, 155
annotation reports, 71

Application Bank
reports, 19

application bank
reports generated, 72

applications, 17, 165
Check WebSphere, 18, 178
Configure WBSSPI, 166
Config WBSSPI, 18
Deploy UDM, 20
Discover, 18, 44, 167
Gather MBean Data, 20
Init Non-Root, 18, 169
JMX Metric Builder, 20
Self-Healing Info, 18, 170
Start Monitoring, 18, 173
Start Tracing, 18, 173
Start WebSphere, 18, 179
Stop Monitoring, 18, 173
Stop Tracing, 18, 173
Stop WebSphere, 18
UDM Graph Disable, 20
UDM Graph Enable application, 20
Verify, 18, 174
View Error File, 18, 176
View Graphs, 18, 177
View WebSphere Log, 18, 179
WBSSPI Admin group, 17
WBSSPI Reports group, 19
WebSphere group, 18

application server
verifying status, 40

Application Servers tree item, 144
Application Servers view, 152

assigning operator responsibilities, 28, 36
AUTO_DISCOVER, 151
AUTO_DISCOVER property, 155

automatic action reports, 15, 71

B
bundles, 24

C
Cancel button, 145

Check WebSphere application, 18, 178
how to run, 178
what it does, 178

CODA
using, 76

collecting
WebSphere login information, 41

collection intervals
changing, 63
changing for selected metrics, 63

collector templates, 21

conditional properties
configuring, 48
requirements, 48
setting, 48

configuration
properties, 153
structure, 141
syntax, 141

configuration editor, see Config WBSSPI application

configuration example
different login information, 163
global defaults, 161
global login information, 163
group and node properties, 161
single node/two servers, 161
virtual IP addresses, 162
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location, 139

Configurations view, 152

Configuration tree item, 144
Configure WBSSPI application, 166

how to run, 167
what it does, 166

configuring, 35

conditional properties, 48
managed nodes, 40
management server, 35, 42
OVPM, 35

ovweb.conf, 35
prerequisites, 35

remote systems, 67

Config WBSSPI application, 18
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actions, 145

Add Application Server action, 145, 146
Add Group action, 145, 148

Add Node action, 145, 149

Application Servers tree item, 144
Application Servers view, 152
AUTO_DISCOVER, 151

buttons, 145

Cancel button, 145

Configurations view, 152

Configuration tree item, 144

Default Properties tree item, 144

Default Properties view, 152

Defaults tree item, 144

Defaults view, 152

Exit action, 146

Finish button, 145

Groups tree item, 144

Groups view, 152

modifying a property, 151

Next button, 145

Nodes tree item, 144

Nodes view, 152

Remove ALL App Servers action, 146, 149
Remove ALL Groups action, 146, 149
Remove ALL Nodes action, 146, 150
Remove Application Server action, 146, 149
Remove Group action, 146, 149

Remove Node action, 146, 150

removing a property, 151

Save action, 146

Save button, 145

Set Configuration Properties tab, 146, 150
setting a property, 150

tree, 143

using

View Configuration Settings tab, 146, 152
View Inherited Properties, 152

creating
template groups, 65

customizing
creating new templates, 64
metrics, 16
templates, 55, 59
thresholds for different servers, 64

customizing template groups, 16

customizing templates, 16

D

data collection, 13

data interpretation, 14

Default Properties tree item, 144
Default Properties view, 152
Defaults tree item, 144

Defaults view, 152

Deploy UDM application, 20

directories
locations for trace file/error logs, 96

Discover application, 18, 44, 167
how to run, 168
setting LOGIN and PASSWORD, 45
what it does, 167

discovery process
verifying, 46

discovery template, 22
displaying graphed metrics, 35

distributing
templates, 47

duration
customizing, 56

E
enabling PMI, 42

error logs
location, 139

error messages, 101 to 138
Exit action, 146

F

files, locations on management server/managed

nodes, 94, 96
filesets, 24
Finish button, 145



G

Gather MBean Data application, 20

global properties, 141
GRAPH_URL property, 156

graphs
example, 82
metrics used to generate, 82
OVPM, 75
pre-defined for OVPM, 82

GROUP block, 141
Groups tree item, 144

Groups view, 152

H
HOME property, 156

Init Non-Root application, 18, 169
how to run, 169
what it does, 169
installing, 23
bundles, 24
filesets, 24
report package, 77
software requirements, 23
swinstall, 23

instruction text, 15
location, 15

J

JAVA_HOME property, 156
JMB_JAVA_HOME property, 156
JMX_CLASSPATH property, 156

JMX Metric Builder application, 20

L

license count, 73

limitations
remote systems, 69

logfile monitoring
remote systems, 69

LOGFILE property, 156
logfiles templates, 21

LOGIN
setting, 45

LOGIN property, 156

M

managed nodes
configuring, 40

management server
configuring, 42

MAX_ERROR_LOG_SIZE property, 157

MeasureWare
using, 76

message browser messages, 15

messages
instruction text, 15
message browser, 15

message template, 22

message text
customizing, 56

metrics
customizing, 16
data collected, 13
graphs generated from, 82
modifying collections in the collector template,
59
OVPI reports generated from, 80
Reporter reports generated from, 79

metrics templates, 21

modifying
collection intervals, 63
templates, 16

modifying a property, 151

N

NAME property, 157

Next button, 145

NODE block, 142

Nodes tree item, 144

Nodes view, 152
NUM_SERVERS property, 157

(o)

ov.envvars.sh, 35
OV_CONF environment variable, 35
OVPA, 75
using, 76
OVPI
pre-defined reports, 80

OVPM
integrating with WBS SPI, 35, 82
pre-defined graphs, 82
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ovweb.conf
configuring, 35
OV_CONF environment variable, 35

P

PASSWORD
setting, 45

PASSWORD property, 157

PMI
enabling, 42
metrics generating WBS SPI Reports, 72
template groups level, 22

PORT property, 157

prerequisites
configuring, 35

PROFILE_HOME property, 158

properties, 153
global, 141
listed by WBS SPI requirements, 154
precedence, 142
server-specific, 142

R

reinstalling
templates, 70

remote systems, 66
configuring, 67
limitations, 69
logfile monitoring, 69
overview, 66
requirements, 66

Remove ALL App Servers action, 146, 149
Remove ALL Groups action, 146, 149
Remove ALL Nodes action, 146, 150
Remove Application Server action, 146, 149
Remove Group action, 146, 149

Remove Node action, 146, 150

removing
swremove, 25
WBS SPI, 24

removing a property, 151

Reporter
pre-defined reports, 79
using, 77

Reporter reports, 16

report package
installing, 26, 77
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reports

annotation, 71

application bank, 72

Application Bank generated, 19
automatic action, 15, 71

generated from alarms, 19

generated from HP OpenView Reporter, 78
generated from OVPI, 80

HP OpenView Reporter, 16

included, 16

metrics used to generate in OVPI, 80
metrics used to generate in Reporter, 79
OVPI, 75

pre-defined for OVPI, 80

pre-defined for Reporter, 79

Reporter, 75

reports (automatic action)

how they are generated, 71

requirements

remote systems, 66

resetting thresholds, 58
RMID_PORT property, 157
RMID_START_TIME property, 158

S

Save action, 146

Save button, 145

Schedule templates, 21

Self-Healing Info application, 18, 170

how to run, 172
required setup, 170
what it does, 170

server-specific properties, 142

Set Access Info for Default Properties window, 45
Set Configuration Properties tab, 146, 150
Set Configuration Settings tab

AUTO_DISCOVER, 151
modifying a property, 151
removing a property, 151
setting a property, 150

setting a property, 150

severity

customizing, 56

software requirements, 23
START _CMD property, 158
Start Monitoring application, 18, 173

how to run, 173
what it does, 173



Start Tracing application, 18, 173
how to run, 174
what it does, 173

Start WebSphere application, 18, 179
how to run, 179
what it does, 179

STOP_CMD property, 158

Stop Monitoring application, 18, 173
how to run, 173
what it does, 173

Stop Tracing application, 18, 173
how to run, 174
what it does, 173

Stop WebSphere application, 18
how to run, 179
what it does, 179

structure
configuration, 141

swinstall, 23
swremove, 25

syntax
configuration, 141

T

tag option
creating custom template groups, 64

template groups
changing collection intervals, 63
creating, 65
creating with tag parameter, 64
customizing, 16
PMI level, 22
WBSSPI Discovery, 22
WBSSPI-Logfiles, 21
WBSSPI-Metrics, 21
WBSSPI-Schedule, 21

templates, 20
collector, 21
continuously setting, 58
customization, 16
customizing, 55, 59
customizing actions, 56
customizing duration, 56
customizing message text, 56
customizing severity, 56
customizing thresholds, 56
discovery, 22
distributing, 47
logfiles, 21
message, 22
metrics, 21
modifying, 16
reinstalling, 70
resetting thresholds, 58
schedule, 21
thresholds without reset, 58
WBSSPI-Messages, 22

thresholds
customizing, 56
resetting, 58
settings for different servers, 64
without reset, 58

TIMEOUT property, 158
TYPE property, 158

V)

UDM_DEFINITIONS_FILE property, 159

UDM Graph Disable, 20
UDM Graph Enable, 20
uninstallilng, 24
unsupported platforms, 66

upgrading, 27
management server, 28
WBS SPI report package, 26, 32, 33
WBS-SPI report package, 26

user defined metrics
graphing, 92
USER property, 159

using
Config WBSSPI application

Using JMX Actions Command Parameters, 61

Examples, 62
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Verify application, 18, 174
how to run, 176
what it does, 174
verifying
application server status, 40
discovery process, 46

VERSION property, 159

View Configuration Settings tab, 146, 152
View Inherited Properties, 152

View Error File application, 18, 176
how to run, 177
what it does, 176

View Graphs application, 18, 177
how to run, 177
required setup, 177
what it does, 177

View Inherited Properties, 152

View WebSphere Log application, 18, 179
how to run, 180
what it does, 179

virtual IP addresses
example configuration, 162

w

wasspi_wbs_ca command, 59
parameters, 59
tag option, 64

WBS SPI
capabilities, 13
components, 17
overview, 14
removing, 24

WBSSPI Admin application group, 17, 166
WBSSPI Discovery template group, 22
WBSSPI-Logfiles template group, 21
WBSSPI-Messages template, 22
WBSSPI-Metrics template group, 21

WBS SPI node group
adding nodes, 47

WBSSPI Reports application group, 19
WBSSPI-Schedule template group, 21
WebSphere application group, 18, 178

WebSphere login information
collecting, 41
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